Tiled Documentation

Release 1.6.0

Thorbjørn Lindeijer

Apr 23, 2021
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Custom Properties</td>
<td>33</td>
</tr>
<tr>
<td>7.1</td>
<td>Adding Properties</td>
<td>33</td>
</tr>
<tr>
<td>7.2</td>
<td>Tile Property Inheritance</td>
<td>35</td>
</tr>
<tr>
<td>7.3</td>
<td>Predefining Properties</td>
<td>35</td>
</tr>
<tr>
<td>8</td>
<td>Using Templates</td>
<td>37</td>
</tr>
<tr>
<td>8.1</td>
<td>Creating Templates</td>
<td>38</td>
</tr>
<tr>
<td>8.2</td>
<td>Creating Template Instances</td>
<td>38</td>
</tr>
<tr>
<td>8.3</td>
<td>Editing Templates</td>
<td>38</td>
</tr>
<tr>
<td>8.4</td>
<td>Detaching Template Instances</td>
<td>38</td>
</tr>
<tr>
<td>9</td>
<td>Using Terrains</td>
<td>41</td>
</tr>
<tr>
<td>9.1</td>
<td>Define the Terrain Information</td>
<td>42</td>
</tr>
<tr>
<td>9.2</td>
<td>Editing with the Terrain Brush</td>
<td>44</td>
</tr>
<tr>
<td>9.3</td>
<td>Terrain Fill Mode</td>
<td>44</td>
</tr>
<tr>
<td>9.4</td>
<td>Tile and Terrain Probability</td>
<td>45</td>
</tr>
<tr>
<td>9.5</td>
<td>Tile Transformations</td>
<td>46</td>
</tr>
<tr>
<td>9.6</td>
<td>Final Words</td>
<td>47</td>
</tr>
<tr>
<td>10</td>
<td>Using Infinite Maps</td>
<td>49</td>
</tr>
<tr>
<td>10.1</td>
<td>Creating an Infinite Map</td>
<td>49</td>
</tr>
<tr>
<td>10.2</td>
<td>Editing the Infinite Map</td>
<td>51</td>
</tr>
<tr>
<td>10.3</td>
<td>Conversion from Infinite to Finite Map and Vice Versa</td>
<td>51</td>
</tr>
<tr>
<td>11</td>
<td>Working with Worlds</td>
<td>55</td>
</tr>
<tr>
<td>11.1</td>
<td>Defining a World</td>
<td>55</td>
</tr>
<tr>
<td>11.2</td>
<td>Editing Worlds</td>
<td>56</td>
</tr>
<tr>
<td>11.3</td>
<td>Using Pattern Matching</td>
<td>57</td>
</tr>
<tr>
<td>11.4</td>
<td>Showing Only Direct Neighbors</td>
<td>57</td>
</tr>
<tr>
<td>12</td>
<td>Using Commands</td>
<td>59</td>
</tr>
<tr>
<td>12.1</td>
<td>The Command Button</td>
<td>59</td>
</tr>
<tr>
<td>12.2</td>
<td>Editing Commands</td>
<td>59</td>
</tr>
<tr>
<td>12.3</td>
<td>Example Commands</td>
<td>60</td>
</tr>
<tr>
<td>13</td>
<td>Automapping</td>
<td>61</td>
</tr>
<tr>
<td>13.1</td>
<td>What is Automapping?</td>
<td>61</td>
</tr>
<tr>
<td>13.2</td>
<td>Setting it Up</td>
<td>61</td>
</tr>
<tr>
<td>13.3</td>
<td>Examples</td>
<td>64</td>
</tr>
<tr>
<td>14</td>
<td>Export Formats</td>
<td>83</td>
</tr>
<tr>
<td>14.1</td>
<td>Generic File Formats</td>
<td>83</td>
</tr>
<tr>
<td>14.2</td>
<td>Defold</td>
<td>84</td>
</tr>
<tr>
<td>14.3</td>
<td>GameMaker: Studio 1.4</td>
<td>84</td>
</tr>
<tr>
<td>14.4</td>
<td>GameMaker Studio 2.3</td>
<td>87</td>
</tr>
<tr>
<td>14.5</td>
<td>tBIN</td>
<td>92</td>
</tr>
<tr>
<td>14.6</td>
<td>Other Formats</td>
<td>92</td>
</tr>
<tr>
<td>14.7</td>
<td>Custom Export Formats</td>
<td>93</td>
</tr>
<tr>
<td>14.8</td>
<td>Export as Image</td>
<td>94</td>
</tr>
<tr>
<td>15</td>
<td>Keyboard Shortcuts</td>
<td>95</td>
</tr>
<tr>
<td>15.1</td>
<td>General</td>
<td>95</td>
</tr>
<tr>
<td>15.2</td>
<td>When a tile layer is selected</td>
<td>96</td>
</tr>
<tr>
<td>15.3</td>
<td>When an object layer is selected</td>
<td>97</td>
</tr>
<tr>
<td>15.4</td>
<td>In the Properties dialog</td>
<td>97</td>
</tr>
</tbody>
</table>
# User Preferences

- General .......................................................... 99
- Interface ......................................................... 101
- Keyboard ......................................................... 103
- Theme ............................................................... 103
- Plugins ............................................................ 104

# Python Scripts

- Example Export Plugin .......................................... 106
- Debugging Your Script ........................................... 107
- API Reference ..................................................... 107

# Libraries and Frameworks

- Support by Language ............................................. 109
- Support by Framework ............................................. 111

# TMX Map Format

- `<map>` .......................................................... 117
- `<editorsettings>` ............................................... 118
- `<tileset>` ......................................................... 119
- `<layer>` .......................................................... 122
- `<objectgroup>` ................................................... 125
- `<imagelayer>` ..................................................... 127
- `<group>` .......................................................... 127
- `<properties>` ..................................................... 128
- Template Files .................................................... 128

# TMX Changelog

- Tiled 1.5 .......................................................... 131
- Tiled 1.4 .......................................................... 131
- Tiled 1.3 .......................................................... 131
- Tiled 1.2.1 ......................................................... 132
- Tiled 1.2 .......................................................... 132
- Tiled 1.1 .......................................................... 132
- Tiled 1.0 .......................................................... 132
- Tiled 0.18 ......................................................... 132
- Tiled 0.17 ........................................................ 133
- Tiled 0.16 ........................................................ 133
- Tiled 0.15 ........................................................ 133
- Tiled 0.14 ........................................................ 133
- Tiled 0.13 ........................................................ 133
- Tiled 0.12 ........................................................ 133
- Tiled 0.11 ........................................................ 133
- Tiled 0.10 ........................................................ 134
- Tiled 0.9 .......................................................... 134
- Tiled 0.8 .......................................................... 135

# JSON Map Format

- Map ................................................................. 138
- Layer ............................................................... 139
- Chunk ............................................................... 140
- Object .............................................................. 141
- Text ................................................................. 144
- Tileset .............................................................. 145
- Object Template ................................................... 149
21.8 Property .................................................. 149
21.9 Point ...................................................... 149
21.10 Changelog ................................................ 150

22 Scripting .................................................... 153
22.1 Introduction .............................................. 153
22.2 API Reference .......................................... 155
Note: If you’re not finding what you’re looking for in these pages, please don’t hesitate to ask questions on the Tiled Forum or the Tiled Discord.
1.1 About Tiled

Tiled is a 2D level editor that helps you develop the content of your game. Its primary feature is to edit tile maps of various forms, but it also supports free image placement as well as powerful ways to annotate your level with extra information used by the game. Tiled focuses on general flexibility while trying to stay intuitive.

In terms of tile maps, it supports straight rectangular tile layers, but also projected isometric, staggered isometric and staggered hexagonal layers. A tileset can be either a single image containing many tiles, or it can be a collection of individual images. In order to support certain depth faking techniques, tiles and layers can be offset by a custom distance and their rendering order can be configured.

The primary tool for editing tile layers is a stamp brush that allows efficient painting and copying of tile areas. It also supports drawing lines and circles. In addition, there are several selection tools and a tool that does automatic terrain transitions. Finally, it can apply changes based on pattern-matching to automate parts of your work.

Tiled also supports object layers, which traditionally were only for annotating your map with information but more recently they can also be used to place images. You can add rectangle, point, ellipse, polygon, polyline and tile objects. Object placement is not limited to the tile grid and objects can also be scaled or rotated. Object layers offer a lot of flexibility to add almost any information to your level that your game needs.

Other things worth mentioning are the support for adding custom map or tileset formats through plugins, extending Tiled with JavaScript, the tile stamp memory, tile animation support and the tile collision editor.

1.2 Getting Started

1.2.1 Setting up a New Project

When launching Tiled for the first time, we are greeted with the following window:

To make all our assets readily accessible from the Project view, as well as to be able to quickly switch between multiple projects, it is recommended to first set up a Tiled project. This is however an entirely optional step that can be skipped when desired.
Choose *Project -> Save Project As...* to save a new project file. The recommended location is the root of your project, but you can place it anywhere you want.

Next, we’ll add at least one folder, either some “assets” folder or simply the root of your project, but you can also choose to add several top-level folders like “tilesets”, “maps”, “templates”, etc. Right-click in the Project view and choose *Add Folder to Project...* to add the relevant folders.

### 1.2.2 Creating a New Map

To create a new map, choose *File -> New -> New Map...* (*Ctrl+N*). The following dialog will pop up:

Here, we choose the initial map size, tile size, orientation, tile layer format, tile render order (only supported for *Orthogonal* maps) and whether the map is *infinite* or not. All of these things can be changed later as needed, so it’s not important to get it all right the first time.

**Note:** If you set up a project, make sure to save the map to a folder that you had added to your project. This will make it quickly accessible using *File -> Open File in Project* (*Ctrl+P*).

After saving our map, we’ll see the tile grid and an initial tile layer will be added to the map. However, before we can start using any tiles we need to add a tileset. Choose *File -> New -> New Tileset...* to open the New Tileset dialog:

Click the *Browse...* button and select the `tmw_desert_spacing.png` tileset from the examples shipping with Tiled (or use one of your own if you wish). This example tileset uses a tile size of 32x32. It also has a one pixel margin around the tiles and a one pixel spacing in between the tiles (this is pretty rare actually, usually you should leave these values on 0).

**Note:** We leave the *Embed in map* option disabled. This is recommended, since it will allow the tileset to be used by multiple maps without setting up its parameters again. It will also be good to store the tileset in its own file if you later
Fig. 2: New Map
Fig. 3: New Tileset
add tile properties, terrain definitions, collision shapes, etc., since that information is then shared between all your maps.

After saving the tileset, Tiled should look as follows:

![Tileset Created](image)

Fig. 4: Tileset Created

Since we don’t want to do anything else with the tileset for now, just switch back to the map file:

We’re ready to select some tiles and start painting! But first, let’s have a quick look at the various layer types supported by Tiled.

**Note:** Much of the manual still needs to be written. Fortunately, there is a very nice Tiled Map Editor Tutorial Series on GamesFromScratch.com. In addition, the support for Tiled in various engines and frameworks often comes with some usage information.
Fig. 5: Tileset Usable on the Map
2.1 What’s in a Project

A Tiled project file primarily defines the list of folders containing the assets belonging to that project. In addition, it provides an anchor for the session file.

Apart from the list of folders, a project currently has the following properties, which can be changed through the Project -> Project Properties... dialog.

**Extensions Directory** A project-specific directory where you can put Tiled extensions. It defaults to simply extensions, so when you have a directory called “extensions” alongside your project file it will be picked up automatically.

The directory is loaded in addition to the global extensions.

**Object Types File** Refers to the file defining the object types. Be sure to specify this file before opening the Object Types Editor, to make sure any types you define are saved to the right location.

When left unspecified, object type definitions are saved to a global location.

**Automapping Rules File** Refers to an Automapping rules file that should be used for all maps while this project is loaded. It is ignored for maps that have a rules.txt file saved alongside them.

2.2 Sessions

Each project file gets an associated .tiled-session file, stored alongside it. The session file should generally not be shared with others and stores your last opened files, part of their last editor state, last used parameters in dialogs, etc.

When switching projects Tiled automatically switches to the associated session, so you can easily resume where you left off. When no project is loaded a global session file is used.
2.3 Opening a File in the Project

Another advantage of setting up a project is that you can quickly open any file with a recognized extension located in one of the folders of the project. Use File -> Open File in Project (Ctrl+P) to open the file filter and just type the name of the file you’d like to open.

![Open File in Project](image)

Fig. 1: Open File in Project

Future Extensions

There are many ways in which the projects could be made more powerful:

- Make the project accessible through the **scripting API**.
- Allow turning off features on a per-project basis, to simplify the UI and reduce the chance of accidentally doing something your project doesn’t support.
- Recognizing the various assets in your project, so that selection of images, tilesets and templates can be made more efficient (potentially replacing the system file dialog).

If you like any of these plans, please help me getting around to it faster by sponsoring Tiled development. The more support I receive the more time I can afford to spend improving Tiled!
A Tiled map supports various sorts of content, and this content is organized into various different layers. The most common layers are the Tile Layer and the Object Layer. There is also an Image Layer for including simple foreground or background graphics. The order of the layers determines the rendering order of your content.

Layers can be hidden, made only partially visible and can be locked. Layers also have an offset and a parallax scrolling factor, which can be used to position them independently of each other, for example to fake depth. Finally their contents can be tinted by multiplying with a custom tint color.

You use Group Layers to organize the layers into a hierarchy. This makes it more comfortable to work with a large amount of layers.

### 3.1 Layer Types

#### 3.1.1 Tile Layers

Tile layers provide an efficient way of storing a large area filled with tile data. The data is a simple array of tile references and as such no additional information can be stored for each location. The only extra information stored are a few flags, that allow tile graphics to be flipped vertically, horizontally or anti-diagonally (to support rotation in 90-degree increments).

The information needed to render each tile layer is stored with the map, which specifies the position and rendering order of the tiles based on the orientation and various other properties.

Despite only being able to refer to tiles, tile layers can also be useful for defining various bits of non-graphical information in your level. Collision information can often be conveyed using a special tileset, and any kind of object that does not need custom properties and is always aligned to the grid can also be placed on a tile layer.

#### 3.1.2 Object Layers

Object layers are useful because they can store many kinds of information that would not fit in a tile layer. Objects can be freely positioned, resized and rotated. They can also have individual custom properties. There are many kinds of
Fig. 1: The eye and lock icon toggle the visibility and locked state of a layer respectively.
objects:

- **Rectangle** - for marking custom rectangular areas
- **Ellipse** - for marking custom ellipse or circular areas
- **Point** - for marking exact locations (since Tiled 1.1)
- **Polygon** - for when a rectangle or ellipse doesn’t cut it (often a collision area)
- **Polyline** - can be a path to follow or a wall to collide with
- **Tile** - for freely placing, scaling and rotating your tile graphics
- **Text** - for custom text or notes (since Tiled 1.0)

All objects can be named, in which case their name will show up in a label above them (by default only for selected objects). Objects can also be given a type, which is useful since it can be used to customize the color of their label and the available custom properties for this object type. For tile objects, the type can be inherited from their tile.

For most map types, objects are positioned in plain pixels. The only exception to this are isometric maps (not isometric staggered). For isometric maps, it was deemed useful to store their positions in a projected coordinate space. For this, the isometric tiles are assumed to represent projected squares with both sides equal to the tile height. If you’re using a different coordinate space for objects in your isometric game, you’ll need to convert these coordinates accordingly.

The object width and height is also mostly stored in pixels. For isometric maps, all shape objects (rectangle, point, ellipse, polygon and polyline) are projected into the same coordinate space described above. This is based on the assumption that these objects are generally used to mark areas on the map.

### 3.1.3 Image Layers

Image layers provide a way to quickly include a single image as foreground or background of your map. They are currently not so useful, because if you instead add the image as a Tileset and place it as a Tile Object, you gain the ability to freely scale and rotate the image.

The only advantage of using an image layer is that it avoids selecting / dragging the image while using the Select Objects tool. However, since Tiled 1.1 this can also be achieved by locking the object layer containing the tile object you’d like to avoid interacting with.

### 3.1.4 Group Layers

Group layers work like folders and can be used for organizing the layers into a hierarchy. This is mainly useful when your map contains a large amount of layers.

The visibility, opacity, offset, lock and tint color of a group layer affects all child layers.

Layers can be easily dragged in and out of groups with the mouse. The Raise Layer / Lower Layer actions also allow moving layers in and out of groups.

### 3.2 Parallax Scrolling Factor

The parallax scrolling factor determines the amount by which the layer moves in relation to the camera.

By default its value is 1, which means its position on the screen changes at the same rate as the position of the camera (in opposite direction). A lower value makes it move slower, simulating a layer that is further away, whereas a higher value makes it move faster, simulating a layer positioned in between the screen and the camera.

3.2. Parallax Scrolling Factor 13
A value of 0 makes the layer not move at all, which can be useful to include some pieces of your ingame UI or to mark its general viewport boundaries.

Negative values make the layer move in opposite direction, though this is rarely useful.

When the parallax scrolling factor is set on a group layer, it applies to all its child layers. The effective parallax scrolling factor of a layer is determined by multiplying the parallax scrolling factor by the scrolling factors of all parent layers.

### 3.3 Tinting Layers

When you set the *Tint Color* property of a layer, this affects the way images are rendered. This includes tiles, tile objects and the image of an *Image Layer*.

Each pixel color value is multiplied by the tint color. This way you can darken or colorize your graphics in various ways without needing to set up separate images for it.

![Image](image.png)

*Fig. 2: A gray tileset rendered in a different color for each layer.*

The tint color can also be set on a *Group Layer*, in which case it is inherited by all layers in the group.

### Future Extensions

There are many ways in which the layers can be made more powerful:

- Ability to lock individual objects (#828).
- Moving certain map-global properties to the Tile Layer (#149). It would be useful if one map could accommodate layers of different tile sizes and maybe even of different orientation.
If you like any of these plans, please help me getting around to it faster by sponsoring Tiled development. The more support I receive the more time I can afford to spend improving Tiled!
**Tile Layers** are what makes Tiled a *tile map editor*. Although not as flexible as *Object Layers*, they provide efficient data storage and good rendering performance as well as efficient content creation. Every new map gets one by default, though feel free to delete it when you’re not going to use it.

### 4.1 Stamp Brush

**Shortcut: B**

The primary tool for editing tile layers is the Stamp Brush. It can be used to paint single tiles as well as larger “stamps”, which is where it gets its name from. Using the right mouse button, it can also quickly capture tile stamps from the currently active layer. A tile stamp is commonly created by selecting one or more tiles in the Tilesets view.

The Stamp Brush has some extra features:

- While holding *Shift*, click any two points to draw a line between them.
- While holding *Ctrl+Shift*, click any two points two draw a circle or ellipse centered on the first point.
- Activate the *Random Mode* using the dice button on the Tool Options toolbar to have the Stamp Brush paint with random tiles from the tile stamp. The probability of each tile depends on how often it occurred on the tile stamp, as well as the probability set on each tile in the *Tileset Editor*.
- Activate the *Terrain Fill Mode* using the Terrain tile button on the tool bar to have the Stamp Brush paint using random terrain tiles. This makes adjacent tiles match edge and corner terrains to be placed. Terrain tiles are described in detail in *Using Terrains*.
- In combination with the *Tile Stamps* view, it can also place randomly from a set of predefined tile stamps. This can be more useful than the *Random Mode*, which randomly places individual tiles.
- You can flip the current tile stamp horizontally/vertically by using *X* and *Y* respectively. You can also rotate left/right by using *Z* and *Shift+Z* respectively. These actions can also be triggered from the Tool Options tool bar.
4.2 Terrain Brush

Shortcut: T

The Terrain Brush allows for efficient editing with certain types of terrain transitions (corner-based, edge-based or a combination). Setting it up requires associating terrain information with your tiles, which is described in detail in Using Terrains.

Similarly to the Stamp Brush, you can draw lines by holding Shift. When holding Ctrl, the size of the edited area is increased to cover an entire tile rather than just one corner or edge.

When holding Alt, the editing operations are also applied at a 180 degree rotation. This is especially useful when editing strategic maps where two sides need to have equal opportunities. The modifier works well in combination with either Shift for drawing lines or Ctrl for increasing the edited area.

4.3 Bucket Fill Tool

Shortcut: F

The Bucket Fill Tool provides a quick way of filling empty areas or areas covered with the same tiles. The currently active tile stamp will be repeated in the filled area. It can also be used in combination with the Random Mode, or Terrain Fill Mode.

When holding Shift, the tool fills the currently selected area regardless of its contents. This is useful for filling custom areas that have been selected previously using one or more Selection Tools.

You can also flip and rotate the current stamp as described for the Stamp Brush.

4.4 Shape Fill Tool

Shortcut: P

This tool provides a quick way to fill rectangles or ellipses with a certain tile or pattern. Hold Shift to fill an exact square or circle.

You can also flip and rotate the current stamp as described for the Stamp Brush.

4.5 Eraser

Shortcut: E

A simple eraser tool. Left click erases single tiles and right click can be used to quickly erase rectangular areas.

- Holding Shift erases on all layers.
4.6 Selection Tools

There are various tile selection tools that all work in similar fashion:

- **Rectangular Select** allows selection of rectangular areas (shortcut: \texttt{R})
- **Magic Wand** allows selection of connected areas filled with the same tile (shortcut: \texttt{W})
- **Select Same Tile** allows selection of same-tiles across the entire layer (shortcut: \texttt{S})

By default, each of these tools replaces the currently selected area. The following modifiers can be used to change this behavior:

- Holding \texttt{Shift} expands the current selection with the new area
- Holding \texttt{Ctrl} subtracts the new area from the current selection
- Holding \texttt{Ctrl} and \texttt{Shift} selects the intersection of the new area with the current selection

You can also lock into one of these modes (Add, Subtract or Intersect) by clicking on one of the tool buttons in the Tool Options toolbar.

4.7 Managing Tile Stamps

It can often be useful to store the current tile stamp somewhere to use it again later. The following shortcuts work for this purpose:

- \texttt{Ctrl} + 1-9 - Store current tile stamp (similar to \texttt{Ctrl} + \texttt{C})
- 1-9 - Recall the stamp stored at this location (similar to \texttt{Ctrl} + \texttt{V})

Tile stamps can also be stored by name and extended with variations using the *Tile Stamps* view.
CHAPTER 5

Working with Objects

Using objects you can add a great deal of information to your map for use in your game. They can replace tedious alternatives like hardcoding coordinates (like spawn points) in your source code or maintaining additional data files for storing gameplay elements.

By using *tile objects*, objects of various types can be made easy to recognize or they can be used for purely graphical purposes. In some cases they can replace the use of tile layers entirely, as demonstrated by the “Sticker Knight” example shipping with Tiled.

All objects can have *custom properties*, which can also be used to create *connections between objects*.

To start using objects, add an *Object Layer* to your map.

### 5.1 Placement Tools

Each type of object has its own placement tool.

A preview is shown of the object you’re about to place when you hover over the map. While placing an object, you can press `Escape` or right-click to cancel placement of the object. Press `Escape` again to switch to the *Select Objects* tool.

#### 5.1.1 Insert Rectangle

Shortcut: `R`

The rectangle was the first type of object supported by Tiled, which is why objects are rectangles by default in the *TMX Map Format*. They are useful for marking rectangular areas and assigning custom properties to them. They are also often used for specifying collision boxes.

Place a rectangle by clicking-and-dragging in any direction. Holding `Shift` makes it square and holding `Ctrl` snaps its size to the tile size.

Rectangle objects have their origin in the top-left. However, if the rectangle is empty (width and height are both 0), it is rendered as a small square around its position. This is mainly to keep it visible and selectable.
5.1.2 Insert Point

Shortcut: I

Points are the simplest objects you can place on a map. They only represent a location, and cannot be resized or rotated. Simply click on the map to position a point object.

5.1.3 Insert Ellipse

Shortcut: C

Ellipses work the same way as rectangles, except that they are rendered as an ellipse. Useful for when your area or collision shape needs to represent a circle or ellipse.

5.1.4 Insert Polygon

Shortcut: P

Polygons are the most flexible way of defining the shape of an area. They are most commonly used for defining collision shapes.

When placing a polygon, the first click determines the location of the object as well as the location of the first point of the polygon. Subsequent clicks are used to add additional points to the polygon. Polygons needs to have at least three points. Click the first point again to finish creating the polygon. You can press Escape to cancel the creation of the polygon.

When you want to change a polygon after it has been placed, you need to use the Edit Polygons tool.

Polylines

Polylines are created by not closing a polygon. Right-click or press Enter while creating a polygon to finish it as a polyline.

Polylines are rendered as a line and require only two points. While they can represent collision walls, they are also often used to represent paths to be followed.

You can extend an existing polyline at either end when it is selected, by clicking on the displayed dots. It is also possible to finish the polyline by connecting it to either end of another existing polyline object. The other polyline object needs to be selected as well, since the interactive dots only show on selected polylines.

The Edit Polygons tool is used to edit polylines as well.

5.1.5 Insert Tile

Shortcut: T

Tiles can be inserted as objects to have full flexibility in placing, scaling and rotating the tile image on your map. Like all objects, tile objects can also have custom properties associated with them. This makes them useful for placement of recognizable interactive objects that need special information, like a chest with defined contents or an NPC with defined script.

To place a tile object, first select the tile you want to place in the Tilesets view. Then use the Left mouse button on the map to start placing the object, move to position it and release to finish placing the object.

To change the tile used by existing tile objects, select all the objects you want to change using the Select Objects tool and then right-click on a tile in the Tilesets view, and choose Replace Tile of Selected Objects.
You can customize the alignment of tile objects using the Object Alignment property on the Tileset. For compatibility reasons this property is set to Unspecified by default, in which case tile objects are bottom-left aligned in all orientations except on Isometric maps, where they are bottom-center aligned. Setting this property to Top Left makes the alignment of tile objects consistent with that of rectangle objects.

5.1.6 Insert Template

Shortcut: V

Can be used to quickly insert multiple instances of the template selected in the Templates view. See Creating Template Instances.

5.1.7 Insert Text

Shortcut: X

Text objects can be used to add arbitrary multi-line text to your maps. You can configure various font properties and the wrapping / clipping area, making them useful for both quick notes as well as text used in the game.

5.2 Select Objects

Shortcut: S

When you’re not inserting new objects, you’re generally using the Select Objects tool. It packs a lot of functionality, which is outlined below.

5.2.1 Selecting and Deselecting

You can select objects by clicking them or by dragging a rectangular lasso, selecting any object that intersect with its area. By holding Shift or Ctrl while clicking, you can add/remove single objects to/from the selection. Press Escape to deselect all objects.

When pressing and dragging on an object, this object is selected and moved. When this prevents you from starting a rectangular selection, you can hold Shift to force the selection rectangle.

By default you interact with the top-most object. When you need to select an object below another object, first select the higher object and then hold Alt while clicking at the same location to select lower objects. You can also hold Alt while opening the context menu to get a list of all objects at the clicked location, so you may directly select the desired object.

You can quickly switch to the Edit Polygons tool by double-clicking on the polygon or polyline you want to edit.

5.2.2 Moving

You can simply drag any single object, or drag already selected objects by dragging any one of them. Hold Ctrl to toggle snapping to the tile grid.

Hold Alt to force a move operation on the currently selected objects, regardless of where you click on the map. This is useful when the selected objects are small or covered by other objects.

The selected objects can also be moved with the arrow keys. By default this moves the objects pixel by pixel. Hold Shift while using the arrow keys to move the objects by distance of one tile.
5.2.3 Resizing

You can use the resize handles to resize one or more selected objects. Hold Ctrl to keep the aspect ratio of the object and/or Shift to place the resize origin in the center.

Note that you can only change width and height independently when resizing a single object. When having multiple objects selected, the aspect ratio is constant because there would be no way to make that work for rotated objects without full support for transformations.

5.2.4 Rotating

To rotate, click any selected object to change the resize handles into rotation handles. Before rotating, you can drag the rotation origin to another position if necessary. Hold Shift to rotate in 15-degree increments. Click any selected object again to go back to resize mode.

You can also rotate the selected objects in 90-degree steps by pressing Z or Shift + Z.

5.2.5 Changing Stacking Order

If the active Object Layer has its Drawing Order property set to Manual (the default is Top Down), you can control the stacking order of the selected objects within their object layer using the following keys:

- PgUp - Raise selected objects
- PgDown - Lower selected objects
- Home - Move selected objects to Top
- End - Move selected objects to Bottom

You can also find these actions in the context menu. When you have multiple Object Layers, the context menu also contains actions to move the selected objects to another layer.

5.2.6 Flipping Objects

You can flip the selected objects horizontally by pressing X or vertically by pressing Y. For tile objects, this also flips their images.

5.3 Edit Polygons

Shortcut: E

Polygons and polylines have their own editing needs and as such are covered by a separate tool, which allows selecting and moving around their nodes. You can select and move the nodes of multiple polygons at the same time. Click a segment to select the nodes at both ends. Press Escape to deselect all nodes, or to switch back to the Select Objects tool.

Nodes can be deleted by selecting them and choosing “Delete Nodes” from the context menu. The Delete key can also be used to delete the selected nodes, or the selected objects if no nodes are selected.

When you have selected multiple consecutive nodes of the same polygon, you can join them together by choosing “Join Nodes” from the context menu. You can also split the segments in between the nodes by choosing “Split Segments”. Alternatively, you can simply double-click a segment to split it at that location.
You can also delete a segment when two consecutive nodes are selected in a polygon by choosing “Delete Segment” in the context menu. This will convert a polygon into a polyline, or turn one polyline object in two polyline objects.

It is possible to extend a polyline at either end, either by right-clicking those nodes and choosing “Extend Polyline”, or by switching to the Insert Polygon tool and clicking on either end of an already selected polyline.

5.4 Connecting Objects

It can often be useful to connect one object with another, like when a switch should open a certain door or an NPC should follow a certain path. To do this, add a custom property of type object to the source object. This property can then be set to the desired target object in several ways.

Make sure the property value is selected, as seen on the following screenshot:

![Object Connection Property](image)

Fig. 1: Object Connection Property

Then, you can set the connection by either:

- Typing in the ID of the target object.
- Clicking the icon with the window and magnifier, to open a dialog where you can filter all objects on the map to find your target object.
- Clicking the arrow icon and then clicking an object on the map to set it as the target object.

As shown on the screenshot above, any connections between objects are rendered as arrows, taking the color of their target object (defined as part of the object types or by the color of the object layer). You can toggle the display of these arrows using View -> Show Object References.

If you’d like to get to the target object, but it’s very far away, you can jump there by right-clicking the property and selecting Go to Object.

Future Extensions

Here are some ideas about improvements that could be made to the above tools:
• Some improvements could still be made to the support for editing polygons and polylines, like allowing to rotate and scale the selected nodes (#1487).

• The tools could put short usage instructions in the status bar, to help new users without requiring them to carefully read the manual (#1855).

If you like any of these plans, please help me getting around to it faster by sponsoring Tiled development. The more support I receive the more time I can afford to spend improving Tiled!
Editing Tilesets

To edit a tileset it needs to be opened explicitly for editing. External tilesets can be opened via the File menu, but in general the quickest way to edit the tileset when it is already open in the Tilesets view is to click the small Edit Tileset button in the tool bar below the tileset.

6.1 Two Types of Tileset

A tileset is a collection of tiles. Tiled currently supports two types of tilesets, which are chosen when creating a new tileset:

Based on Tileset Image  This tileset defines a fixed size for all tiles and the image from which these tiles are supposed to be cut. In addition it supports a margin around the tiles and a spacing between the tiles, which allows for using tileset images that either happen to have space between or around their tiles or those that have extruded the border pixels of each tile to avoid color bleeding.

Collection of Images  In this type of tileset each tile refers to its own image file. It is useful when the tiles aren’t the same size, or when the packing of tiles into a texture is done later on.

Regardless of the type of tileset, you can associate a lot of meta-information with it and its tiles. Some of this information can be for use in your game, like collision information and animations. Other information is primarily meant for certain editing tools.

Note:  A tileset can be either embedded in a map file or saved externally. Since Tiled 1.0, the default and recommended approach is to save your tilesets to their own file. This simplifies your workflow since it makes sure any meta-information is shared between all maps using the same tileset.

6.2 Tileset Properties

You can access the tileset properties by using the menu action Tileset > Tileset Properties.
Name  The name of the tileset. Used to identify the tileset in the Tilesets view when editing a map.

Object Alignment  The alignment to use for tile objects referring to tiles from this tileset. This affects the placement of the tile relative to the position of the object (the origin) and is also the location around which the rotation is applied.

Possible values are: Unspecified (the default), Top Left, Top, Top Right, Left, Center, Right, Bottom Left, Bottom and Bottom Right. When unspecified, tile object alignment is generally Bottom Left, except for Isometric maps where it is Bottom.

Drawing Offset  A drawing offset in pixels, applied when rendering any tile from the tileset (as part of tile layers or as tile objects). This is can be useful to make your tiles align to the grid.

Background Color  A background color for the tileset, which can be set in case the default dark-gray background is not suitable for your tiles.

Orientation  When the tileset contains isometric tiles, you can set this to Isometric. This value, along with the Grid Width and Grid Height properties, is taken into account by overlays rendered on top of the tiles. This helps for example when specifying Terrain Information. It also affects the orientation used by the Tile Collision Editor.

Columns  This is a read-only property for tilesets based on a tileset image, but for image collection tilesets you can control the number of columns used when displaying the tileset here.

Image  This property only exists for tiles based on a tileset image. Selecting the value field will show an Edit... button, allowing you to change the parameters relevant to cutting the tiles from the image.

Of course, as with most data types in Tiled, you can also associate Custom Properties with the tileset.

6.3 Tile Properties

ID  The ID of the tile in the tileset (read-only)

Type  This property refers to custom types defined in the Object Types Editor. See the section about Typed Tiles for more information.

Width and Height  The size of the tile (read-only)

Probability  Represents a relative probability that this tile will get chosen out of multiple options. This value is used in Random Mode and by the Terrain Brush.

Image  Only relevant for tiles that are part of image collection tilesets, this shows the image file of the tile and allows you to change it.

6.4 Terrain Information

Terrain information can be added to a tileset to enable the use of the the Terrain Brush. See the section about defining terrain information.

6.5 Tile Collision Editor

The tile collision editor is available by clicking the Tile Collision Editor button on the tool bar. This will open a view where you can create and edit shapes on the tile. You can also associate custom properties with each shape.
Usually these shapes define collision information for a certain sprite or for a tile representing level geometry, but of course you could also use them to add certain hot-spots to your sprites like for particle emitters or the source of gunshots.

![Tile Collision Editor](image)

Fig. 1: Tile Collision Editor

To be able to easily check whether your tiles have the right collision shapes set up, they can be rendered on the map. To enable this, check Show Tile Collision Shapes in the View menu. The collision shapes are rendered for both tile layers and tile objects.

### 6.6 Tile Animation Editor

The tile animation editor allows defining a single linear looping animation with each tile by referring to other tiles in the tileset as its frames. Open it by clicking the Tile Animation Editor button.

Tile animations can be live-previewed in Tiled, which is useful for getting a feeling of what it would look like in-game. The preview can be turned on or off via View > Show Tile Animations.

The following steps allow to add or edit a tile animation:

- Select the tile in the main Tiled window. This will make the Tile Animation Editor window show the (initially empty) animation associated with that tile, along with all other tiles from the tileset.
- Drag tiles from the tileset view in the Tile Animation Editor into the list on the left to add animation frames. You can drag multiple tiles at the same time. Each new frame gets a default duration of 100 ms (or other value when set using the Frame Duration field at the top).
- Double-click on the duration of a frame to change it.
- Drag frames around in the list to reorder them.
Fig. 2: Collision shapes rendered on the map. This map is from Owyn’s Adventure.

Fig. 3: Tile Animation Editor
A preview of the animation shows in the bottom left corner.

You can change the duration of multiple frames at once by selecting them, changing the value in the Frame Duration field and then clicking Apply.

### Future Extensions

There are many ways in which the tileset editor can be made more efficient, for example:

**Terrain Sets**

- Make it easier to set up terrain (#1729)

**Tile Collision Editor**

- Allow setting collisions for multiple tiles at once (#1322)
- Render tile collision shapes to the tileset view (#1281)

**Tile Animation Editor**

- Support multiple named animations per tile (#986)
- Make it easier to define animations spanning multiple tiles (#811)

If you like any of these plans, please help me getting around to it faster by sponsoring Tiled development. The more support I receive the more time I can afford to spend improving Tiled!
CHAPTER 7

Custom Properties

One of the major strengths of Tiled is that it allows setting custom properties on all of its basic data structures. This way it is possible to include many forms of custom information, which can later be used by your game or by the framework you’re using to integrate Tiled maps.

Custom properties are displayed in the Properties view. This view is context-sensitive, usually displaying the properties of the last selected object. For tiles in a tileset or objects on an object layer, it also supports multi-selection.

7.1 Adding Properties

When you add a property (using the ‘+’ button at the bottom of the Properties view), you are prompted for its name and its type. Currently Tiled supports the following basic property types:

- **bool** (true or false)
- **color** (a 32-bit color value)
- **file** (a relative path referencing a file)
- **float** (a floating point number)
- **int** (a whole number)
- **object** (a reference to an object) - Since Tiled 1.4
- **string** (any text, including multi-line text)

The property type is used to choose a custom editor in the Properties view. Choosing a number or boolean type also avoids that the value will get quoted in JSON and Lua exports.

The context menu for custom file properties provides a quick way to open the file in its preferred editor. For object references, there is an action to quickly jump to the referenced object.
Fig. 1: Properties View

Fig. 2: Add Property Dialog
7.2 Tile Property Inheritance

When custom properties are added to a tile, these properties will also be visible when an object instance of that tile is selected. This enables easy per-object overriding of certain default properties associated with a tile. This becomes especially useful when combined with Typed Tiles.

Inherited properties will be displayed in gray (disabled text color), whereas overridden properties will be displayed in black (usual text color).

7.3 Predefining Properties

7.3.1 General Setup

Usually you only use a limited set of object types in your game, and each type of object has a fixed set of possible properties, with specific types and default values. To save you time, Tiled allows predefining these properties based on the “Type” field for objects. You can set this up using the Object Types Editor, available from the View menu.

![Object Types Editor](image)

By default, Tiled stores these object types globally. However, since you’ll often want to share them with other people in your project, you can export your object types or change the storage location of the object types file for your project. A simple XML or JSON file with self-explanatory contents is used to store your object types.

The color not only affects the rendering of the various shapes of objects, but is also the color of the label which will show up if you give your object a name.

To make the predefined properties show up in the Properties view, all you need to do is to enter the name of the type in the built-in “Type” property. Usually this is what you’re doing already anyway to tell your engine what kind of object it is dealing with.
7.3.2 Typed Tiles

If you’re using tile objects, you can set the type on the tile to avoid having to set it on each object instance. Setting the type on the tile makes the predefined properties visible when having the tile selected, allowing to override the values. It also makes those possibly overridden values visible when having a tile object instance selected, again allowing you to override them.

An example use-case for this would be to define custom types like “NPC”, “Enemy” or “Item” with properties like “name”, “health” or “weight”. You can then specify values for these on the tiles representing these entities. And when placing those tiles as objects, you can override those values if you need to.

Future Extensions

There are several types of custom properties I’d like to add:

- **Enumerations**, where you can predefine all possible values and it forms a combo box (#1211).
- **Array properties**, which would be properties having a list of values (#1493).
- **Dictionary properties**, which would be properties that can contain any number of other properties as children (#489).

It would also be nice to add support for **limiting property values**, like the length of string properties or a minimum/maximum on number values.

Apart from predefining properties based on object type, I’d like to add support for predefining the properties for each data type. So defining which custom properties are valid for maps, tilesets, layers, etc. (#1410)

If you like any of these plans, please help me getting around to it faster by sponsoring Tiled development. The more support I receive the more time I can afford to spend improving Tiled!
Any created object can be saved as a template. These templates can then be instantiated elsewhere as objects that inherit the template’s properties. This can save a lot of tedious work of setting up the object type and properties, or even just finding the right tile in the tileset.

Each template is stored in its own file, where they can be organized in directories. You can save templates in either XML or JSON format, just like map and tileset files.
8.1 Creating Templates

A template can be created by right clicking on any object in the map and selecting “Save As Template”. You will be asked to choose the file name and the format to save the template in. If the object already has a name the suggested file name will be based on that.

To be able to select your templates for editing or instantiating you’ll generally want to use the Project view, so make sure to save your templates in a folder that is part of your project. Dragging in a template from a file manager is also possible.

Note: You can’t create a template from a tile object that uses a tile from an embedded tileset, because template files do not support referring to such tilesets.

8.2 Creating Template Instances

Shortcut: V

Template instantiation works by either dragging and dropping the template from the Project view to the map, or by using the “Insert Template” tool by selecting a template and clicking on the map. The latter is more convenient when you want to create many instances.

8.3 Editing Templates

Editing templates is done using the Template Editor view. A template can be opened for editing by selecting it in the Project view or by dragging the template file on the Template Editor view. The template can also be selected using the Open File in Project action.

When selecting the template in the Template Editor view, the Properties view will show the template’s properties, where they can be edited.

Any changes to the template are saved automatically and are immediately reflected on all template instances.

If a property of a template instance is changed, it will be internally marked as an overridden property and won’t be changed when the template changes.

If a template file changes on disk, it is automatically reloaded and any changes will be reflected in the Template Editor as well as on any template instances.

8.4 Detaching Template Instances

Detaching a template instance will disconnect it from its template, so any further edits to the template will not affect the detached instance.

To detach an instance, right click on it and select Detach.

If your map loader does not support object templates, but you’d still like to use them, you can enable the Detach templates export option.
Future Extensions

- Resetting overridden properties individually (#1725).
- Locking template properties (#1726).
- Handling wrong file paths (#1732).
- Managing the templates folder, e.g. moving, renaming or deleting a template or a sub-folder (#1723).
CHAPTER 9

Using Terrains

When editing a tile map, sometimes we don’t think in terms of tiles but rather in terms of terrains - areas of tiles with transitions to other kinds of tiles. Say we want to draw a patch of grass, a road or a certain platform. In this case, manually choosing the right tiles for the various transitions or connections quickly gets tedious. The Terrain Brush was added to make editing tile maps easier in such cases.

**Warning:** While Tiled has supported terrains since version 0.9 and later supported a similar feature called “Wang tiles” since version 1.1, both features were unified and extended in Tiled 1.5. As a result, terrain information defined in Tiled 1.5 can’t be used by older versions.

The Terrain Brush relies on the tileset providing one or more Terrain Sets - sets of tiles labelled according to their terrain layouts. Tiled supports the following terrain sets:

- **Corner Set** Tiles that needs to match neighboring tiles at their corners, with a transition from one type of terrain to another in between. A complete set with 2 terrains has 16 tiles.

- **Edge Set** Tiles that need to match neighboring tiles at their sides. This is common for roads, fences or platforms. A complete set with 2 terrains has 16 tiles.

- **Mixed Set** Tiles that rely on matching neighboring tiles using both their corners and sides. This allows a tileset to provide more variation, at the cost of needing significantly more tiles. A complete set with 2 terrains has 256 tiles, but reduced sets like the 47-tile Blob tileset can be used with this type as well.

Based on the information in a terrain set, the Terrain Brush can understand the map and automatically choose the right tiles when making edits. When necessary, it also adjusts neighboring tiles to make sure they correctly connect to the modified area.

The Stamp Brush, as well as the Bucket Fill Tool and the Shape Fill Tool, also have a mode where they can fill an area with random terrain.
9.1 Define the Terrain Information

9.1.1 Creating the Terrain Set

First of all, switch to the tileset file. If you’re looking at the map and have the tileset selected, you can do this by clicking the small Edit Tileset button below the Tiles view.

![Fig. 1: Edit Tileset button](image)

Then, activate the terrain editing mode by clicking on the Terrain Sets button on the tool bar. With this mode activated, the Terrain Sets view will become visible, with a button to add a new set. In this example, we’ll define a Corner Set.

![Fig. 2: Adding a Terrain Set](image)

When adding a terrain set, the name of the new set will automatically get focus. Give the set a recognizable name, in the example we’ll type “Desert Ground”. We can also set one of the tiles as the icon of the set by right-clicking a tile and choosing “Use as Terrain Set Image”.

9.1.2 Adding Terrains

The new set will have one terrain added by default. If we already know we need additional ones, click the Add Terrain button to add more.

Each terrain has a name, color and can have one of the tiles as its icon it to make it more recognizable. Double-click the terrain to edit its name. To change the color, right-click the terrain and choose “Pick Custom Color”. To assign an icon, select the terrain and then right-click a tile, choosing “Use as Terrain Image”.

![Fig. 3: Our Terrains](image)

**Note:** We generally don’t need to define an explicit terrain for “empty tiles”. If you have tiles transitioning to nothing, it should be enough to not mark those areas.

With our terrains set up we’re ready to mark each of our tiles.
9.1.3 Marking the Tiles

Note that for a Corner Set, we can only mark the corners of the tiles. For a Edge Set, we’re limited to marking the edges of our tiles. If we need both we need to use a Mixed Set. If it turns out that we chose the wrong type of terrain set, we can still change the type in the Properties view (right-click the terrain set and choose Terrain Set Properties…).

With the terrain we want to mark selected, click and drag to mark the regions of the tiles that match this terrain.

![Fig. 4: Here we have marked all the sandy corners in our example tileset.](image)

If you make a mistake, just use Undo (or press Ctrl+Z). Or if you notice a mistake later, either use Erase Terrain to clear a terrain type from a corner or select the correct terrain type and paint over it. Each corner can only have one type of terrain associated with it.

Now do the same for each of the other terrain types. Eventually you’ll have marked all tiles apart from the special objects.

![Fig. 5: We’re done marking the terrain of our tiles.](image)

Patterns View

Next to the Terrains tab there’s also a Patterns tab. This view can be useful when marking complete sets, since it can highlight still missing patterns. Each pattern which already occurs on a tile in the tileset is darkened, to make the missing patterns stand out. Note though, that it is not necessary for a terrain set to have all possible patterns, especially when using more than 2 terrains.

![Fig. 6: Patterns view, showing all possible combinations in the set.](image)
9.2 Editing with the Terrain Brush

Now you can disable the Terrain Sets mode by clicking the tool bar button again. Then switch back to the map and activate the Terrain Sets window. Select the terrain set we have just set up, so we can use its terrains.

Click on the Sand terrain and try to paint. You may immediately notice that nothing is happening. This is because there are no other tiles on the map yet, so the terrain tool doesn’t really know how to help (because we also have no transitions to “nothing” in our tileset). There are two ways out of this:

- We can hold Ctrl (Command on a Mac) to paint a slightly larger area. This way we will paint at least a single tile filled with the selected terrain, though this is not convenient for painting larger areas.

- Assuming we’re out to create a desert map, it’s better to start by filling the entire map with sand. Just switch back to the Tilesets window for a moment, select the sand tile and then use the Bucket Fill Tool.

Once we’ve painted some sand, let’s select the Cobblestone terrain. Now you can see the tool in action!

![Fig. 7: Drawing cobblestone](image)

Finally, see what happens when you try drawing some dirt on the cobblestone. Because there are no transitions from dirt directly to cobblestone, the Terrain tool first inserts transitions to sand and from there to cobblestone. Neat!

![Fig. 8: Drawing dirt](image)

Note: An Erase Terrain button is provided for the case where your terrain tiles transition to nothing. This allows for erasing parts of your terrain while choosing the right tiles as well. This mode does nothing useful when there are no transitions to nothing in the selected Terrain Set.

9.3 Terrain Fill Mode

The Stamp Brush, Bucket Fill Tool and the Shape Fill Tool have a Terrain Fill Mode, which can be used to paint or fill an area with random terrain. With this mode activated, each cell will be randomly chosen from all those in the selected Terrain Set, making sure to match all adjacent edges and/or corners.
Note that since this mode makes sure that newly placed tiles match up with any already existing tiles, generally nothing will change when painting with the Stamp Brush on existing terrain. The exception is when there are multiple variations of the same tile, in which case it will randomize between those.

When filling a shape or an area, only the edges of the filled area need to connect to any existing tiles. Internally the area is completely randomized.

### 9.4 Tile and Terrain Probability

Both the **Terrain Fill Mode** and the Terrain Brush will by default consider all matching tiles with equal probability. Both individual tiles as well as terrains have a *Probability* property, which can be used to change the frequency with which a certain tile or terrain is chosen compared to other valid options.

The relative probability of a tile is the product of its own probability and the probability of the terrain at each corner and/or side.

![Diagram showing relative tile and terrain probabilities](image)

Fig. 11: Left shows “path” with probability 0.1, right shows “path” with probability 10.
9.4.1 Probability for Variations

A common usage for probability, especially at the individual tile level, is to make certain variations of a tile less common than others. Our example tileset contains several bushes and other decorations which we may randomly want to scatter across the desert.

To achieve this, first of all we mark all of them as “sand” tiles, because this is their base terrain. Then, to make them less common than the regular sand tile, we can put their probability on 0.01. This value means they are each 100 times less likely to be chosen than the regular sand tile (which still has its default probability of 1). To edit the Probability property of the tiles we need to exit the Terrain Sets mode.

![Fig. 12: Setting low probability on decoration tiles.](image)

Fig. 12: Setting low probability on decoration tiles.

![Fig. 13: Random decorative tiles appearing with low probability.](image)

Fig. 13: Random decorative tiles appearing with low probability.

**Hint:** It is also possible to put the probability to 0, which disables automatic usage of a tile entirely. This can be useful because it still makes the tools aware of the terrain of a certain tile, which is taken into account when modifying neighboring tiles.

9.5 Tile Transformations

Tiled supports flipping and rotating tiles. When using terrains, tiles can be automatically flipped and/or rotated to create variations that would otherwise not be available in a tileset. This can be enabled in the Tileset Properties.

The following transformation-related options are available:

**Flip Horizontally** Allow tiles to be flipped horizontally.
**Flip Vertically**  Allow tiles to be flipped vertically. This would be left disabled when the graphics contain shadows in vertical direction, for example.

**Rotate**  Allow tiles to be rotated (by 90, 180 or 270-degrees).

**Prefer Untransformed Tiles**  When transformations are enabled, it could happen that a certain pattern can be filled by either a regular tile or a transformed tile. With this option enabled, the untransformed tiles will always take precedence. Leaving this option disabled allows transformations to be used to create more variation.

![Example](image)

Fig. 14: With rotations enabled, the normally 47-tiles Blob tileset can be reduced to a mere 15 tiles.

### 9.6 Final Words

Now you should have a pretty good idea about how to use this tool in your own project. A few things to keep in mind:

- For one terrain to interact with another, they need to be part of the same Terrain Set. This also means all tiles need to be part of the same tileset. If you have tiles in different tilesets that you want to transition to one another, you will need to merge the tilesets into one.

- Since defining the terrain information can be somewhat laborious, you’ll want to avoid using embedded tilesets so that terrain information can be shared among several maps.

- The Terrain tool works fine with isometric maps as well. To make sure the terrain overlay is displayed correctly, set up the Orientation, Grid Width and Grid Height in the tileset properties.

- The tool will handle any number of terrains (up to 255) and each corner of a tile can have a different type of terrain. Still, there are other ways of dealing with transitions that this tool can’t handle. Also, it is not able to edit multiple layers at the same time. For a more flexible, but also more complicated way of automatic tile placement, check out Automapping.

- There’s a collection of tilesets that contain transitions that are compatible with this tool on OpenGameArt.org.
Infinite maps give you independence from bounds of the map. The canvas is “auto-growing”, which basically means, that you have an infinite grid which can be painted upon without worrying about the width and height of the map. The bounds of a particular layer get expanded whenever tiles are painted outside the current bounds.

### 10.1 Creating an Infinite Map

In the order to create an infinite map, make sure the ‘Infinite’ option is selected in New Map dialog.
Chapter 10. Using Infinite Maps
The newly created map will then have an infinite canvas.

10.2 Editing the Infinite Map

Except for the Bucket Fill Tool, all tools work exactly in the same way as in the fixed-size maps. The Bucket Fill Tool fills the current bounds of that particular tile layer. These bounds get increased upon further painting of that tile layer.

10.3 Conversion from Infinite to Finite Map and Vice Versa

In the map properties, you can toggle whether the map should be infinite or not. When converting from infinite to a finite map, the width and height of the final map are chosen on the basis of bounds of all the tile layers.
Chapter 10. Using Infinite Maps

Fig. 2: Unchecking the Infinite property in Map Properties
10.3. Conversion from Infinite to Finite Map and Vice Versa

Fig. 3: The Converted Map
Sometimes a game has a large world which is split over multiple maps to make the world more digestible by the game (less memory usage) or easier to edit by multiple people (avoiding merge conflicts). It would be useful if the maps from such a world could be seen within the same view, and to be able to quickly switch between editing different maps. Defining a world allows you to do exactly that.

11.1 Defining a World

A world is defined in a .world file, which is a JSON file that tells Tiled which maps are part of the world and at what location. Worlds can be created by using the Map > New World… action.
You may also create .world files by hand. Here is a simple example of a world definition, which defines the global position (in pixels) of three maps:

```json
{
    "maps": [
        {
            "fileName": "001-1.tmx",
            "x": 0,
            "y": 0
        },
        {
            "fileName": "002-1.tmx",
            "x": 0,
            "y": 3200
        },
        {
            "fileName": "006-1.tmx",
            "x": 3840,
            "y": 4704
        }
    ],
    "type": "world"
}
```

Once defined, a world needs to be loaded by choosing Map > Load World... from the menu. Multiple worlds can be loaded at the same time, and worlds will be automatically loaded again when Tiled is restarted.

When a map is opened, Tiled checks whether it is part of any of the loaded worlds. If so, any other maps in the same world are loaded as well and displayed alongside the opened map. You can click any of the other maps to open them for editing, which will switch files while keeping the view in the same position.

Worlds are reloaded automatically when their file is changed on disk.

### 11.2 Editing Worlds

Once you have loaded a world, you can select the ‘World Tool’ from the toolbar to add, remove and move maps within the world.

**Adding Maps** Click the ‘Add the current map to a loaded world’ button on the toolbar, from the dropdown menu select the world you want to add it to. To add a different map to the current world, you can use the ‘Add another map to the current world’ button from the toolbar. Alternatively, both actions can be accessed by rightclicking in the map editor.

**Removing Maps** Hit the ‘Remove the current map from the current world’ button on the toolbar. Alternatively, rightclick a map in the map editor and select the ‘Remove... from World...’ action from the context menu.

**Moving Maps** Simply drag around maps within the map editor. You can abort moving a map by hitting ‘Escape’ or by right-clicking.

Alternatively you can use the arrow keys to move the current selected map - holding Shift will perform bigger steps.

**Saving World files** You can save manipulated world files by using the Map > Save World menu. Worlds will also automatically be saved if you launch any external tool that has the ‘Save Map Before Executing’ option enabled.
11.3 Using Pattern Matching

For projects where the maps follow a certain naming style that allows the location of each map in the world to be derived from the file name, a regular expression can be used in combination with a multiplier and an offset.

**Note:** Currently no interface exists in Tiled to define a world using pattern matching, nor can it be modified. World files with patterns have to be manually edited.

Here is an example:

```json
{
    "patterns": [
        {
            "regexp": "ow-p0*\d+-n0*\d+o0000.tmx",
            "multiplierX": 6400,
            "multiplierY": 6400,
            "offsetX": -6400,
            "offsetY": -6400
        }
    ],
    "type": "world"
}
```

The regular expression is matched on all files that live in the same directory as the world file. It captures two numbers, the first is taken as \(x\) and the second as \(y\). These will then be multiplied by \(multiplierX\) and \(multiplierY\) respectively, and finally \(offsetX\) and \(offsetY\) are added. The offset exists mainly to allow multiple sets of maps in the same world to be positioned relative to each other. The final value becomes the position (in pixels) of each map.

![Image](image_url)

Fig. 2: The island from Alchemic Cutie, using patterns to automatically show each map at the right location.

A world definition can use a combination of manually defined maps and patterns.

11.4 Showing Only Direct Neighbors

Tiled takes great care to only load each map, tileset and image once, but sometimes the world is just too large for it to be loaded completely. Maybe there is not enough memory, or rendering the entire map is too slow.

In this case, there is an option to only load the direct neighbors of the current map. Add "onlyShowAdjacentMaps": true to the top-level JSON object.

To make this possible, not only the position but also the size of each map needs to be defined. For individual maps, this is done using width and height properties. For patterns, the properties are mapWidth and mapHeight, which default to the defined multipliers for convenience. All values are in pixels.

**Note:** In the future, a property could be added to allow specifying a distance around the current map in which other
maps are loaded.
The Command Button allows you to create and run shell commands (other programs) from Tiled.
You may setup as many commands as you like. This is useful if you edit maps for multiple games and you want to set up a command for each game. Or you could setup multiple commands for the same game that load different checkpoints or configurations.

12.1 The Command Button

It is located on the main toolbar to the right of the redo button. Clicking on it will run the default command (the first command in the command list). Clicking the arrow next to it will bring down a menu that allows you to run any command you have set up, as well as an option to open the Edit Commands dialog. You can also find all the commands in the File menu.
Apart from this, you can set up custom keyboard shortcuts for each command.

12.2 Editing Commands

The ‘Edit Commands’ dialog contains a list of commands. Each command has several properties:
Name The name of the command as it will be shown in the drop down list, so you can easily identify it.
Executable The executable to run. It should either be a full path or the name of an executable in the system PATH.
Arguments The arguments for running the executable.
Working directory The path to the working directory.
Shortcut A custom key sequence to trigger the command. You can use ‘Clear’ to reset the shortcut.
Output in Debug Console If this is enabled, then the output (stdout and stderr) of this command will be displayed in the Debug Console. You can find the Debug Console in View > Views and Toolbars > Debug Console.
Save map before executing If this is enabled, then the current map will be saved before executing the command.
**Enabled** A quick way to disable commands and remove them from the drop down list. The default command is the first enabled command.

Note that if the executable or any of its arguments contain spaces, these parts need to be quoted.

### 12.2.1 Substituted Variables

In the executable, arguments and working directory fields, you can use the following variables:

- `%mapfile` the full path of the current file (either map or tilesset).
- `%mappath` the path in which the current file is located.
- `%projectpath` the path in which the current project is located.
- `%objecttype` the type of the currently selected object, if any.
- `%objectid` the ID of the currently selected object, if any.
- `%layername` the name of the currently selected layer.
- `%tileid` a comma-separated list with the IDs of the selected tiles, if any.

For the working directory field, you can additionally use the following variable:

- `%executablepath` the path to the executable.

### 12.3 Example Commands

Launching a custom game called “mygame” with a -loadmap parameter and the mapfile:

```
mygame -loadmap %mapfile
```

On Mac, remember that Apps are folders, so you need to run the actual executable from within the Contents/MacOS folder:

```
/Applications/TextEdit.app/Contents/MacOS/TextEdit %mapfile
```

Or use `open` (and note the quotes since one of the arguments contains spaces):

```
open -a "/Applications/CoronaSDK/Corona Simulator.app" /Users/user/Desktop/project/main.lua
```

Some systems also have a command to open files in the appropriate program:

- **OSX**: `open %mapfile`
- **GNOME systems like Ubuntu**: `gnome-open %mapfile`
- **FreeDesktop.org standard**: `xdg-open %mapfile`
13.1 What is Automapping?

Automapping is an advanced tool to automatically search certain combinations of tiles across layers in a map and to replace these parts with another combination. This allows the user to draw structures quickly and Automapping will generate a complex scenario from them, which would have taken much more time if manually crafted.

The goal of Automapping is that you only need to draw within one layer and everything else is setup for you. This brings some advantages:

- **Working speed** - you need less time to setup a map.
- **Less errors** - the main reason is to reduce the error rate. If you have setup the rules properly, there are no hidden errors.

13.1.1 External Links

- Automapping explained for Tiled 0.9 and later (YouTube)
- Examples on Automapping
- Tiled Map Editor Tutorial Part Three: AutoMap (YouTube)

13.2 Setting it Up

The Automapping feature looks for a text file called ‘rules.txt’ in the folder where the current map is located. Each line in this text file is either

- a path to a **rulefile**
- or a path to another textfile which has the same syntax (i.e. in another directory)
- or is a comment which is indicated by # or //
A `rulefile` is a standard map file, which can be read and written by tiled (*.tmx). In one rulefile there can be multiple defined rules.

An automapping `rulefile` consists of 4 major parts:

1. The definition of regions describes which locations of the rulemap are actually used to create Automapping rules.
2. The definition of inputs describes which kind of pattern the working map will be searched for.
3. The definition of outputs describes how the working map is changed when an input pattern is found.
4. The map properties are used to fine-tune the input pattern localization and the output of all rules within this rules file.

### 13.2.1 Defining the Regions

There must be either a tile layer called `regions` or there must be both tile layers `regions_input` and `regions_output`. Using the `regions` layer, the region defined for input and output is the same. Using the different layers `regions_input` and `regions_output` delivers the possibility to have different regions for the input section and the output section. The region layer(s) are only used to mark regions where an Automapping rule exists. Therefore, it does not matter which tiles are used in this layer, since these tiles are just used to define a region. So either use any tile or no tile at a coordinate to indicate if that coordinate belongs to a rule or if it doesn’t.

If multiple rules are defined in one rulemap file, the regions must not be adjacent. That means there must be at least one tile of unused space in between two rules. If the regions are adjacent (coherent) then both regions are interpreted as one rule.

### Multiple Rules in One Rulefile

Multiple rules are possible in one rulemap. However, if you want to have the rules applied in a certain sequence, you should use multiple `rulefiles` and define the sequence within the `rules.txt` file. As of now there also is a certain sequence within one rulemapfile. Generally speaking the regions with small y value come first. If there are regions at the same y value, then the x value is taken into account. On orthogonal maps this ordering scheme is the same as for reading in most western countries (Left to right, top to bottom). The order within one rulemap may be changed later, once tiled is capable of utilizing multiple threads/processors. So if you want to rely on a certain sequence, use different rulemaps and order these in the rules.txt

### 13.2.2 Definition of Inputs

Inputs are generally defined by tile layers which name follows this scheme:

`input[not][index]_name`

where the `[not]` and `[index]` are optional. After the first underscore there will be the name of the input layer. The input layer name can of course include more underscores.

The `name` determines which layer on the working map is examined. So for example the layer `input_Ground` will check the layer called `Ground` in the working map for this rule. `input_test_case` will check the layer `test_case` in the working map for this rule.

Multiple layers having the same name and index is explicitly allowed and is intended. Having multiple layers of the same name and index , will allow you to define different possible tiles per coordinate as input.

The index is used to create complete different input conditions. All layers having the same index are taken into account for forming one condition. Each of these conditions are checked individually.

1. index must not contain an underscore.
2. index must not start with *not*
3. index may be empty.

If there are tiles in the standard input layers one of these tiles must be there to match the rule. The optional *not* inverts the meaning of that layer. So if there are input not layers, the tiles placed on them, must not occur in the working map at the examined region to make a rule match. Within one rule you can combine the usage of both input and input not layers to make rules input conditions as accurate as you need or as fuzzy as you need.

### 13.2.3 Definition of Outputs

Outputs are generally defined by layers which name follows this scheme:

```markdown
output[index]_name
```

which is very similar to the input section. At first there must be the word output. Then optionally an *index* may occur. After the first underscore there will be the name of the target layer. The target layer name can of course include more underscores.

All layers of the same index are treated as one possible output. So the intention of indexes in the outputs of rules is only used for random output.

The indexes in the output section have nothing to do with the indexes in the input section, they are independent. In the output section they are used for randomness. In the input section they are used to define multiple possible layers as input. So when there are multiple indexes within one rule, the output will be chosen fairly (uniformly distributed) across all indexes. So a dice will be rolled and one index is picked. All of the output layers carrying this index will be put out into the working map then.

Note that the output is not being checked for overlapping on itself. This can be achieved by setting the map property *NoOverlappingRules* to true.

### 13.2.4 Map Properties

The following map properties can be used to customize the behavior of the rules in a *rulefile*:

- **DeleteTiles** This map property is a boolean property: it can be true or false. If rules of this rulefile get applied at some location in your map, this map property determines if all other tiles are deleted before applying the rules. Consider a map where you have multiple layers. Not all layers are filled at all places. In that case all tiles of all layers should be cleared, so afterwards there are only the tiles which are defined by the rules. Since when not all tiles are cleared before, you will have still tiles from before at these places, which are not covered by any tile.

- **AutomappingRadius** This map property is a number: 1, 2, 3 … It determines how many tiles around your changes will be checked as well for redoing the Automapping at live Automapping.

- **MatchOutsideMap** This map property determines whether rules can match even when their input region falls partially outside of a map. By default it is false for bounded maps and true for infinite maps. In some cases it can be useful to enable this also for bounded maps. Tiles outside of the map boundaries are simply considered empty unless one of either OverflowBorder or WrapBorder are also true.

  Tiled 1.0 and 1.1 behaved as if this property was true, whereas older versions of Tiled have behaved as if this property was false.

- **OverflowBorder** This map property customizes the behavior intended by the MatchOutsideMap property. When this property is true, tiles outside of the map boundaries are considered as if they were copies of the nearest inbound tiles, effectively “overflowing” the map’s borders to the outside region.

  When this property is true, it implies MatchOutsideMap. Note that this property has no effect on infinite maps (since there is no notion of border).
**WrapBorder**  This map property customizes the behavior intended by the **MatchOutsideMap** property. When this property is `true`, the map effectively “wraps” around itself, making tiles on one border of the map influence the regions on the other border and vice versa.

When this property is `true`, it implies **MatchOutsideMap**. Note that this property has no effect on infinite maps (since there is no notion of border).

If both **WrapBorder** and **OverflowBorder** are `true`, **WrapBorder** takes precedence over **OverflowBorder**.

**NoOverlappingRules**  This map property is a boolean property: A rule is not allowed to overlap on itself.

These properties are map wide, meaning it applies to all rules which are part of the rulemap. If you need rules with different properties you can use multiple rulemaps.

### 13.2.5 Layer Properties

The following properties are supported on a per-layer basis:

**StrictEmpty**  This layer property is a boolean property. It can be added to **input** and **inputnot** layers to customize the behavior for empty tiles within the input region.

In “StrictEmpty” mode, empty tiles in the input region match empty tiles in the set layer. So when an “input” layer contains an empty tile within the input region, this means an empty tile is allowed at that location. And when an “inputnot” layer contains an empty tile within the input region, it means an empty tile is not allowed at that location.

### 13.3 Examples

#### 13.3.1 Abstract Input Layer Examples

**Having Multiple Input Layers with the Same Name**

Assume the following 3 tile layers as input, which possible inputs are there in the working map?
The following parts would be detected as matches for this rule:
Input Layers Using Different Indexes

Given the following 3 input tile layers:

<table>
<thead>
<tr>
<th>Tile layer</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 2</td>
<td>input_Ground</td>
</tr>
<tr>
<td>3 4</td>
<td>input_Ground</td>
</tr>
<tr>
<td>5 6</td>
<td>input2_Ground</td>
</tr>
</tbody>
</table>

The last layer has an index unequal to the other indexes (which are empty). All following parts would be recognized as matches within the working map:
13.3.2 The Mana World Examples

The Mana world examples will demonstrate quite a lot of different Automapping features. At first a shoreline will be constructed, by first adding all the straight parts and afterwards another rule will correct the corners to make them also fit the given tileset. After the shoreline has been added, the waters will be marked as unwalkable for the game engine. Last but not least the grass should be tiles should be made random by using 5 different grasss tiles.

![Fig. 1: This is what we want to draw.](image)

Basic Shoreline

This example will demonstrate how a straight shoreline can easily be setup between shallow water grass tiles. In this example we will only implement the shoreline, which has grass in southern and water in northern direction.
Fig. 2: Here we have straight shorelines applied.

Fig. 3: Here we have some corners.

Fig. 4: And corners the other way round as well.
Fig. 5: Here all unwalkable tiles are marked.

Fig. 6: If you look closely at the grass, you’ll see they are now randomized.
So basically the meaning we will define in the input region is: *All tiles which are south of a water tile and are not water tiles themselves, will be replaced by a shoreline tile*

<table>
<thead>
<tr>
<th>Tile layer</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Regions" /></td>
<td>regions</td>
</tr>
<tr>
<td><img src="image2.png" alt="Input_Ground" /></td>
<td>input_Ground</td>
</tr>
<tr>
<td><img src="image3.png" alt="Output_Ground" /></td>
<td>output_Ground</td>
</tr>
</tbody>
</table>

The region in which this Automapping rule should be defined is of 2 tiles in height and 1 tile in width. Therefore we need a layer called *regions* and it will have 2 tiles placed to indicate this region.

The input layer called *input_Ground* is depicted in the middle. Only the upper tile is filled by the water tile. The lower tile contains no tile. It is not an invisible tile, just no tile at all.

And whenever there is no tile in a place within the rule regions in an input layer, what kind of tiles will be allowed there? There will be allowed any tiles except all used tiles within all input layer with the same index and name.

Here we only have one tile layer as an input layer carrying only the water tile. Hence at the position, where no tile is located, all tiles except that water tile are allowed.

The output layer called *output_Ground* shows the tile which gets placed, if this rule matches.

**Corners on a Shore Line**

This example is a continuation of the previous example. Now the corners of the given shoreline should be implemented automatically. Within this article we will just examine the bent in corner shoreline in the topleft corner. The other shoreline corners are constructed the same way. So after the example is applied, we would like to have the corners of the shoreline get suitable tiles. Since we rely on the other example being finished, we will put the rules needed for the corners into another new rulefile. (which is listed afterwards in rules.txt)
The shoreline may have some more corners nearby, which means there may be more different tiles than the straight corner lines. In the figure we see all inputs which should be covered.

Both the tiles in the top right corner and in the lower left corner are directly adjacent to the desired (slightly transparent) tile in the top left corner.

We can see 3 different tiles for the lower left corner, which is straight shore line, bent inside and bend outside shore lines.

Also we see 3 different inputs for the top right corner, which also is straight, bent in or out shore line.

**regions**

So with this rule we want to put the bent in shore line tile in the top left corner, we don’t care which tile was there before. Also we don’t care about the tile in the lower right corner. (probably water, but can be any decorative watertile, so just ignore it).

Therefore we will need different input and output regions. In the figure we can see the both tilelayers regions input and regions output. The input section covers just these two tiles as we discussed. The output region covers just the
single tile we want to output. Though the input and output region do not overlap, the united region of both the input and the output region is still one coherent region, so it’s one rule and works.

Output regions can be larger than absolutely required, since when there are no tiles in the Output section, the tiles in the working map are not overwritten but just kept as is, hence the Output region could also be sized as the united region of both the output and input region.

**regions_input**

Now we want to put all the nine possible patterns we observed as possible input for this rule. We could of course define nine different layers `input1_Ground` up to `input9_Ground`

Nine TileLayers?! what a mess, we’ll do it a better way.

Also, consider having not just 3 possible tiles at the 2 locations but 4. Then we would need $4 \times 4 = 16$ tilelayers to get all conditions. Another downside of this comes with more needed locations: Think of more than 2 locations needed to construct a ruleinput. So for 3 locations, then each location could have the 3 possibilities, hence you need $3 \times 3 \times 3 = 27$ tilelayers. It’s not getting better…

So let’s try a smart way: All input layers have the same name, so at each position any of the three different tiles is valid.

<table>
<thead>
<tr>
<th>Tile layer</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="input_Ground.png" alt="Image" /></td>
<td>input_Ground</td>
</tr>
<tr>
<td><img src="input_Ground.png" alt="Image" /></td>
<td>input_Ground</td>
</tr>
<tr>
<td><img src="input_Ground.png" alt="Image" /></td>
<td>input_Ground</td>
</tr>
</tbody>
</table>

**outputs**

The output is straightforward, since only one tile is needed. No randomness is needed, hence the index is not needed to be varied, so it’s kept empty. The desired output layer is called Ground, so the overall name of the single output layer will be output Ground. At this single layer at the correct location the correct tile is placed.
The Other Corners on a Shore Line

This is for corners bent the other way round. Basically it has the same concepts, just other tiles.
Adding Collision Tiles

The Mana World uses an extra tile layer called *Collision* to have information about whether a player is able to walk on certain tiles or not. That layer is invisible to the player, but the game engine parses it, whether there is a tile or there is...
no tile.
So we need to decide for each position if a player can walk there and put a tile into the *Collision* layer if it is unwalkable. 
*As input* layer we will parse the *Ground* layer and put collision tiles where the player should not walk.
Actually this task is a bunch of rules, but each rule itself is very easy:
## Chapter 13. Automapping

<table>
<thead>
<tr>
<th>Tile layer</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Tile layer 1" /></td>
<td>input_Ground</td>
</tr>
<tr>
<td><img src="image2.png" alt="Tile layer 2" /></td>
<td>output_Collision</td>
</tr>
<tr>
<td><img src="image3.png" alt="Tile layer 3" /></td>
<td>regions</td>
</tr>
</tbody>
</table>
In the above *regions* layer we have 14 different rules, because there are 14 incoherent regions in the *regions* layer. That's 9 different water tiles, which should be unwalkable and 5 different grass tiles which will be placed randomly in the next example.

As input we will have one of all the used tiles and as output there is either a tile in the *Collision* layer or not.

**Do we need the rules with clean output?** No, it is not needed for one run of Automapping. But if you are designing a map, you will likely add areas with collision and then remove some parts of it again and so on.

So we need to also remove the collision tiles from positions, which are not marked by a collision any more. This can be done by adding the map property *DeleteTiles* and setting it to *yes* or *true*. Then all the parts in the *Collision* layer will be erased before the Automapping takes place, so the collision tiles are only placed at real unwalkable tiles and the history of if there has been a collision tile placed is neglected.

**Random Grass Tiles**

In this example we will shuffle all grass tiles, so one grass tiles will be replaced with another randomly chosen tile.

As input we will choose all of our grass tiles. This is done by having each tile in its own input layer, so each grass tile gets accepted for this rule.

As output we will also put each grass tile into one output layer. To make it random the *index* of the output layers needs to be different for each layer.

The following rule might look the same, but there are different grass tiles. Each grass tile is in both one of the input and one of the output layers (the order of the layers doesn't matter).
<table>
<thead>
<tr>
<th>Tile layer</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>regions</td>
<td></td>
</tr>
<tr>
<td>input_Ground</td>
<td></td>
</tr>
<tr>
<td>input_Ground</td>
<td></td>
</tr>
<tr>
<td>input_Ground</td>
<td></td>
</tr>
<tr>
<td>input_Ground</td>
<td></td>
</tr>
<tr>
<td>output1_Ground</td>
<td></td>
</tr>
<tr>
<td>output2_Ground</td>
<td></td>
</tr>
<tr>
<td>output3_Ground</td>
<td></td>
</tr>
<tr>
<td>output4_Ground</td>
<td></td>
</tr>
<tr>
<td>output5_Ground</td>
<td></td>
</tr>
</tbody>
</table>
13.3.3 An alternating wall

This example will demonstrate how a wall as a transition between a walkable area and the non-walkable black void can easily be setup. As input a dedicated set layer will be used.

In my opinion a dedicated set layer is much easier to use for the rough draft, but for adding details such as collision information on decorative tiles the input should use the decoration.

The structure of the input, output and region layer is very similar to the example of the straight shoreline in The Mana World examples. The main difference is the different size. Since the wall contains multiple tiles in height, the height of the rulelayers is different as well. Vertically the tiles are also alternating. As you can see in the following figure, every second tile displaying the base board of the wall has a notch for example.
Hence the region in which this Automapping rule should be defined is of 4 tiles in height and 2 tile in width. Therefore we need a layer called *regions* and it will have 8 tiles placed to indicate this region. In the figure the top graphics shows such a region layer.
The input layer has the following meaning:

*If there are 2 vertical adjacent brown tiles in the set layer and in the 3x2 tiles above here are no brown tiles, this rule matches.*

Only the lowest 2 coordinates contain the brown tile. The upper coordinates contain no tile. (It is not an invisible tile, just no tile at all.) The input layer called *Input_set* is depicted in the middle of the figure.

The output consists of only one layer as well called *Output_Walls*. It contains the actual wall tiles.

![Fig. 7: Vertically the tiles are alternating.](image)

When trying to match the input layer to the desired set layer (right picture of the figure at the beginning of the example, you will see it matches all the way along, with no regard of the vertical adjustment.

Hence when we use the rule as discussed now, we will get not the desired result, because this rule overlaps itself. The overlapping problem is shown in figure above.

Since the overlapping is not desired, we can turn it off by adding a map property to the rulemap *NoOverlappingRules* and setting it to *true*.

Keep in mind that the map property applies for all rules on that rule map.
While there are many libraries and frameworks that work directly with Tiled maps, Tiled also supports a number of additional file and export formats, as well as exporting a map to an image.

Exporting can be done by clicking File > Export. When triggering the menu action multiple times, Tiled will only ask for the file name the first time. Exporting can also be automated using the --export-map and --export-tileset command-line parameters.

Several Export Options are available, which are applied to maps or tilesets before they are exported (without affecting the map or tileset itself).

## 14.1 Generic File Formats

Tiled supports exporting to several generic file formats which are not targeting any specific framework.

### 14.1.1 JSON

The JSON format is the most common additional file format supported by Tiled. It can be used instead of TMX since Tiled can also open JSON maps and tilesets and the format supports all Tiled features. Especially in the browser and when using JavaScript in general, the JSON format is easier to load.

### 14.1.2 Lua

Maps and tilesets can be exported to Lua code. This export option supports most of Tiled’s features and is useful when using a Lua-based framework like LÖVE (with Simple Tiled Implementation), Solar2D (with ponytiled or Dusk Engine) or Defold.

Currently not included are the type of custom properties (though the type does affect how a property value is exported) and information related to object templates.
### 14.1.3 CSV

The CSV export only supports *tile layers*. Maps containing multiple tile layers will export as multiple files, called `base_<layer-name>.csv`.

Each tile is written out by its ID, unless the tile has a custom property called `name`, in which case its value is used to write out the tile. Using multiple tiles will lead to ambiguous IDs, unless the custom `name` property is used. Empty cells get the value `-1`.

When tiles are flipped horizontally, vertically or diagonally, these states are exported using bitflags in the ID, in the same way as done in the *TMX Map Format*.

### 14.2 Defold

Tiled can export to Defold using one of the two supplied plugins. Both are disabled by default.

#### 14.2.1 defold

This plugin exports a map to a Defold Tile Map (*.tilemap). It only supports tile layers and only a single tileset may be used.

Upon export, the `tile_set` property of the Tile Map is left empty, so it will need to be set up in Defold after each export.

#### 14.2.2 defoldcollection

This plugin exports a map to a Defold Collection (*.collection), while also creating multiple .tilemap files.

It supports:

- Group layers (**only top-level group layers are supported, not nested ones!**)
- Multiple Tilesets per Tilemap

Upon export:

- The `Path` property of each Tileset may need to be set up manually in Defold after each export. However, Tiled will attempt to find the `.tilesource` file corresponding with the name your Tileset in Tiled in your project’s `/tilesources/` directory. If one is found, manual adjustments won’t be necessary.

- If you create custom properties on your map called `x-offset` and `y-offset`, these values will be used as coordinates for your top-level GameObject in the Collection. This is useful when working with Worlds.

All layers of a Tilemap will have Z-index property assigned with values ranging between 0 and 0.1. The plugin supports the use of 9999 Group Layers and 9999 Tile Layers per Group Layer.

When any additional information from the map is needed, the map can be exported in *Lua format* and loaded as Defold script.

### 14.3 GameMaker: Studio 1.4

GameMaker: Studio 1.4 uses a custom XML-based format to store its rooms, and Tiled ships with a plugin to export maps in this format. Currently only orthogonal maps will export correctly.
Tile layers and tile objects (when no type is set) will export as “tile” elements. These support horizontal and vertical flipping, but no rotation. For tile objects, scaling is also supported.

**Warning:** The tilesets have to be named the same as the corresponding backgrounds in the GameMaker project. Otherwise GameMaker will pop up an error for each tile while loading the exported `room.gmx` file.

### 14.3.1 Object Instances

GameMaker object instances are created by putting the object name in the “Type” field of the object in Tiled. Rotation is supported here, and for tile objects also flipping and scaling is supported (though flipping in combination with rotation doesn’t appear to work in GameMaker).

The following custom properties can be set on objects to affect the exported instance:

- **string** code (instance creation code, default: “”)
- **float** scaleX (default: derived from tile or 1.0)
- **float** scaleY (default: derived from tile or 1.0)
- **int** originX (default: 0)
- **int** originY (default: 0)

The `scaleX` and `scaleY` properties can be used to override the scale of the instance. However, if the scale is relevant then it will generally be easier to use a tile object, in which case it is automatically derived from the tile size and the object size.

The `originX` and `originY` properties can be used to tell Tiled about the origin of the object defined in GameMaker, as an offset from the top-left. This origin is taken into account when determining the position of the exported instance.

**Hint:** Of course setting the type and/or the above properties manually for each instance will get old fast. Since Tiled 1.0.2, you can instead use tile objects with the type set on the tile, and in Tiled 1.1 you can also use *object templates*.

### 14.3.2 Views

Views can be defined using *rectangle objects* where the Type has been set to *view*. The position and size will be snapped to pixels. Whether the view is visible when the room starts depends on whether the object is visible. The use of views is automatically enabled when any views are defined.

The following custom properties can be used to define the various other properties of the view:

**Port on screen**

- **int** xport (default: 0)
- **int** yport (default: 0)
- **int** wport (default: 1024)
- **int** hport (default: 768)

**Object following**
• string objName
• int hborder (default: 32)
• int vborder (default: 32)
• int hspeed (default: -1)
• int vspeed (default: -1)

Hint: When you’re defining views in Tiled, it is useful to add view as object type in the Object Types Editor, adding the above properties for ease of access. If you frequently use views with similar settings, you can set up templates for them.

14.3.3 Map Properties

General

• int speed (default: 30)
• bool persistent (default: false)
• bool clearDisplayBuffer (default: true)
• bool clearViewBackground (default: false)
• string code (map creation code, default: “”)

Physics

• bool PhysicsWorld (default: false)
• int PhysicsWorldTop (default: 0)
• int PhysicsWorldLeft (default: 0)
• int PhysicsWorldRight (default: width of map in pixels)
• int PhysicsWorldBottom (default: height of map in pixels)
• float PhysicsWorldGravityX (default: 0.0)
• float PhysicsWorldGravityY (default: 10.0)
• float PhysicsWorldPixToMeters (default: 0.1)
14.3.4 Layer Properties

Both tile layers and object layers may produce “tile” elements in the exported room file. Their depth is set automatically, with tiles from the bottom-most layer getting a value of 10000000 (the GameMaker default) and counting up from there. If you want to set a custom depth value you can set the following property on the layer:

- int depth (default: 10000000 + N)

14.4 GameMaker Studio 2.3

GameMaker Studio 2.3 uses a JSON-based format to store its rooms, and Tiled ships with a plugin to export maps in this format.

This plugin will do its best to export the map as accurately as possible, mapping Tiled’s various features to the matching GameMaker features. Tile layers get exported as tile layers when possible, but will fall back to asset layers if necessary. Objects can get exported as instances, but also as tile graphics, sprite graphics or views. Image layers get exported as background layers.

**Warning:** Since GameMaker’s “Add Existing” action doesn’t work at this point in time (2.3.1) the easiest way to export a Tiled map to your GameMaker Project is to replace an already existing room.yy file.

If you want to do this while GameMaker is running with the open project you’ll need to deactivate “Use save writing of files” in the Tiled preferences (Under Edit -> Preferences -> General -> Saving and Loading). Otherwise GameMaker will detect that the room file got deleted and will propose to restore it from memory. Without “save writing” GameMaker will detect that the file got changed and propose to reload the updated one.

14.4.1 References to Existing Assets

Since Tiled currently only exports a map as a GameMaker room, any sprites, tilesets and objects used by the map are expected to be already available in the GameMaker project.

For sprites, the sprite name is be derived from the image file name by removing the file extension. If necessary, the sprite name can be explicitly specified using a custom sprite property (supported on tilesets, tiles from image collection tilesets and image layers).

For tilesets, the tileset name entered in Tiled must match the name of the tileset asset in GameMaker.

For object instances, the name of the object should be set in the Type field.

14.4.2 Exporting a Tiled Map

A Tiled map contains tile layers, object layers, image layers and group layers. All these layer types are supported.

**Tile Layers**

When possible, a tile layer will get exported as a tile layer.

When several tilesets are used on the same layer, the layer gets exported as a group with a child tile layer for each tileset, since GameMaker supports only one tileset per tile layer.
When the tile size of a tiles set doesn’t match the grid size of the map, or when the map orientation is not orthogonal (for example, isometric or hexagonal), the tiles will get exported to an asset layer instead. This layer type is more flexible, though for tile graphics it does not support rotation.

When the layer includes tiles from a collection of images tiles set, these will get exported to an asset layer as sprite graphics.

**Object Layers**

Object layers in Tiled are very flexible since objects take so many forms. As such the export looks at each object to see how it should be exported to the GameMaker room.

When an object has a Type, it is exported as an instance on an instance layer, where the type refers to the name of the object to instantiate. Except, when the type is “view”, the object is interpreted as a view.

When an object has no Type, but it is a tile object, then it is exported as either a tile graphic or a sprite graphic, depending on whether the tile is from a tiles set image or a collection of images.

The following custom properties can be set on objects to affect the exported instance or sprite asset:

- **color colour** (default: based on layer tint color)
- **float scaleX** (default: derived from tile or 1.0)
- **float scaleY** (default: derived from tile or 1.0)
- **bool inheritItemSettings** (default: false)
- **int originX** (default: 0)
- **int originY** (default: 0)
- **bool ignore** (default: whether the object is hidden)

The scaleX and scaleY properties can be used to override the scale of the instance. However, if the scale is relevant then it will generally be easier to use a tile object, in which case it is automatically derived from the tile size and the object size.

The originX and originY properties can be used to tell Tiled about the origin of the sprite defined in GameMaker, as an offset from the top-left. This origin is taken into account when determining the position of the exported instance.

**Hint:** Of course setting the type and/or the above properties manually for each instance will get old fast. Instead you can use tile objects with the type set on the tile or use object templates.

**Object Instances**

The following additional custom properties can be set on objects that are exported as object instances:

- **bool hasCreationCode** (default: false)
- **int imageIndex** (default: 0)
- **float imageSpeed** (default: 1.0)
- **int creationOrder** (default: 0)

The hasCreationCode property can be set to true. Refers to “InstanceCreationCode_[inst_name].gml” in the room folder which you can create inside GameMaker itself or with an external text editor.
By default the instance creation order is derived from the object positions inside the layer and object hierarchy from Tiled. This can be changed by using the custom property `creationOrder`. Objects with lower values will be created before objects with higher values (so objects with negative values will be created before objects without a `creationOrder` property).

Additional custom properties that are not documented here can be used to override the variable definitions that got set up inside GameMaker for the object.

**Note:** As of now only variable definitions of the object itself can be overridden. Overriding variable definitions of parent objects is not supported. As a workaround you can use the creation code to override variables of a parent object.

**Tile Graphics**

For objects exported as tile graphics (aka GMS 1.4 tiles), it should be noted that rotation is not supported on asset layers.

When 90-degree rotation with grid-alignment suffices, these tiles should be placed on tile layers instead. When free placement with rotation is required, a collection of images tileset should be used, so that the objects can be exported as sprite graphics instead.

**Sprite Graphics**

The following additional custom properties can be set on objects that are exported as sprite graphics:

- float `headPosition` (default: 0.0)
- float `animationSpeed` (default: 1.0)

**Image Layers**

Image layers are exported as background layers.

The file name of the source image is assumed to be the same as the name of the corresponding sprite asset. Alternatively the custom property `sprite` can be used to explicitly set the name of the sprite asset.

While not supported visually in Tiled, it is possible to create an image layer without an image but with only a tint color. Such layers will get exported as a background layer with just the color set.

The following custom properties can be set on image layers to affect the exported background layers:

- string `sprite` (default: based on image filename)
- bool `htiled` (default: false)
- bool `vtiled` (default: false)
- bool `stretch` (default: false)
- float `hspeed` (default: 0.0)
- float `vspeed` (default: 0.0)
- float `animationFPS` (default: 15.0)
- int `animationSpeedtype` (default: 0)

Even though the custom properties such as `htiled` and `vtiled` have no visual effect inside Tiled you will see the effect in the exported room inside GameMaker.
14.4.3 Special Cases and Custom Properties

Rooms

If a Background Color is set in the map properties of Tiled an extra background layer with the according color is exported as the bottommost layer.

The following custom properties can be set under Map -> Map Properties.

General

- string parent (default: “Rooms”)
- bool inheritLayers (default: false)
- string tags (default: “”)

The parent property is used to define the parent folder inside GameMakers asset browser.
The tags property is used to assign tags to the room. Multiple tags can be separated by commas.

Room Settings

- bool inheritRoomSettings (default: false)
- bool persistent (default: false)
- bool clearDisplayBuffer (default: true)
- bool inheritCode (default: false)
- string creationCodeFile (default: “”)

The creationCodeFile property is used to define the path of an existing creation code file, e.g.: “${project_dir}/rooms/room_name/RoomCreationCode.gml”.

Viewports and Cameras

General

- bool inheritViewSettings (default: false)
- bool enableViews (default: true when any “view” objects were found)
- bool clearViewBackground (default: false)

Viewport 0 - Viewport 7

You can configure up to 8 viewports by using view objects (see Views).

Physics

- bool inheritPhysicsSettings (default: false)
- bool PhysicsWorld (default: false)
- float PhysicsWorldGravityX (default: 0.0)
- float PhysicsWorldGravityY (default: 10.0)
• float PhysicsWorldPixToMeters (default: 0.1)

**Sprite References**

As mentioned above, references to sprites generally derive the name of the sprite asset from the image file name. The following property can be set on tiles, tiles from image collection tilesets and image layers to explicitly specify the sprite name:

• string sprite (default: based on image filename)

**Paths**

| Warning: | Paths are not supported yet, but it’s planned to export polyline and polygon objects as paths on path layers in a future update. |

**Views**

Views can be defined using *rectangle objects* where the *Type* has been set to “view”. The position and size will be snapped to pixels. Whether the view is visible when the room starts depends on whether the object is visible. The use of views is automatically enabled when any views are defined.

The following custom properties can be used to define the various other properties of the view:

**General**

• bool inherit (default: false)

**Camera Properties**

The Camera Properties are automatically derived from the position and size of the view object.

**Viewport Properties**

• int xport (default: 0)
• int yport (default: 0)
• int wport (default: 1366)
• int hport (default: 768)

**Object following**

• string objectId
• int hborder (default: 32)
• int vborder (default: 32)
• int hspeed (default: -1)
• int vspeed (default: -1)

**Hint:** When you’re defining views in Tiled, it is useful to add view as object type in the *Object Types Editor*, adding the above properties for ease of access. If you frequently use views with similar settings, you can set up *templates* for them.
Layers

All layer types support the following custom properties:

- `int depth` (default: auto-assigned, like in GameMaker)
- `bool visible` (default: derived from layer)
- `bool hierarchyFrozen` (default: layer locked state)
- `bool noExport` (default: false)

The `depth` property can be used to assign a specific depth value to a layer.

The `visible` property can be used to override the “Visible” state of the layer if needed.

The `hierarchyFrozen` property can be used to override the “Locked” state of the layer if needed.

The `noExport` property can be used to suppress exporting of an entire layer, including any child layers. This is useful if you use a layer for annotations (like adding background image or text objects) that you do not want exported to GameMaker. Note that any views defined on this layer will then also get ignored.

14.5 tBIN

The tBIN map format is a binary format used by the tIDE Tile Map Editor. tIDE was used by Stardew Valley, a successful game that spawned many community mods.

Tiled ships with a plugin that enables direct editing of Stardew Valley maps (and any other maps using the tBIN format). This plugin needs to be enabled in Edit > Preferences > Plugins. It is not enabled by default because it won’t store everything (most notably it doesn’t support object layers in general, nor external tilesets), so you need to know what you are doing.

Note: The tBIN format supports setting custom properties on the tiles of a tile layer. Since Tiled does not support this directly, “TileData” objects are created that match the location of the tile, on which such properties are then stored.

14.6 Other Formats

A few other plugins ship with Tiled to support various games or tools:

- **droidcraft** Adds support for editing DroidCraft maps (*.dat)
- **flare** Adds support for editing Flare Engine maps (*.txt)
- **replicaisland** Adds support for editing Replica Island maps (*.bin)
- **rpmap** Adds support for exporting Tiled maps as RpMap (*.rpmap), the format used by MapTool.
  
  Currently, support is limited to maps using “Image Collection” tilesets since MapTool doesn’t support tileset images.

- **tengine** Adds support for exporting to T-Engine4 maps (*.lua)

These plugins are disabled by default. They can be enabled in Edit > Preferences > Plugins.
14.7 Custom Export Formats

Tiled provides several options for extending it with support for additional file formats.

14.7.1 Using JavaScript

Tiled is extendable using JavaScript and it is possible to add custom export formats using `tiled.registerMapFormat` or `tiled.registerTilesetFormat`.

14.7.2 Using Python

It is also possible to write Python scripts to add support for importing or exporting custom map formats.

14.7.3 Using C++

Currently all export options shipping with Tiled are written as C++ Tiled plugins. The API for such plugins is not documented (apart from Doxygen-style comments in the `libtiled` source code), but there are over a dozen examples you can look at.

**Note:** For binary compatibility reasons, a C++ plugin needs to be compiled for the same platform, by the same compiler and with the same versions of Qt and Tiled that the plugin is supposed to support. Generally, the easiest way to achieve this is by compiling the plugin along with Tiled, which is what all current plugins do. If you write a C++ plugin that could be useful for others, it is recommended you open a pull request to have it shipped with Tiled.
14.8 Export as Image

Maps can be exported as image. Tiled supports most common image formats. Choose File -> Export as Image... to open the relevant dialog.

Since exporting a map can in some cases result in a huge image, a Use current zoom level option is provided to allow exporting the map at the size it's currently displayed at.

For repeatedly converting a map to an image, manually triggering this export isn't very convenient. For this purpose, a tool called tmxrasterizer ships with Tiled, which contrary to its name is able to render any supported map format to an image. It is also able to render entire worlds to an image. On Linux this tool can be set up for generating thumbnail previews of maps in the file manager.

**Note:** When exporting on the command-line on Linux, Tiled will still need an X server to run. To automate exports in a headless environment, you can use a headless X server such as Xvfb. In this case you would run Tiled from the command-line as follows:

```
xvfb-run tiled --export-map ...
```
CHAPTER 15

Keyboard Shortcuts

Note: Most of the below shortcuts can be changed in the Preferences.

On Mac, replace Ctrl with the Command key.

15.1 General

- Right Click on Tile - Captures the tile under the mouse (drag to capture larger areas).
- Ctrl + MouseWheel - Zoom in/out on tileset and map
- Ctrl + Plus/Minus - Zoom in/out on map
- Ctrl + 0 - Reset zoom on map
- Ctrl + Object Move - Toggles “Snap to Grid” temporarily
- Ctrl + Object Resize - Keep aspect ratio
- Alt + Object Resize - Toggles “Snap to Grid” temporarily
- Middle Click or Space Bar - Hold to pan the map view
- Ctrl + X - Cut (tiles, objects or properties)
- Ctrl + C - Copy (tiles, objects or properties)
- Ctrl + V - Paste (tiles, objects or properties)
- Del - Delete (tiles or objects)
- H - Toggle highlighting of the current layer
- A - Invokes Automapping
- Alt + C - Copy current position of mouse cursor to clipboard (in tile coordinates)
• Ctrl + D - Duplicate selected objects
• Ctrl + Shift + D - Duplicate active layer
• F2 - Rename (if applicable in context)
• Tab - Hide docks and tool bars
• Ctrl + PgUp - Select previous layer (above current layer)
• Ctrl + PgDown - Select next layer (below current layer)
• Ctrl + Shift + Up - Move current layer up
• Ctrl + Shift + Down - Move current layer down
• Ctrl + Shift + H - Show/Hide all other layers (only active layer visible / all layers visible)
• Ctrl + Tab - Switch to left document
• Ctrl + Shift + Tab - Switch to right document
• Alt + Left - Switch to left document
• Alt + Right - Switch to right document
• ] - Select next tiles
• [ - Select previous tiles
• Ctrl + G - Toggle displaying of the tile grid
• Ctrl + W - Close current document
• Ctrl + Shift + W - Close all documents
• Ctrl + E - Export current document
• Ctrl + Shift + E - Export current document to another file
• Ctrl + Q - Quit Tiled
• Ctrl + R - Reload current document
• Ctrl + T - Force-reload all tilesets used by the current map (mainly useful when not using the automatic reloading)

15.2 When a tile layer is selected

• D - Toggle Random Mode
• B - Activate Stamp Brush
  – Shift + Click - Line mode, places tiles on a line between two clicked locations
  – Ctrl + Shift + Click - Circle mode, places tiles around the clicked center
• T - Activate Terrain Brush
• G - Activate wang-tool (from Tiled 1.1 - 1.4)
• F - Activate Bucket Fill Tool
• P - Activate Shape Fill Tool
• E - Activate Eraser
• R - Activate Rectangular Select
• W - Activate Magic Wand
• S - Activate Select Same Tile
• Ctrl + 1-9 - Store current tile selection (similar to Ctrl + C)
• 1-9 recall the previous selection (similar to Ctrl + V)
• Ctrl + A - Select the whole layer
• Ctrl + Shift + A - Select nothing

Changing the active stamp:
• X - Flip active stamp horizontally
• Y - Flip active stamp vertically
• Z - Rotate active stamp clockwise
• Shift + Z - Rotate active stamp counterclockwise

15.3 When an object layer is selected

• S - Activate Select Objects
  • PgUp - Raise selected objects (with Manual object drawing order)
  • PgDn - Lower selected objects (with Manual object drawing order)
  • Home - Move selected objects to Top (with Manual object drawing order)
  • End - Move selected objects to Bottom (with Manual object drawing order)
• O - Activate Edit Polygons
• R - Activate Insert Rectangle
• I - Activate Insert Point
• C - Activate Insert Ellipse
• P - Activate Insert Polygon
  • Enter - Finish creating object
  • Escape - Cancel creating object
• T - Activate Insert Tile
• V - Activate Insert Template (since Tiled 1.1)
• E - Activate Insert Text
• Ctrl + A - Select all objects in the current object layer
• Ctrl + Shift + A - Clear object selection

15.4 In the Properties dialog

• Del or Backspace - Deletes a property
User Preferences

There are only a few options located in the Preferences, accessible though the menu via Edit > Preferences. Most other options, like whether to draw the grid, what kind snapping to do or the last used settings when creating a new map are simply remembered persistently.

The preferences are stored in a system-dependent format and location:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Registry Key/Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>HKEY_CURRENT_USER\SOFTWARE\mapeditor.org\Tiled</td>
</tr>
<tr>
<td>macOS</td>
<td>~/Library/Preferences/org.mapeditor.Tiled.plist</td>
</tr>
<tr>
<td>Linux</td>
<td>~/.config/mapeditor.org/tiled.conf</td>
</tr>
</tbody>
</table>

### 16.1 General

#### 16.1.1 Saving and Loading

**Include DTD reference in saved maps**

This option is not enabled by default, since it is of very little use whereas it can in some environments cause problems. Feel free to enable it if it helps with validation for example, but note that the referenced DTD is likely out of date (there is a somewhat more up-to-date XSD file available in the repository).
Reload tileset images when they change
This is very useful while working on the tiles or when the tiles might change as a result of a source control system.

Open last files on startup
Generally a useful thing to keep enabled.

Use safe writing of files
This setting causes files to be written to a temporary file, and when all went well, to be swapped with the target file. This avoids data getting lost due to errors while saving or due to insufficient disk space. Unfortunately, it is known to cause issues when saving files to a Dropbox folder or a network drive, in which case it helps to disable this feature.

16.1.2 Export Options

The following export options are applied each time a map or tileset gets exported, without affecting the map or tileset itself.

Embed tilesets
All tilesets are embedded in the exported map. Useful for example when you are exporting to JSON and loading an external tileset is not desired.

Detach templates
All template instances are detached. Useful when you want to use the templates feature but can’t or don’t want to load the external template object files.

Resolve object types and properties
Stores effective object type and properties with each object. Object properties
are inherited from a tile (in case of a tile object) and from the default properties of their type.

**Minimize output** Omits unnecessary whitespace in the output file. This option is supported for XML (TMX and TSX), JSON and Lua formats.

These options are also available as options when exporting using the command-line.

### 16.2 Interface

#### 16.2.1 Interface

**Language** By default the language tries to match that of the system, but if it picks the wrong one you can change it here.

**Grid colour** Because black is not always the best color for the grid.

**Fine grid divisions** The tile grid can be divided further using this setting, which affects the “Snap to Fine Grid” setting in the View > Snapping menu.

**Object line width** Shapes are by default rendered with a 2 pixel wide line, but some people like it thinner or even thicker. On some systems the DPI-based scaling will affect this setting as well.

**Object selection behavior** By default the Select Objects tool selects objects from any layer. With this setting, you can make it prefer to select objects from the currently selected layers, or
to only pick objects from the selected layers.

When the “Highlight Current Layer” option is enabled, Tiled automatically prefers to select objects from the currently selected layers.

**Hardware accelerated drawing (OpenGL)**

This enables a rather unoptimized way of rendering the map using OpenGL. It’s usually not an improvement and may lead to crashes, but in some scenarios it can make editing more responsive.

**Mouse wheel zooms by default**

This option causes the mouse wheel to zoom without the need to hold Control (or Command on macOS). It can be a convenient way to navigate the map, but it can also interfere with panning on a touchpad.

**Middle mouse button uses auto-scrolling**

With this option enabled, the clicking middle mouse button doesn’t drag the map directly but instead controls the speed of a continuous panning movement.

**Use smooth scrolling**

This option affects the behavior when scrolling with the arrow keys. When disabled, the view scrolls in steps based on key press events. When enabled (the default), the view scrolls continuously while the keys are held down.

### 16.2.2 Updates

By default, Tiled checks for news and new versions and highlights any updates in the status bar. Here you can disable this functionality. It
is recommended to keep at least one of these enabled.

If you disable displaying of new versions, you can still manually check whether a new version is available by opening the About Tiled dialog.

16.3 Keyboard

Here you can add, remove or change the keyboard shortcuts of most available actions.

Conflicting keybindings are highlighted in red. They will not work until you resolve the conflict.

If you customize multiple shortcuts, it is recommended to use the export functionality to save the keybindings somewhere, so that you can easily recover that setup or copy it to other Tiled installations.

16.4 Theme

On Windows and Linux, the default style used by Tiled is “Tiled Fusion”. This is a customized version of the “Fusion” style that ships with Qt. On macOS, this style can also be used, but because it looks so out of place the default is “Native” there.

The “Tiled Fusion” style allows customizing the base color. When choosing a dark base color, the text automatically switches to white and some other adjustments are made to keep things readable. You can
also choose a custom selection color.

The “Native” style tries to fit in with the operating system, and is available since it is in some cases preferable to the custom style. The base color and selection color can’t be changed when using this style, as they depend on the system.

## 16.5 Plugins

Here you can choose which plugins are enabled, as well as opening the *scripted extensions* folder.

Plugins add support for map and/or tileset file formats. Some generic plugins are enabled by default, while more specific ones need to be manually enabled.

There is no need to restart Tiled when enabling or disabling plugins. When a plugin fails to load, try hovering its icon to see if the tool tip displays a useful error message.

See *Export Formats* for more information about supported file formats.
CHAPTER 17

Python Scripts

**Note:** Since Tiled 1.3, Tiled can be extended using **JavaScript**. The JavaScript API provides a lot more opportunity for extending Tiled’s functionality than just adding custom map formats. It is fully documented and works out of the box on all platforms. It should be preferred over the Python plugin when possible.

Tiled ships with a plugin that enables you to use Python 3 to add support for custom map formats. This is nice especially since you don’t need to compile Tiled yourself and the scripts are easy to deploy to any platform.

For the scripts to get loaded, they should be placed in `~/.tiled`. Tiled watches this directory for changes, so there is no need to restart Tiled after adding or changing scripts (though the directory needs to exist when you start Tiled).

There are several example scripts available in the repository.

**Note:** To create the `~/.tiled` folder on Windows, open command prompt (`cmd.exe`), which should start in your home folder by default, then type `mkdir .tiled` to create the folder.

On Linux, folders starting with a dot are hidden by default. In most file managers you can toggle showing of hidden files using `Ctrl+H`.

**Note:** Since Tiled 1.2.4, the Python plugin is disabled by default, because depending on which Python version is installed on the system the loading of this plugin may cause a crash (#2091). To use the Python plugin, first enable it in the Preferences.

**Warning:** On Windows, Python is not installed by default. For the Tiled Python plugin to work, you’ll need to install Python 3.7 (get it from [https://www.python.org/](https://www.python.org/)). You will also need to check the box “Add Python 3.7 to PATH” in the installer:

On Linux you will also need to install the appropriate package. However, currently Linux builds are done on Ubuntu 16.04 against Python 3.5, and you’d need to install the same version somehow.
The Python plugin is currently not enabled for macOS releases. We’ll need to find out how to build it against Python 3, while macOS only ships with Python 2.7 by default. If you rely on this plugin on macOS you’ll need to use Tiled 1.1 for now.

### 17.1 Example Export Plugin

Suppose you’d like to have a map exported in the following format:

```
29,29,29,29,29,29,32,-1,34,29,29,29,29,29,29,
29,29,29,29,29,29,32,-1,34,29,29,29,29,29,29,
29,29,29,29,29,29,32,-1,34,29,29,29,29,29,29,
29,29,29,29,29,29,32,-1,34,29,29,29,29,29,29,
25,25,25,25,25,25,44,-1,34,29,29,29,29,29,29,
-1,-1,-1,-1,-1,-1,-1,-1,34,29,29,29,29,29,29,
41,41,41,41,41,41,41,41,41,41,41,41,41,41,41,
29,29,29,29,29,29,29,29,29,29,29,29,29,29,29,
-1,-1,-1,-1,-1,-1,-1,-1,35,34,29,29,29,29,29,
29,29,29,29,29,29,29,29,29,29,29,29,29,29,29,
```

You can achieve this by saving the following `example.py` script in the scripts directory:

```python
from tiled import *

class Example(Plugin):
    @classmethod
    def nameFilter(cls):
        return "Example files (*.example)"

    @classmethod
    def shortName(cls):
        return "example"

    @classmethod
    def write(cls, tileMap, fileName):
        with open(fileName, 'w') as fileHandle:
            for i in range(tileMap.layerCount()):
                if isTileLayerAt(tileMap, i):
                    tileLayer = tileLayerAt(tileMap, i)
                    for y in range(tileLayer.height()):
                        tiles = []
                        for x in range(tileLayer.width()):
                            if tileLayer.cellAt(x, y).tile() != None:
                                tiles.append(str(tileLayer.cellAt(x, y).tile().id()))
                            else:
                                tiles.append(str(-1))
                        line = ','.join(tiles)
                        if y == tileLayer.height() - 1:
                            line += ';'
                        else:
                            line += ',
                        print(line, file=fileHandle)

        return True
```

You can achieve this by saving the following `example.py` script in the scripts directory:
Then you should see an “Example files” entry in the type dropdown when going to File > Export, which allows you to export the map using the above script.

**Note:** This example does not support the use of group layers, and in fact the script API doesn’t support this yet either. Any help with maintaining the Python plugin would be very appreciated. See [open issues related to Python support](#).

### 17.2 Debugging Your Script

Any errors that happen while parsing or running the script are printed to the Console, which can be enabled in View > Views and Toolbars > Console.

### 17.3 API Reference

It would be nice to have the full API reference documented here, but for now please check out the source file for available classes and methods.
There are many libraries available for reading and/or writing Tiled maps (either stored in the TMX Map Format or the JSON Map Format) as well as many development frameworks that include support for Tiled maps. This list is divided into two sections:

- Support by Language
- Support by Framework

The first list is for developers who plan on implementing their own renderer. The second list is for developers already using (or considering) a particular game engine / graphics library who would rather pass on having to write their own tile map renderer.

Note: For updates to this page please open a pull request or issue on GitHub, thanks!

## 18.1 Support by Language

These libraries typically include only a TMX parser, but no rendering support. They can be used universally and should not require a specific game engine or graphics library.

### 18.1.1 C

- cute tiled - JSON map loader with examples (zlib/Public Domain).
- TMX - TMX map loader with Allegro5 and SDL2 examples (BSD).

### 18.1.2 C++

- C++/TinyXML based tmxparser (BSD)
- C++/Qt based libtiled, used by Tiled itself and included at src/libtiled (BSD)
• C++11/TinyXml2 libtmx-parser by halsafar. (zlib/tinyxml2)
• C++11/TinyXml2 libtmx by jube, for reading only (ISC licence). See documentation.
• TMXParser General *.tmx tileset data loader. Intended to be used with TSXParser for external tileset loading. (No internal tileset support)
• TSXParser General *.tsx tileset data loader. Intended to be used with TMXParser.
• TMXLoader based on RapidXml. Limited functionality (check the website for details).
• tmxlite C++14 map parser with compressed map support but no external linking required. Includes examples for SFML and SDL2 rendering. Currently has full tmx support up to 0.16. (Zlib/libpng)
• Tileson - A Tiled JSON parser for modern C++ (C++17) by Robin Berg Pettersen (BSD)

18.1.3 C#/.NET

• TiledCS: A dotnet library for loading Tiled tilesets and maps (TMX/TSX or JSON).
• MonoGame.Extended has a Tiled map loader and renderer that works with MonoGame on all platforms that support portable class libraries.
• The following projects appear to be no longer maintained, but might still be useful: TiledSharp, NTiled, tmx-mapper-pcl, tiled-xna and TmxCSharp.

18.1.4 Clojure

• tile-soup: Parses and validates a TMX file into a map. Automatically decodes Base64 and CSV formatted data and coerces numbers when necessary. Works on both the JVM and in browsers via ClojureScript.

18.1.5 D

• tiledMap.d simple single-layer and single-tileset example to load a map and its tileset in D language. It also contains basic rendering logic using DSFML.
• dtiled can load JSON-formatted Tiled maps. It also provides general tilemap-related functions and algorithms.

18.1.6 Go

• github.com/lafriks/go-tiled
• github.com/salviati/go-tmx/tmx

18.1.7 Haskell

• htiled (TMX) by Christian Rødli Amble.
• aeson-tiled (JSON) by Schell Scivally.
18.1.8 Java

- A library for loading TMX files is included with Tiled at util/java/libtiled-java.
- TiledReader is a simple TMX reader that conveys the information in Tiled files via a hand-crafted class structure, but does not load image data.
- Android-Specific:
  - AndroidTMXLoader loads TMX data into an object and renders to an Android Bitmap (limited functionality)
  - libtiled-java port is a port of the libtiled-java to be used on Android phones.

18.1.9 PHP

- PHP TMX Viewer by sebbu: render the map as an image (allow some modifications as well)

18.1.10 Pike

- TMX parser: a simple loader for TMX maps (CSV format only).

18.1.11 Processing

- linux-man/ptmx: Add Tiled maps to your Processing sketch.

18.1.12 Python

- pytiled-parser: Python parser for JSON maps (No support for TMX format as of v1.0.0)
- Arcade: 2D game library that uses pytiled-parser for easy loading of JSON maps into a game. (No support for TMX format as of v2.6.0) Arcade Tiled Examples
- pytmxlib: library for programmatic manipulation of TMX maps
- python-tmx: a simple library for reading and writing TMX files.

18.1.13 Ruby

- tmx gem by erisdiscord

18.1.14 Vala

- librpg A library to load and handle spritesets (own format) and orthogonal TMX maps.

18.2 Support by Framework

Following entries are integrated solutions for specific game engines. They are typically of little to no use if you’re not using said game engine.
18.2.1 AndEngine

- AndEngine by Nicolas Gramlich supports rendering TMX maps

18.2.2 Allegro

- allegro_tiled integrates Tiled support with Allegro 5.

18.2.3 Castle Game Engine (Object Pascal)

- Castle Game Engine has native support for Tiled maps (see the CastleTiledMap unit)

18.2.4 Cell2D

- The Java library Cell2D supports Tiled maps via a pipeline that starts with TiledReader, but currently has more built-in support for orthogonal maps than for other orientations.

18.2.5 cocos2d

- cocos2d (Python) supports loading Tiled maps through its cocos.tiles module.
- cocos2d-x (C++) supports loading TMX maps through the CCTMXTiledMap class.
- cocos2d-objc (Objective-C, Swift) (previously known as: cocos2d-iphone, cocos2d-swift, cocos2d-spritebuilder) supports loading TMX maps through CCTiledMap
- TilemapKit is a tilemapping framework for Cocos2D. It supports all TMX tilemap types, including staggered iso and all hex variations. No longer in development.

18.2.6 Construct 2 - Scirra

- Construct 2, since the Beta Release 149, officially supports TMX maps, and importing it by simple dragging the file inside the editor. Official Note

18.2.7 Flixel

- Lithander demonstrated his Flash TMX parser combined with Flixel rendering

18.2.8 Game Maker

- Tiled ships with plugins for exporting to GameMaker: Studio 1.4 and GameMaker Studio 2.3 room files.
- Tiled2GM Converter by Dmi7ry
18.2.9 Godot

- **Tiled Map Importer** imports each map as Godot scene which can be instanced or inherited (forum announcement).
- **Tiled To Godot Export** is a Tiled *JavaScript extension* for exporting Tilemaps and Tilesets in Godot 3.2 format (forum announcement).

18.2.10 Grid Engine

- Planimeter’s **Grid Engine** supports Tiled Lua-exported maps.

18.2.11 Haxe

- **HaxePunk Tiled Loader** for HaxePunk
- **HaxeFlixel**
- **OpenFL “openfl-tiled”** is a library, which gives OpenFL developers the ability to use the Tiled Map Editor.
- **OpenFL + Tiled + Flixel** Experimental glue to use “openfl-tiled” with HaxeFlixel

18.2.12 HTML5 (multiple engines)

- **Canvas Engine** A framework to create video games in HTML5 Canvas
- **chem-tmx** Plugin for chem game engine.
- **chesterGL** A simple WebGL/canvas game library
- **Crafty** JavaScript HTML5 Game Engine; supports loading Tiled maps through an external component TiledMapBuilder.
- **GameJs** JavaScript library for game programming; a thin wrapper to draw on HTML5 canvas and other useful modules for game development
- **KineticJs-Ext** A multi-canvas based game rendering library
- **melonJS** A lightweight HTML5 game engine
- **Panda 2**, a HTML5 Game Development Platform for Mac, Windows and Linux. Has a plugin for rendering Tiled maps, both orthogonal and isometric.
- **Phaser** A fast, free and fun open source framework supporting both JavaScript and TypeScript (Tiled tutorial)
- **linux-man/p5.tiledmap** adds Tiled maps to p5.js.
- **Platypus Engine** A robust orthogonal tile game engine with game entity library.
- **sprite.js** A game framework for image sprites.
- **TMXjs** A JavaScript, jQuery and RequireJS-based TMX (Tile Map XML) parser and renderer.
- **glazeJS** A high performance 2D game engine built in Typescript. It supports the TMX format, rendering tile layers on the GPU via WebGL (demo).
18.2.13 indielib-crossplatform

- indielib cross-platform supports loading TMX maps through the C++/TinyXML based tmx-parser by KonoM (BSD)

18.2.14 LibGDX

- libgdx, a Java-based Android/desktop/HTML5 game library, provides a packer, loader and renderer for TMX maps

18.2.15 LITlengine

- LITlengine is a 2D Java Game Engine that supports loading, saving and rendering maps in the .tmx format.

18.2.16 LÖVE

- Simple Tiled Implementation Lua loader for the LÖVE (Love2d) game framework.

18.2.17 MOAI SDK

- Hanappe Framework for MOAI SDK.
- Rapanui Framework for MOAI SDK.

18.2.18 Monkey X

- bit.tiled Loads TMX file as objects. Aims to be fully compatible with native TMX files.
- Diddy is an extensive framework for Monkey X that contains a module for loading and rendering TMX files. Supports orthogonal and isometric maps as both CSV and Base64 (uncompressed).

18.2.19 Node.js

- node-tmx-parser - loads the TMX file into a JavaScript object

18.2.20 Oak Nut Engine (onut)

- Oak Nut Engine supports Tiled maps through Javascript and C++. (see TiledMap Javascript or C++ samples)

18.2.21 Orx Portable Game Engine

- TMX to ORX Converter Tutorial and converter download for Orx.
18.2.22 Pygame

- Pygame map loader by dr0id
- PyTMX by Leif Theden (bitcraft)
- tmx.py by Richard Jones, from his 2012 PyCon ‘Introduction to Game Development’ talk.
- TMX, a fork of tmx.py and a port to Python3. A demo called pylletTown can be found here.

18.2.23 Pyglet

- JSON map loader/renderer for pyglet by Juan J. Martínez (reidrac)
- PyTMX by Leif Theden (bitcraft)

18.2.24 PySDL2

- PyTMX by Leif Theden (bitcraft)

18.2.25 RPG Maker MV

- Tiled Plugin for RPG Maker MV by Dr.Yami & Archeia, from RPG Maker Web

18.2.26 SDL

- C++/TinyXML/SDL based loader example by Rohin Knight (limited functionality)

18.2.27 SFML

- STP (SFML TMX Parser) by edoren
- C++/SFML Tiled map loader by fallahn. (Zlib/libpng)
- C++/SfTileEngine by Tresky (currently limited functionality)

18.2.28 Slick2D

- Slick2D supports loading TMX maps through TiledMap.

18.2.29 Solar2D (formerly Corona SDK)

- ponytiled is a simple Tiled Map Loader for Solar2D (forum announcement)
- Dusk Engine is a fully featured Tiled map game engine for Solar2D (no longer maintained, but may still be useful)
- Berry is a simple Tiled Map Loader for Solar2D.
- Qiso is an isometric engine for Solar2D that supports loading Tiled maps, and also handles things like path-finding for you.
18.2.30 Sprite Kit Framework

- SKTilemap is built from the ground up in Swift. It’s up to date, full of features and easy to integrate into any Sprite Kit project. Supports iOS and OSX.
- SKTiled - A Swift framework for working with Tiled assets in SpriteKit.
- JSTileMap is a lightweight SpriteKit implementation of the TMX format supporting iOS 7 and OS X 10.9 and above.

18.2.31 TERRA Engine (Delphi/Pascal)

- TERRA Engine supports loading and rendering of TMX maps.

18.2.32 Unity

- SuperTiled2Unity is a collection of C# Unity scripts that can automatically import Tiled map editor files directly into your Unity projects.
- Tiled TMX Importer, imports into Unity 2017.2’s new native Tilemap system.
- Tiled to Unity is a 3D pipeline for Tiled maps. It uses prefabs as tiles, and can place decorations dynamically on tiles. Supports multiple layers (including object layers).
- Tuesday: A generic C# serializer and deserializer plus a set of Unity editor scripts that allow you to drag and drop TMX files into your scene, make edits, and save back out as TMX files. MIT license.
- UniTiled, a native TMX importer for Unity.
- X-UniTMX supports almost all Tiled 0.11 features. Imports TMX/XML files into Sprite Objects or Meshes.
- Orthello Pro (2D framework) offers Tiled map support.

18.2.33 Unreal Engine 4

- Paper2D provides built-in support for tile maps and tile sets, importing JSON exported from Tiled.

18.2.34 Urho3D

- Urho3D natively supports loading Tiled maps as part of the Urho2D sublibrary (Documentation, HTML5 example).

18.2.35 XNA

- FlatRedBall Glue tool ships with a Tiled plugin that loads TMX maps into the FlatRedBall engine, providing rich integration with its features.
- XTiled by Michael C. Neel and Dylan Wolf, XNA library for loading and rendering TMX maps
- XNA map loader by Kevin Gadd, extended by Stephen Belanger and Zach Musgrave
TMX and TSX are Tiled’s own formats for storing tile maps and tilesets, based on XML. TMX provides a flexible way to describe a tile-based map. It can describe maps with any tile size, any amount of layers, any number of tile sets and it allows custom properties to be set on most elements. Beside tile layers, it can also contain groups of objects that can be placed freely.

Note that there are many libraries and frameworks available that can work with TMX maps and TSX tilesets.

In this document we’ll go through each element found in these file formats. The elements are mentioned in the headers and the list of attributes of the elements are listed right below, followed by a short explanation. Attributes or elements that are deprecated or unsupported by the current version of Tiled are formatted in italics. All optional attributes are either marked as optional, or have a default value to imply that they are optional.

Have a look at the changelog when you’re interested in what changed between Tiled versions.

---

**Note:** A DTD-file (Document Type Definition) is served at http://mapeditor.org/dtd/1.0/map.dtd. This file is not up-to-date but might be useful for XML-namespacing anyway.

---

**Note:** For compatibility reasons, it is recommended to ignore unknown elements and attributes (or raise a warning). This makes it easier to add features without breaking backwards compatibility, and allows custom variants and additions to work with existing tools.

---

### 19.1 <map>

- **version:** The TMX format version. Was “1.0” so far, and will be incremented to match minor Tiled releases.
- **tiledversion:** The Tiled version used to save the file (since Tiled 1.0.1). May be a date (for snapshot builds). (optional)
• **orientation**: Map orientation. Tiled supports “orthogonal”, “isometric”, “staggered” and “hexagonal” (since 0.11).

• **renderorder**: The order in which tiles on tile layers are rendered. Valid values are right-down (the default), right-up, left-down and left-up. In all cases, the map is drawn row-by-row. (only supported for orthogonal maps at the moment)

• **compressionlevel**: The compression level to use for tile layer data (defaults to -1, which means to use the algorithm default).

• **width**: The map width in tiles.

• **height**: The map height in tiles.

• **tilewidth**: The width of a tile.

• **tileheight**: The height of a tile.

• **hexsidelength**: Only for hexagonal maps. Determines the width or height (depending on the staggered axis) of the tile’s edge, in pixels.

• **staggeraxis**: For staggered and hexagonal maps, determines which axis (“x” or “y”) is staggered. (since 0.11)

• **staggerindex**: For staggered and hexagonal maps, determines whether the “even” or “odd” indexes along the staggered axis are shifted. (since 0.11)

• **backgroundcolor**: The background color of the map. (optional, may include alpha value since 0.15 in the form #AARRGGBB. Defaults to fully transparent.)

• **nextlayerid**: Stores the next available ID for new layers. This number is stored to prevent reuse of the same ID after layers have been removed. (since 1.2) (defaults to the highest layer id in the file + 1)

• **nextobjectid**: Stores the next available ID for new objects. This number is stored to prevent reuse of the same ID after objects have been removed. (since 0.11) (defaults to the highest object id in the file + 1)

• **infinite**: Whether this map is infinite. An infinite map has no fixed size and can grow in all directions. Its layer data is stored in chunks. (0 for false, 1 for true, defaults to 0)

The tilewidth and tileheight properties determine the general grid size of the map. The individual tiles may have different sizes. Larger tiles will extend at the top and right (anchored to the bottom left).

A map contains three different kinds of layers. Tile layers were once the only type, and are simply called layer, object layers have the objectgroup tag and image layers use the imagelayer tag. The order in which these layers appear is the order in which the layers are rendered by Tiled.

The staggered orientation refers to an isometric map using staggered axes.

Can contain at most one: `<properties>`

Can contain any number: `<tileset>, <layer>, <objectgroup>, <imagelayer>, <group>` (since 1.0), `<editorsettings>` (since 1.3)

### 19.2 `<editorsettings>`

This element contains various editor-specific settings, which are generally not relevant when reading a map.

Can contain: `<chunksize>, <export>`
19.2.1 <chunksize>

- width: The width of chunks used for infinite maps (default to 16).
- height: The width of chunks used for infinite maps (default to 16).

19.2.2 <export>

- target: The last file this map was exported to.
- format: The short name of the last format this map was exported as.

19.3 <tileset>

- firstgid: The first global tile ID of this tileset (this global ID maps to the first tile in this tileset).
- source: If this tileset is stored in an external TSX (Tile Set XML) file, this attribute refers to that file. That TSX file has the same structure as the <tileset> element described here. (There is the firstgid attribute missing and this source attribute is also not there. These two attributes are kept in the TMX map, since they are map specific.)
- name: The name of this tileset.
- tilewidth: The (maximum) width of the tiles in this tileset.
- tileheight: The (maximum) height of the tiles in this tileset.
- spacing: The spacing in pixels between the tiles in this tileset (applies to the tileset image, defaults to 0)
- margin: The margin around the tiles in this tileset (applies to the tileset image, defaults to 0)
- tilecount: The number of tiles in this tileset (since 0.13)
- columns: The number of tile columns in the tileset. For image collection tilesets it is editable and is used when displaying the tileset. (since 0.15)
- objectalignment: Controls the alignment for tile objects. Valid values are unspecified, topleft, top, topright, left, center, right, bottomleft, bottom and bottomright. The default value is unspecified, for compatibility reasons. When unspecified, tile objects use bottomleft in orthogonal mode and bottom in isometric mode. (since 1.4)

If there are multiple <tileset> elements, they are in ascending order of their firstgid attribute. The first tileset always has a firstgid value of 1. Since Tiled 0.15, image collection tilesets do not necessarily number their tiles consecutively since gaps can occur when removing tiles.

Image collection tilesets have no <image> tag. Instead, each tile has an <image> tag.

Can contain at most one: <image>, <tileoffset>, <grid> (since 1.0), <properties>, <terrainotypes>, <wangsets> (since 1.1), <transformations> (since 1.5)

Can contain any number: <tile>

19.3.1 <tileoffset>

- x: Horizontal offset in pixels. (defaults to 0)
- y: Vertical offset in pixels (positive is down, defaults to 0)
This element is used to specify an offset in pixels, to be applied when drawing a tile from the related tileset. When not present, no offset is applied.

19.3.2 <grid>

- **orientation**: Orientation of the grid for the tiles in this tileset (orthogonal or isometric, defaults to orthogonal)
- **width**: Width of a grid cell
- **height**: Height of a grid cell

This element is only used in case of isometric orientation, and determines how tile overlays for terrain and collision information are rendered.

19.3.3 <image>

- **format**: Used for embedded images, in combination with a data child element. Valid values are file extensions like png, gif, jpg, bmp, etc.
- **id**: Used by some versions of Tiled Java. Deprecated and unsupported.
- **source**: The reference to the tileset image file (Tiled supports most common image formats). Only used if the image is not embedded.
- **trans**: Defines a specific color that is treated as transparent (example value: “#FF00FF” for magenta). Including the “#” is optional and Tiled leaves it out for compatibility reasons. (optional)
- **width**: The image width in pixels (optional, used for tile index correction when the image changes)
- **height**: The image height in pixels (optional)

Note that it is not currently possible to use Tiled to create maps with embedded image data, even though the TMX format supports this. It is possible to create such maps using libtiled (Qt/C++) or tmxlib (Python).

Can contain at most one: <data>

19.3.4 <terraintypes>

This element defines an array of terrain types, which can be referenced from the terrain attribute of the tile element.

Can contain any number: <terrain>

<terrain>

- **name**: The name of the terrain type.
- **tile**: The local tile-id of the tile that represents the terrain visually.

Can contain at most one: <properties>
19.3.5 <transformations>

This element is used to describe which transformations can be applied to the tiles (e.g. to extend a Wang set by transforming existing tiles).

- **hflip**: Whether the tiles in this set can be flipped horizontally (default 0)
- **vflip**: Whether the tiles in this set can be flipped vertically (default 0)
- **rotate**: Whether the tiles in this set can be rotated in 90 degree increments (default 0)
- **preferuntransformed**: Whether untransformed tiles remain preferred, otherwise transformed tiles are used to produce more variations (default 0)

19.3.6 <tile>

- **id**: The local tile ID within its tileset.
- **type**: The type of the tile. Refers to an object type and is used by tile objects. (optional) (since 1.0)
- **terrain**: Defines the terrain type of each corner of the tile, given as comma-separated indexes in the terrain types array in the order top-left, top-right, bottom-left, bottom-right. Leaving out a value means that corner has no terrain. (optional)
- **probability**: A percentage indicating the probability that this tile is chosen when it competes with others while editing with the terrain tool. (defaults to 0)

Can contain at most one: `<properties>, <image> (since 0.9), <objectgroup>, <animation>`

<animation>

Contains a list of animation frames.

Each tile can have exactly one animation associated with it. In the future, there could be support for multiple named animations on a tile.

Can contain any number: `<frame>`

<frame>

- **tileid**: The local ID of a tile within the parent `<tileset>`.
- **duration**: How long (in milliseconds) this frame should be displayed before advancing to the next frame.

19.3.7 <wangsets>

Contains the list of Wang sets defined for this tileset.

Can contain any number: `<wangset>`

<wangset>

Defines a list of corner colors and a list of edge colors, and any number of Wang tiles using these colors.

- **name**: The name of the Wang set.
- **tile**: The tile ID of the tile representing this Wang set.
Can contain at most one: `<properties>`

Can contain up to 255: `<wangcolor>` (since Tiled 1.5)

Can contain any number: `<wangtile>`

```xml
<wangcolor>
A color that can be used to define the corner and/or edge of a Wang tile.

- **name**: The name of this color.
- **color**: The color in #RRGGBB format (example: #c17d11).
- **tile**: The tile ID of the tile representing this color.
- **probability**: The relative probability that this color is chosen over others in case of multiple options. (defaults to 0)
```

Can contain at most one: `<properties>`

```xml
<wangtile>
Defines a Wang tile, by referring to a tile in the tileset and associating it with a certain Wang ID.

- **tileid**: The tile ID.
- **wangid**: “The Wang ID, given by a comma-separated list of indexes (starting from 1, because 0 means _unset_) referring to the Wang colors in the Wang set in the following order: top, top right, right, bottom right, bottom, bottom left, left, top left (since Tiled 1.5). Before Tiled 1.5, the Wang ID was saved as a 32-bit unsigned integer stored in the format 0xCECECECE (where each C is a corner color and each E is an edge color, in reverse order).”
- **hflip**: Whether the tile is flipped horizontally (removed in Tiled 1.5).
- **vflip**: Whether the tile is flipped vertically (removed in Tiled 1.5).
- **dflip**: Whether the tile is flipped on its diagonal (removed in Tiled 1.5).
```

### 19.4 <layer>

All `<tileset>` tags shall occur before the first `<layer>` tag so that parsers may rely on having the tilesets before needing to resolve tiles.

- **id**: Unique ID of the layer. Each layer that added to a map gets a unique id. Even if a layer is deleted, no layer ever gets the same ID. Can not be changed in Tiled. (since Tiled 1.2)
- **name**: The name of the layer. (defaults to “”)
- **x**: The x coordinate of the layer in tiles. Defaults to 0 and can not be changed in Tiled.
- **y**: The y coordinate of the layer in tiles. Defaults to 0 and can not be changed in Tiled.
- **width**: The width of the layer in tiles. Always the same as the map width for fixed-size maps.
- **height**: The height of the layer in tiles. Always the same as the map height for fixed-size maps.
- **opacity**: The opacity of the layer as a value from 0 to 1. Defaults to 1.
- **visible**: Whether the layer is shown (1) or hidden (0). Defaults to 1.
• **tintcolor**: A tint color that is multiplied with any tiles drawn by this layer in #AARRGGBB or #RRGGBB format (optional).

• **offsetx**: Horizontal offset for this layer in pixels. Defaults to 0. (since 0.14)

• **offsety**: Vertical offset for this layer in pixels. Defaults to 0. (since 0.14)

• **parallaxx**: Horizontal parallax factor for this layer. Defaults to 1. (since 1.5)

• **parallaxy**: Vertical parallax factor for this layer. Defaults to 1. (since 1.5)

Can contain at most one: `<properties>`, `<data>`

### 19.4.1 `<data>`

• **encoding**: The encoding used to encode the tile layer data. When used, it can be “base64” and “csv” at the moment. (optional)

• **compression**: The compression used to compress the tile layer data. Tiled supports “gzip”, “zlib” and (as a compile-time option since Tiled 1.3) “zstd”.

When no encoding or compression is given, the tiles are stored as individual XML tile elements. Next to that, the easiest format to parse is the “csv” (comma separated values) format.

The base64-encoded and optionally compressed layer data is somewhat more complicated to parse. First you need to base64-decode it, then you may need to decompress it. Now you have an array of bytes, which should be interpreted as an array of unsigned 32-bit integers using little-endian byte ordering.

Whatever format you choose for your layer data, you will always end up with so called “global tile IDs” (gids). They are global, since they may refer to a tile from any of the tilesets used by the map. In order to find out from which tileset the tile is you need to find the tileset with the highest `firstgid` that is still lower or equal than the gid. The tilesets are always stored with increasing `firstgid`s.

Can contain any number: `<tile>`, `<chunk>`

### Tile flipping

The highest three bits of the gid store the flipped states. Bit 32 is used for storing whether the tile is horizontally flipped, bit 31 is used for the vertically flipped tiles and bit 30 indicates whether the tile is flipped (anti) diagonally, enabling tile rotation. These bits have to be read and cleared before you can find out which tileset a tile belongs to.

When rendering a tile, the order of operation matters. The diagonal flip (x/y axis swap) is done first, followed by the horizontal and vertical flips.

The following C++ pseudo-code should make it all clear:

```cpp
// Bits on the far end of the 32-bit global tile ID are used for tile flags
const unsigned FLIPPED_HORIZONTALLY_FLAG = 0x80000000;
const unsigned FLIPPED_VERTICALLY_FLAG = 0x40000000;
const unsigned FLIPPED_DIAGONALLY_FLAG = 0x20000000;
...

// Extract the contents of the <data> element
string tile_data = ...

unsigned char *data = decompress(base64_decode(tile_data));
unsigned tile_index = 0;
```

(continues on next page)
Here you should check that the data has the right size
// (map_width * map_height * 4)

for (int y = 0; y < map_height; ++y) {
    for (int x = 0; x < map_width; ++x) {
        unsigned global_tile_id = data[tile_index] |
                                data[tile_index + 1] << 8 |
                                data[tile_index + 2] << 16 |
                                data[tile_index + 3] << 24;
        tile_index += 4;

        // Read out the flags
        bool flipped_horizontally = (global_tile_id & FLIPPED_HORIZONTALLY_FLAG);
        bool flipped_vertically = (global_tile_id & FLIPPED_VERTICALLY_FLAG);
        bool flipped_diagonally = (global_tile_id & FLIPPED_DIAGONALLY_FLAG);

        // Clear the flags
        global_tile_id &= ~(FLIPPED_HORIZONTALLY_FLAG |
                           FLIPPED_VERTICALLY_FLAG |
                           FLIPPED_DIAGONALLY_FLAG);

        // Resolve the tile
        for (int i = tileset_count - 1; i >= 0; --i) {
            Tileset *tileset = tilesets[i];

            if (tileset->first_gid() <= global_tile_id) {
                tiles[y][x] = tileset->tileAt(global_tile_id - tileset->first_gid());
                break;
            }
        }
    }
}

(Since the above code was put together on this wiki page and can’t be directly tested, please make sure to report any errors you encounter when basing your parsing code on it, thanks.)

19.4.2 <chunk>

- **x**: The x coordinate of the chunk in tiles.
- **y**: The y coordinate of the chunk in tiles.
- **width**: The width of the chunk in tiles.
- **height**: The height of the chunk in tiles.

This is currently added only for infinite maps. The contents of a chunk element is same as that of the data element, except it stores the data of the area specified in the attributes.

Can contain any number: <tile>

19.4.3 <tile>

- **gid**: The global tile ID (default: 0).

Not to be confused with the tile element inside a tileset, this element defines the value of a single tile on a tile layer. This is however the most inefficient way of storing the tile layer data, and should generally be avoided.
19.5 `<objectgroup>`

- **id**: Unique ID of the layer. Each layer that added to a map gets a unique id. Even if a layer is deleted, no layer ever gets the same ID. Can not be changed in Tiled. (since Tiled 1.2)
- **name**: The name of the object group. (defaults to ““)
- **color**: The color used to display the objects in this group. (defaults to gray (“#a0a0a4”))
- **x**: The x coordinate of the object group in tiles. Defaults to 0 and can no longer be changed in Tiled.
- **y**: The y coordinate of the object group in tiles. Defaults to 0 and can no longer be changed in Tiled.
- **width**: The width of the object group in tiles. Meaningless.
- **height**: The height of the object group in tiles. Meaningless.
- **opacity**: The opacity of the layer as a value from 0 to 1. (defaults to 1)
- **visible**: Whether the layer is shown (1) or hidden (0). (defaults to 1)
- **tintcolor**: A color that is multiplied with any tile objects drawn by this layer, in #AARRGGBB or #RRGGBB format (optional).
- **offsetx**: Horizontal offset for this object group in pixels. (defaults to 0) (since 0.14)
- **offsety**: Vertical offset for this object group in pixels. (defaults to 0) (since 0.14)
- **draworder**: Whether the objects are drawn according to the order of appearance (“index”) or sorted by their y-coordinate (“topdown”). (defaults to “topdown”)

The object group is in fact a map layer, and is hence called “object layer” in Tiled.

Can contain at most one: `<properties>`

Can contain any number: `<object>`

19.5.1 `<object>`

- **id**: Unique ID of the object. Each object that is placed on a map gets a unique id. Even if an object was deleted, no object gets the same ID. Can not be changed in Tiled. (since Tiled 0.11)
- **name**: The name of the object. An arbitrary string. (defaults to ““)
- **type**: The type of the object. An arbitrary string. (defaults to ““)
- **x**: The x coordinate of the object in pixels. (defaults to 0)
- **y**: The y coordinate of the object in pixels. (defaults to 0)
- **width**: The width of the object in pixels. (defaults to 0)
- **height**: The height of the object in pixels. (defaults to 0)
- **rotation**: The rotation of the object in degrees clockwise around (x, y). (defaults to 0)
- **gid**: A reference to a tile. (optional)
- **visible**: Whether the object is shown (1) or hidden (0). (defaults to 1)
- **template**: A reference to a template file. (optional)

While tile layers are very suitable for anything repetitive aligned to the tile grid, sometimes you want to annotate your map with other information, not necessarily aligned to the grid. Hence the objects have their coordinates and size in pixels, but you can still easily align that to the grid when you want to.
You generally use objects to add custom information to your tile map, such as spawn points, warps, exits, etc.

When the object has a gid set, then it is represented by the image of the tile with that global ID. The image alignment currently depends on the map orientation. In orthogonal orientation it’s aligned to the bottom-left while in isometric it’s aligned to the bottom-center. The image will rotate around the bottom-left or bottom-center, respectively.

When the object has a template set, it will borrow all the properties from the specified template, properties saved with the object will have higher priority, i.e. they will override the template properties.

Can contain at most one: `<properties>`, `<ellipse>` (since 0.9), `<point>` (since 1.1), `<polygon>`, `<polyline>`, `<text>` (since 1.0)

### 19.5.2 `<ellipse>`

Used to mark an object as an ellipse. The existing x, y, width and height attributes are used to determine the size of the ellipse.

### 19.5.3 `<point>`

Used to mark an object as a point. The existing x and y attributes are used to determine the position of the point.

### 19.5.4 `<polygon>`

- **points**: A list of x,y coordinates in pixels.

Each polygon object is made up of a space-delimited list of x,y coordinates. The origin for these coordinates is the location of the parent object. By default, the first point is created as 0,0 denoting that the point will originate exactly where the object is placed.

### 19.5.5 `<polyline>`

- **points**: A list of x,y coordinates in pixels.

A polyline follows the same placement definition as a polygon object.

### 19.5.6 `<text>`

- **fontfamily**: The font family used (defaults to “sans-serif”)
- **pixelsize**: The size of the font in pixels (not using points, because other sizes in the TMX format are also using pixels) (defaults to 16)
- **wrap**: Whether word wrapping is enabled (1) or disabled (0). (defaults to 0)
- **color**: Color of the text in #AARRGGBB or #RRGGBB format (defaults to #000000)
- **bold**: Whether the font is bold (1) or not (0). (defaults to 0)
- **italic**: Whether the font is italic (1) or not (0). (defaults to 0)
- **underline**: Whether a line should be drawn below the text (1) or not (0). (defaults to 0)
- **strikeout**: Whether a line should be drawn through the text (1) or not (0). (defaults to 0)
- **kerning**: Whether kerning should be used while rendering the text (1) or not (0). (defaults to 1)
• **halign:** Horizontal alignment of the text within the object (**left**, **center**, **right** or **justify**, defaults to **left**) (since Tiled 1.2.1)

• **valign:** Vertical alignment of the text within the object (**top**, **center** or **bottom**, defaults to **top**)

Used to mark an object as a text object. Contains the actual text as character data.

For alignment purposes, the bottom of the text is the descender height of the font, and the top of the text is the ascender height of the font. For example, **bottom** alignment of the word “cat” will leave some space below the text, even though it is unused for this word with most fonts. Similarly, **top** alignment of the word “cat” will leave some space above the “t” with most fonts, because this space is used for diacritics.

If the text is larger than the object’s bounds, it is clipped to the bounds of the object.

### 19.6 `<imagelayer>`

• **id:** Unique ID of the layer. Each layer that added to a map gets a unique id. Even if a layer is deleted, no layer ever gets the same ID. Can not be changed in Tiled. (since Tiled 1.2)

• **name:** The name of the image layer. (defaults to “”)

• **offsetx:** Horizontal offset of the image layer in pixels. (defaults to 0) (since 0.15)

• **offsety:** Vertical offset of the image layer in pixels. (defaults to 0) (since 0.15)

• **x:** The x position of the image layer in pixels. (defaults to 0, deprecated since 0.15)

• **y:** The y position of the image layer in pixels. (defaults to 0, deprecated since 0.15)

• **opacity:** The opacity of the layer as a value from 0 to 1. (defaults to 1)

• **visible:** Whether the layer is shown (1) or hidden (0). (defaults to 1)

• **tintcolor:** A color that is multiplied with the image drawn by this layer in **#AARRGGBB** or **#RRGGBB** format (optional).

A layer consisting of a single image.

Can contain at most one: `<properties>`, `<image>`

### 19.7 `<group>`

• **id:** Unique ID of the layer. Each layer that added to a map gets a unique id. Even if a layer is deleted, no layer ever gets the same ID. Can not be changed in Tiled. (since Tiled 1.2)

• **name:** The name of the group layer. (defaults to “”)

• **offsetx:** Horizontal offset of the group layer in pixels. (defaults to 0)

• **offsety:** Vertical offset of the group layer in pixels. (defaults to 0)

• **opacity:** The opacity of the layer as a value from 0 to 1. (defaults to 1)

• **visible:** Whether the layer is shown (1) or hidden (0). (defaults to 1)

• **tintcolor:** A color that is multiplied with any graphics drawn by any child layers, in **#AARRGGBB** or **#RRGGBB** format (optional).

A group layer, used to organize the layers of the map in a hierarchy. Its attributes **offsetx**, **offsety**, **opacity**, **visible** and **tintcolor** recursively affect child layers.

Can contain at most one: `<properties>`
Can contain any number: `<layer>`, `<objectgroup>`, `<imagelayer>`, `<group>`

### 19.8 `<properties>`

Wraps any number of custom properties. Can be used as a child of the `map`, `tileset`, `tile` (when part of a `tileset`), `terrain`, `wangset`, `wangcolor`, `layer`, `objectgroup`, `object`, `imagelayer` and `group` elements.

Can contain any number: `<property>`

#### 19.8.1 `<property>`

- **name**: The name of the property.
- **type**: The type of the property. Can be `string` (default), `int`, `float`, `bool`, `color`, `file` or `object` (since 0.16, with `color` and `file` added in 0.17, and `object` added in 1.4).
- **value**: The value of the property. (default string is “”, default number is 0, default boolean is “false”, default color is #00000000, default file is “.” (the current file’s parent directory))

Boolean properties have a value of either “true” or “false”.

Color properties are stored in the format #AARRGGBB.

File properties are stored as paths relative from the location of the map file.

Object properties can reference any object on the same map and are stored as an integer (the ID of the referenced object, or 0 when no object is referenced). When used on objects in the Tile Collision Editor, they can only refer to other objects on the same tile.

When a string property contains newlines, the current version of Tiled will write out the value as characters contained inside the `property` element rather than as the `value` attribute. It is possible that a future version of the TMX format will switch to always saving property values inside the element rather than as an attribute.

### 19.9 Template Files

Templates are saved in their own file, and are referenced by `objects` that are template instances.

#### 19.9.1 `<template>`

The template root element contains the saved `map object` and a `tileset` element that points to an external tileset, if the object is a tile object.

Example of a template file:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<template>
  <tileset firstgid="1" source="desert.tsx"/>
  <object name="cactus" gid="31" width="81" height="101"/>
</template>
```

Can contain at most one: `<tileset>`, `<object>`
The **TMX Map Format** by https://www.mapeditor.org is licensed under a Creative Commons Attribution-ShareAlike 3.0 Unported License.
Below are described the changes/additions that were made to the TMX Map Format for recent versions of Tiled.

### 20.1 Tiled 1.5

- The colors that are part of a `<wangset>` are no longer separated in corner colors and edge colors. Instead, there is now a single `<wangcolor>` element to define a Wang color. This new element also stores `<properties>`.
- The `wangid` attribute on the `<wangtile>` element is now stored as a comma-separated list of values, instead of a 32-bit unsigned integer in hex format. This is because the number of colors supported in a Wang set was increased from 15 to 255.
- Valid transformations of tiles in a set (flipping, rotation) are specified in a `<transformations>` element. The partial support for the `vflip`, `hflip` and `dflip` attributes on the `<wangtile>` element has been removed.
- The `<wangset>` element has replaced the now deprecated `<terraintypes>` element.

### 20.2 Tiled 1.4

- Added the `objectalignment` attribute to the `<tileset>` element, allowing the tileset to control the alignment used for tile objects.
- Added the `tintcolor` attribute to the `<layer>`, `<objectgroup>`, `<imagelayer>` and `<group>` elements, allowing for a number of graphical effects like darkening or coloring a layer.

### 20.3 Tiled 1.3

- Added an `<editorsettings>` element, which is used to store editor specific settings that are generally not relevant when loading a map.
- Added support for Zstandard compression for tile layer data (`compression="zstd"` on `<data>` elements).
• Added the `compressionlevel` attribute to the `<map>` element, which stores the compression level to use for compressed tile layer data.

### 20.4 Tiled 1.2.1

• Text objects can now get their horizontal alignment saved as `justify`. This option existed in the UI before but wasn’t saved properly.

### 20.5 Tiled 1.2

• Added an `id` attribute to the `<layer>`, `<objectgroup>`, `<imagelayer>` and `<group>` elements, which stores a map-unique ID of the layer.
• Added a `nextlayerid` attribute to the `<map>` element, which stores the next available ID for new layers. This number is stored to prevent reuse of the same ID after layers have been removed.

### 20.6 Tiled 1.1

• Added a `map.infinite` attribute, which indicates whether the map is considered unbounded. Tile layer data for infinite maps is stored in chunks.
• A new `<chunk>` element was added for infinite maps which contains the similar content as `<data>`, except it stores the data of the area specified by its `x`, `y`, `width` and `height` attributes.
• `Templates` were added, a template is an external file referenced by template instance objects:

```xml
<object id="3" template="diamond.tx" x="200" y="100"/>
```

• Tilesets can now contain `Terrain Sets`. They are saved in the new `<wangsets>` element.
• A new `<point>` child element was added to `<object>`, which marks point objects. Point objects do not have a size or rotation.

### 20.7 Tiled 1.0

• A new `<group>` element was added which is a group layer that can have other layers as child elements. This means layers now form a hierarchy.
• Added Text objects, identified by a new `<text>` element which is used as a child of the `<object>` element.
• Added a `tile.type` attribute for supporting `Typed Tiles`.

### 20.8 Tiled 0.18

*No file format changes.*
20.9 Tiled 0.17

- Added **color** and **file** as possible values for the *property.type* attribute.
- Added support for editing multi-line string properties, which are written out differently.

20.10 Tiled 0.16

- The `<property>` element gained a *type* attribute, storing the type of the value. Currently supported types are **string** (the default), **int**, **float** and **bool**.

20.11 Tiled 0.15

- The **offsetx** and **offsety** attributes are now also used for `<imagelayer>` elements, replacing the **x** and **y** attributes previously used. This change was made for consistency with the other layer types.
- The tiles in an image collection tileset are no longer guaranteed to be consecutive, because removing tiles from the collection will no longer change the IDs of other tiles.
- The pure XML and Gzip-compressed tile layer data formats were deprecated, since they didn’t have any advantage over other formats. Remaining formats are CSV, base64 and Zlib-compressed layer data.
- Added **columns** attribute to the `<tileset>` element, which specifies the number of tile columns in the tileset. For image collection tilesets it is editable and is used when displaying the tileset.
- The **backgroundcolor** attribute of the `<map>` element will now take the format #AARRGGBB when its alpha value differs from 255. Previously the alpha value was silently discarded.

20.12 Tiled 0.14

- Added optional **offsetx** and **offsety** attributes to the **layer** and **objectgroup** elements. These specify an offset in pixels that is to be applied when rendering the layer. The default values are 0.

20.13 Tiled 0.13

- Added an optional **tilecount** attribute to the **tileset** element, which is written by Tiled to help parsers determine the amount of memory to allocate for tile data.

20.14 Tiled 0.12

- Previously tile objects never had **width** and **height** properties, though the format technically allowed this. Now these properties are used to store the size the image should be rendered at. The default values for these attributes are the dimensions of the tile image.
20.15 Tiled 0.11

- Added hexagonal to the supported values for the orientation attribute on the map element. This also adds staggerindex (even or odd) and staggeraxis (x or y) and hexsidelength (integer value) attributes to the map element, in order to support the many variations of staggered hexagonal. The new staggerindex and staggeraxis attributes are also supported when using the staggered map orientation.
- Added an id attribute to the object element, which stores a map-unique ID of the object.
- Added a nextobjectid attribute to the map element, which stores the next available ID for new objects. This number is stored to prevent reuse of the same ID after objects have been removed.

20.16 Tiled 0.10

- Tile objects can now be horizontally or vertically flipped. This is stored in the gid attribute using the same mechanism as for regular tiles. The image is expected to be flipped without affecting its position, same way as flipped tiles.
- Objects can be rotated freely. The rotation is stored in degrees as a rotation attribute, with positive rotation going clockwise.
- The render order of the tiles on tile layers can be configured in a number of ways through a new renderorder property on the map element. Valid values are right-down (the default), right-up, left-down and left-up. In all cases, the map is drawn row-by-row. This is only supported for orthogonal maps at the moment.
- The render order of objects on object layers can be configured to be either sorted by their y-coordinate (previous behavior and still the default) or simply the order of appearance in the map file. The latter enables manual control over the drawing order with actions that “Raise” and “Lower” selected objects. It is controlled by the draworder property on the objectgroup element, which can be either topdown (default) or index.
- Tiles can have an objectgroup child element, which can contain objects that define the collision shape to use for that tile. This information can be edited in the new Tile Collision Editor.
- Tiles can have a single looping animation associated with them using an animation child element. Each frame of the animation refers to a local tile ID from this tileset and defines the frame duration in milliseconds. Example:

```
<tileset ...>
...
<tile id="[n]">
  <animation>
    <frame tileid="0" duration="100"/>
    <frame tileid="1" duration="100"/>
    <frame tileid="2" duration="100"/>
  </animation>
</tile>
</tileset>
```

20.17 Tiled 0.9

- Per-object visibility flag is saved (defaults to 1):
• Terrain information was added to tileset definitions (this is generally not very relevant for games):

```xml
<tileset ...>
...
<terraintypes>
  <terrain name="Name" tile="local_id"/>
</terraintypes>
<tile id="local_id" terrain="[n],[n],[n],[n]" probability="percentage"/>
...
</tileset>
```

• There is preliminary support for a “staggered” (isometric) projection (new value for the `orientation` attribute of the `map` element).

• A basic image layer type was added:

```xml
<imagelayer ...>
<image source="..."/>
</imagelayer>
```

• Added ellipse object shape. Same parameters as rectangular objects, but marked as ellipse with a child element:

```xml
<object ...>
<ellipse/>
</object>
```

• Added map property for specifying the background color:

```xml
<map ... backgroundcolor="#RRGGBB">
```

• Added initial (non-GUI) support for individual and/or embedded tile images (since there is no way to set this up in Tiled Qt but only in Tiled Java or with pytmxlib, this is not very important to support at the moment):

```xml
<tileset ...>
<tile id="[n]">
  <!-- an embedded image -->
  <image format="png">
    <data encoding="base64">
      ...
    </data>
  </image>
</tile>
<tile id="[n]">
  <!-- an individually referenced image for a single tile -->
  <image source="file.png"/>
</tile>
...
</tileset>
```

### 20.18 Tiled 0.8

• Tilesets can now have custom properties (using the `properties` child element, just like everything else).
• Tilesets now support defining a drawing offset in pixels, which is to be used when drawing any tiles from that tileset. Example:

```xml
<tileset name="perspective_walls" tilewidth="64" tileheight="64">
  <tileoffset x="-32" y="0"/>
  ...
</tileset>
```

• Support for tile rotation in 90-degree increments was added by using the third most significant bit in the global tile id. This new bit means “anti-diagonal flip”, which swaps the x and y axis when rendering a tile.
Tiled can export maps as JSON files. To do so, simply select “File > Export As” and select the JSON file type. You can export json from the command line with the --export-map option.

The fields found in the JSON format differ slightly from those in the TMX Map Format, but the meanings should remain the same.

The following fields can be found in a Tiled JSON file:
21.1 Map

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>backgroundcolor</td>
<td>string</td>
<td>Hex-formatted color (#RRGGBB or #AARRGGBB) (optional)</td>
</tr>
<tr>
<td>compressionlevel</td>
<td>int</td>
<td>The compression level to use for tile layer data (defaults to -1, which means to use the algorithm default)</td>
</tr>
<tr>
<td>height</td>
<td>int</td>
<td>Number of tile rows</td>
</tr>
<tr>
<td>hexsidelength</td>
<td>int</td>
<td>Length of the side of a hex tile in pixels (hexagonal maps only)</td>
</tr>
<tr>
<td>infinite</td>
<td>bool</td>
<td>Whether the map has infinite dimensions</td>
</tr>
<tr>
<td>layers</td>
<td>array</td>
<td>Array of Layers</td>
</tr>
<tr>
<td>nextlayerid</td>
<td>int</td>
<td>Auto-increments for each layer</td>
</tr>
<tr>
<td>nextobjectid</td>
<td>int</td>
<td>Auto-increments for each placed object</td>
</tr>
<tr>
<td>orientation</td>
<td>string</td>
<td>orthogonal, isometric, staggered or hexagonal</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>renderorder</td>
<td>string</td>
<td>right-down (the default), right-up, left-down or left-up (currently only supported for orthogonal maps)</td>
</tr>
<tr>
<td>staggeraxis</td>
<td>string</td>
<td>x or y (staggered / hexagonal maps only)</td>
</tr>
<tr>
<td>staggerindex</td>
<td>string</td>
<td>odd or even (staggered / hexagonal maps only)</td>
</tr>
<tr>
<td>tileversion</td>
<td>string</td>
<td>The Tiled version used to save the file</td>
</tr>
<tr>
<td>tileheight</td>
<td>int</td>
<td>Map grid height</td>
</tr>
<tr>
<td>tilesets</td>
<td>array</td>
<td>Array of Tilesets</td>
</tr>
<tr>
<td>tilewidth</td>
<td>int</td>
<td>Map grid width</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>map (since 1.0)</td>
</tr>
<tr>
<td>version</td>
<td>string</td>
<td>The JSON format version (previously a number, saved as string since 1.6)</td>
</tr>
<tr>
<td>width</td>
<td>int</td>
<td>Number of tile columns</td>
</tr>
</tbody>
</table>

21.1.1 Map Example

```json
{
   "backgroundcolor":"#656667",
   "height":4,
   "layers":[]
}
```

(continues on next page)
### 21.2 Layer

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chunks</td>
<td>array</td>
<td>Array of chunks (optional). tilelayer only.</td>
</tr>
<tr>
<td>compression</td>
<td>string</td>
<td>zlib, gzip, zstd (since Tiled 1.3) or empty (default). tilelayer only.</td>
</tr>
<tr>
<td>data</td>
<td>array or string</td>
<td>Array of unsigned int (GIDs) or base64-encoded data. tilelayer only.</td>
</tr>
<tr>
<td>draworder</td>
<td>string</td>
<td>topdown (default) or index. objectgroup only.</td>
</tr>
<tr>
<td>encoding</td>
<td>string</td>
<td>csv (default) or base64. tilelayer only.</td>
</tr>
<tr>
<td>height</td>
<td>int</td>
<td>Row count. Same as map height for fixed-size maps.</td>
</tr>
<tr>
<td>id</td>
<td>int</td>
<td>Incremental ID - unique across all layers</td>
</tr>
<tr>
<td>image</td>
<td>string</td>
<td>Image used by this layer. imagelayer only.</td>
</tr>
<tr>
<td>layers</td>
<td>array</td>
<td>Array of layers. group only.</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>Name assigned to this layer</td>
</tr>
<tr>
<td>objects</td>
<td>array</td>
<td>Array of objects. objectgroup only.</td>
</tr>
<tr>
<td>offsetx</td>
<td>double</td>
<td>Horizontal layer offset in pixels (default: 0)</td>
</tr>
<tr>
<td>offsety</td>
<td>double</td>
<td>Vertical layer offset in pixels (default: 0)</td>
</tr>
<tr>
<td>opacity</td>
<td>double</td>
<td>Value between 0 and 1</td>
</tr>
<tr>
<td>parallaxx</td>
<td>double</td>
<td>Horizontal parallax factor for this layer (default: 1). (since Tiled 1.5)</td>
</tr>
<tr>
<td>parallaxy</td>
<td>double</td>
<td>Vertical parallax factor for this layer (default: 1). (since Tiled 1.5)</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>startx</td>
<td>int</td>
<td>X coordinate where layer content starts (for infinite maps)</td>
</tr>
<tr>
<td>starty</td>
<td>int</td>
<td>Y coordinate where layer content starts (for infinite maps)</td>
</tr>
<tr>
<td>tintcolor</td>
<td>string</td>
<td>Hex-formatted tint color (#RRGGBB or #AARRGGBB) that is multiplied with any graphics drawn by this layer or any child layers (optional).</td>
</tr>
<tr>
<td>transparentcolor</td>
<td>string</td>
<td>Hex-formatted color (#RRGGBB) (optional). imagelayer only.</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>tilelayer, objectgroup, imagelayer or group</td>
</tr>
<tr>
<td>visible</td>
<td>bool</td>
<td>Whether layer is shown or hidden in editor</td>
</tr>
<tr>
<td>width</td>
<td>int</td>
<td>Column count. Same as map width for fixed-size maps.</td>
</tr>
<tr>
<td>x</td>
<td>int</td>
<td>Horizontal layer offset in tiles. Always 0.</td>
</tr>
<tr>
<td>y</td>
<td>int</td>
<td>Vertical layer offset in tiles. Always 0.</td>
</tr>
</tbody>
</table>

#### 21.2.1 Tile Layer Example

```json
{
  "data":[1, 2, 1, 2, 3, 1, 3, 1, 2, 2, 3, 3, 4, 4, 4, 1],
  "height":4,
  "name":"ground",
  "opacity":1,
  "properties":[
    {
      "name":"tileLayerProp",
      "type":"int",
      "value":1
    }
  ]
}
```

(continues on next page)
21.2.2 Object Layer Example

```json
{
    "draworder": "topdown",
    "height": 0,
    "name": "people",
    "objects": [],
    "opacity": 1,
    "properties": [
        {
            "name": "layerProp1",
            "type": "string",
            "value": "someStringValue"
        }
    ],
    "type": "objectgroup",
    "visible": true,
    "width": 0,
    "x": 0,
    "y": 0
}
```

21.3 Chunk

Chunks are used to store the tile layer data for *infinite maps*.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>data</td>
<td>array or string</td>
<td>Array of unsigned int (GIDs) or base64-encoded data</td>
</tr>
<tr>
<td>height</td>
<td>int</td>
<td>Height in tiles</td>
</tr>
<tr>
<td>width</td>
<td>int</td>
<td>Width in tiles</td>
</tr>
<tr>
<td>x</td>
<td>int</td>
<td>X coordinate in tiles</td>
</tr>
<tr>
<td>y</td>
<td>int</td>
<td>Y coordinate in tiles</td>
</tr>
</tbody>
</table>

21.3.1 Chunk Example

```json
{
    "data": [1, 2, 1, 2, 3, 1, 3, 1, 2, 2, 3, 3, 4, 4, 4, 1, ...],
    "height": 16,
    "width": 16,
    "x": 0,
    "y": -16
}
```
## 21.4 Object

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ellipse</td>
<td>bool</td>
<td>Used to mark an object as an ellipse</td>
</tr>
<tr>
<td>gid</td>
<td>int</td>
<td>Global tile ID, only if object represents a tile</td>
</tr>
<tr>
<td>height</td>
<td>double</td>
<td>Height in pixels.</td>
</tr>
<tr>
<td>id</td>
<td>int</td>
<td>Incremental ID, unique across all objects</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>String assigned to name field in editor</td>
</tr>
<tr>
<td>point</td>
<td>bool</td>
<td>Used to mark an object as a point</td>
</tr>
<tr>
<td>polygon</td>
<td>array</td>
<td>Array of Points, in case the object is a polygon</td>
</tr>
<tr>
<td>polyline</td>
<td>array</td>
<td>Array of Points, in case the object is a polyline</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>rotation</td>
<td>double</td>
<td>Angle in degrees clockwise</td>
</tr>
<tr>
<td>template</td>
<td>string</td>
<td>Reference to a template file, in case object is a template instance</td>
</tr>
<tr>
<td>text</td>
<td>Text</td>
<td>Only used for text objects</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>String assigned to type field in editor</td>
</tr>
<tr>
<td>visible</td>
<td>bool</td>
<td>Whether object is shown in editor</td>
</tr>
<tr>
<td>width</td>
<td>double</td>
<td>Width in pixels.</td>
</tr>
<tr>
<td>x</td>
<td>double</td>
<td>X coordinate in pixels</td>
</tr>
<tr>
<td>y</td>
<td>double</td>
<td>Y coordinate in pixels</td>
</tr>
</tbody>
</table>

### 21.4.1 Object Example

```
{
    "gid":5,
    "height":0,
    "id":1,
    "name":"villager",
    "properties":[
        {
            "name":"hp",
            "type":"int",
            "value":12
        }
    ],
    "rotation":0,
    "type":"npc",
    "visible":true,
    "width":0,
    "x":32,
    "y":32
}
```

### 21.4.2 Ellipse Example

```
{
    "ellipse":true,
    "height":152,
    "id":13,
    "name":"
    "rotation":0,
}
```
21.4.3 Rectangle Example

```json
{
    "height": 184,
    "id": 14,
    "name": "",
    "rotation": 0,
    "type": "",
    "visible": true,
    "width": 368,
    "x": 576,
    "y": 584
}
```

21.4.4 Point Example

```json
{
    "point": true,
    "height": 0,
    "id": 20,
    "name": "",
    "rotation": 0,
    "type": "",
    "visible": true,
    "width": 0,
    "x": 220,
    "y": 350
}
```

21.4.5 Polygon Example

```json
{
    "height": 0,
    "id": 15,
    "name": "",
    "polygon": [
        { "x": 0, "y": 0 },
        { "x": 152, "y": 88 }
    ]
}
```
21.4.6 Polyline Example

```json
{
    "height":0,
    "id":16,
    "name":null,
    "polyline":{
        "rotation":0,
        "type":null,
        "visible":true,
        "width":0,
        "x":-176,
        "y":432
    }
}
```

(continues on next page)
21.4.7 Text Example

```json
{
  "height":19,
  "id":15,
  "name":"
  "text":
  {
    "text":"Hello World",
    "wrap":true
  },
  "rotation":0,
  "type":"
  "visible":true,
  "width":248,
  "x":48,
  "y":136
}
```

21.5 Text

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bold</td>
<td>bool</td>
<td>Whether to use a bold font (default: false)</td>
</tr>
<tr>
<td>color</td>
<td>string</td>
<td>Hex-formatted color (#RRGGBB or #AARRGGBB) (default: #000000)</td>
</tr>
<tr>
<td>fontfamily</td>
<td>string</td>
<td>Font family (default: sans-serif)</td>
</tr>
<tr>
<td>halign</td>
<td>string</td>
<td>Horizontal alignment (center, right, justify or left (default))</td>
</tr>
<tr>
<td>italic</td>
<td>bool</td>
<td>Whether to use an italic font (default: false)</td>
</tr>
<tr>
<td>kerning</td>
<td>bool</td>
<td>Whether to use kerning when placing characters (default: true)</td>
</tr>
<tr>
<td>pixelsize</td>
<td>int</td>
<td>Pixel size of font (default: 16)</td>
</tr>
<tr>
<td>strikeout</td>
<td>bool</td>
<td>Whether to strike out the text (default: false)</td>
</tr>
<tr>
<td>text</td>
<td>string</td>
<td>Text</td>
</tr>
<tr>
<td>underline</td>
<td>bool</td>
<td>Whether to underline the text (default: false)</td>
</tr>
<tr>
<td>valign</td>
<td>string</td>
<td>Vertical alignment (center, bottom or top (default))</td>
</tr>
<tr>
<td>wrap</td>
<td>bool</td>
<td>Whether the text is wrapped within the object bounds (default: false)</td>
</tr>
</tbody>
</table>
## 21.6 Tileset

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>backgroundcolor</td>
<td>string</td>
<td>Hex-formatted color (#RRGGBB or #AARRGGBB) (optional)</td>
</tr>
<tr>
<td>columns</td>
<td>int</td>
<td>The number of tile columns in the tileset</td>
</tr>
<tr>
<td>firstgid</td>
<td>int</td>
<td>GID corresponding to the first tile in the set</td>
</tr>
<tr>
<td>grid</td>
<td>Grid</td>
<td>(optional)</td>
</tr>
<tr>
<td>image</td>
<td>string</td>
<td>Image used for tiles in this set</td>
</tr>
<tr>
<td>imageheight</td>
<td>int</td>
<td>Height of source image in pixels</td>
</tr>
<tr>
<td>imagewidth</td>
<td>int</td>
<td>Width of source image in pixels</td>
</tr>
<tr>
<td>margin</td>
<td>int</td>
<td>Buffer between image edge and first tile (pixels)</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>Name given to this tileset</td>
</tr>
<tr>
<td>objectalignment</td>
<td>string</td>
<td>Alignment to use for tile objects (unspecified (default), topleft, top, topright, left, center, right, bottomleft, bottom or bottomright) (since 1.4)</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>source</td>
<td>string</td>
<td>The external file that contains this tilesets data</td>
</tr>
<tr>
<td>spacing</td>
<td>int</td>
<td>Spacing between adjacent tiles in image (pixels)</td>
</tr>
<tr>
<td>terrains</td>
<td>array</td>
<td>Array of Terrains (optional)</td>
</tr>
<tr>
<td>tilecount</td>
<td>int</td>
<td>The number of tiles in this tileset</td>
</tr>
<tr>
<td>tiledversion</td>
<td>string</td>
<td>The Tiled version used to save the file</td>
</tr>
<tr>
<td>tileheight</td>
<td>int</td>
<td>Maximum height of tiles in this set</td>
</tr>
<tr>
<td>tileoffset</td>
<td>Tile Offset</td>
<td>(optional)</td>
</tr>
<tr>
<td>tiles</td>
<td>array</td>
<td>Array of Tiles (optional)</td>
</tr>
<tr>
<td>tilewidth</td>
<td>int</td>
<td>Maximum width of tiles in this set</td>
</tr>
<tr>
<td>transformations</td>
<td>Transformations</td>
<td>Allowed transformations (optional)</td>
</tr>
<tr>
<td>transparentcolor</td>
<td>string</td>
<td>Hex-formatted color (#RRGGBB) (optional)</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>tileset (for tileset files, since 1.0)</td>
</tr>
<tr>
<td>version</td>
<td>string</td>
<td>The JSON format version (previously a number, saved as string since 1.6)</td>
</tr>
<tr>
<td>wangsets</td>
<td>array</td>
<td>Array of Wang sets (since 1.1.5)</td>
</tr>
</tbody>
</table>

Each tileset has a firstgid (first global ID) property which tells you the global ID of its first tile (the one with local tile ID 0). This allows you to map the global IDs back to the right tileset, and then calculate the local tile ID by subtracting the firstgid from the global tile ID. The first tileset always has a firstgid value of 1.

### 21.6.1 Grid

Specifies common grid settings used for tiles in a tileset. See `<grid>` in the TMX Map Format.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>height</td>
<td>int</td>
<td>Cell height of tile grid</td>
</tr>
<tr>
<td>orientation</td>
<td>string</td>
<td>orthogonal (default) or isometric</td>
</tr>
<tr>
<td>width</td>
<td>int</td>
<td>Cell width of tile grid</td>
</tr>
</tbody>
</table>

### 21.6.2 Tile Offset

See `<tileoffset>` in the TMX Map Format.
Field | Type | Description
--- | --- | ---
x | int | Horizontal offset in pixels
y | int | Vertical offset in pixels (positive is down)

### 21.6.3 Transformations

See `<transformations>` in the TMX Map Format.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hflip</td>
<td>bool</td>
<td>Tiles can be flipped horizontally</td>
</tr>
<tr>
<td>vflip</td>
<td>bool</td>
<td>Tiles can be flipped vertically</td>
</tr>
<tr>
<td>rotate</td>
<td>bool</td>
<td>Tiles can be rotated in 90-degree increments</td>
</tr>
<tr>
<td>preferuntransformed</td>
<td>bool</td>
<td>Whether untransformed tiles remain preferred, otherwise transformed tiles are used to produce more variations</td>
</tr>
</tbody>
</table>

### 21.6.4 Tileset Example

```json
{
    "columns":19,
    "firstgid":1,
    "image":"..\image\fishbaddie_parts.png",
    "imageheight":480,
    "imagewidth":640,
    "margin":3,
    "name":",
    "properties":[
        {
            "name":"myProperty1",
            "type":"string",
            "value":"myProperty1_value"
        }
    ],
    "spacing":1,
    "tilecount":266,
    "tileheight":32,
    "tilewidth":32
}
```
## 21.6.5 Tile (Definition)

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>animation</td>
<td>array</td>
<td>Array of Frames</td>
</tr>
<tr>
<td>id</td>
<td>int</td>
<td>Local ID of the tile</td>
</tr>
<tr>
<td>image</td>
<td>string</td>
<td>Image representing this tile (optional)</td>
</tr>
<tr>
<td>imageheight</td>
<td>int</td>
<td>Height of the tile image in pixels</td>
</tr>
<tr>
<td>imagewidth</td>
<td>int</td>
<td>Width of the tile image in pixels</td>
</tr>
<tr>
<td>objectgroup</td>
<td>Layer</td>
<td>Layer with type objectgroup, when collision shapes are specified (optional)</td>
</tr>
<tr>
<td>probability</td>
<td>double</td>
<td>Percentage chance this tile is chosen when competing with others in the editor (optional)</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>terrain</td>
<td>array</td>
<td>Index of terrain for each corner of tile (optional)</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>The type of the tile (optional)</td>
</tr>
</tbody>
</table>

A tileset that associates information with each tile, like its image path or terrain type, may include a `tiles` array property. Each tile has an `id` property, which specifies the local ID within the tileset.

For the terrain information, each value is a length-4 array where each element is the index of a `terrain` on one corner of the tile. The order of indices is: top-left, top-right, bottom-left, bottom-right.

Example:

```json
"tiles": [
  {
    "id": 0,
    "properties": [
      {
        "name": "myProperty1",
        "type": "string",
        "value": "myProperty1_value"
      }
    ],
    "terrain": [0, 0, 0, 0]
  },
  {
    "id": 11,
    "properties": [
      {
        "name": "myProperty2",
        "type": "string",
        "value": "myProperty2_value"
      }
    ],
    "terrain": [0, 1, 0, 1]
  },
  {
    "id": 12,
    "properties": [
      {
        "name": "myProperty3",
        "type": "string",
        "value": "myProperty3_value"
      }
    ],
    "terrain": [1, 1, 1, 1]
  }
]```
21.6.6 Frame

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>duration</td>
<td>int</td>
<td>Frame duration in milliseconds</td>
</tr>
<tr>
<td>tileid</td>
<td>int</td>
<td>Local tile ID representing this frame</td>
</tr>
</tbody>
</table>

21.6.7 Terrain

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>string</td>
<td>Name of terrain</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>tile</td>
<td>int</td>
<td>Local ID of tile representing terrain</td>
</tr>
</tbody>
</table>

Example:

```json
"terrains": [
    {
        "name": "ground",
        "tile": 0
    },
    {
        "name": "chasm",
        "tile": 12
    },
    {
        "name": "cliff",
        "tile": 36
    }
]
```

21.6.8 Wang Set

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>colors</td>
<td>array</td>
<td>Array of Wang colors</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>Name of the Wang set</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>tile</td>
<td>int</td>
<td>Local ID of tile representing the Wang set</td>
</tr>
<tr>
<td>wangtiles</td>
<td>array</td>
<td>Array of Wang tiles</td>
</tr>
</tbody>
</table>

Wang Color

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>color</td>
<td>string</td>
<td>Hex-formatted color (#RRGGBB or #AARRGGBB)</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>Name of the Wang color</td>
</tr>
<tr>
<td>probability</td>
<td>double</td>
<td>Probability used when randomizing</td>
</tr>
<tr>
<td>properties</td>
<td>array</td>
<td>Array of Properties</td>
</tr>
<tr>
<td>tile</td>
<td>int</td>
<td>Local ID of tile representing the Wang color</td>
</tr>
</tbody>
</table>

Example:
Wang Tile

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tileid</td>
<td>int</td>
<td>Local ID of tile</td>
</tr>
<tr>
<td>wangid</td>
<td>array</td>
<td>Array of Wang color indexes (uchar[8])</td>
</tr>
</tbody>
</table>

Example:

```json
{
    "tileid": 0,
    "wangid": [2, 0, 1, 0, 1, 0, 2, 0]
}
```

21.7 Object Template

An object template is written to its own file and referenced by any instances of that template.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>string</td>
<td>template</td>
</tr>
<tr>
<td>tileset</td>
<td>Tiletset</td>
<td>External tileset used by the template (optional)</td>
</tr>
<tr>
<td>object</td>
<td>Object</td>
<td>The object instantiated by this template</td>
</tr>
</tbody>
</table>

21.8 Property

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>string</td>
<td>Name of the property</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>Type of the property (string (default), int, float, bool, color or file (since 0.16, with color and file added in 0.17))</td>
</tr>
<tr>
<td>value</td>
<td>value</td>
<td>Value of the property</td>
</tr>
</tbody>
</table>

21.9 Point

A point on a polygon or a polyline, relative to the position of the object.

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>double</td>
<td>X coordinate in pixels</td>
</tr>
<tr>
<td>y</td>
<td>double</td>
<td>Y coordinate in pixels</td>
</tr>
</tbody>
</table>
21.10 Changelog

21.10.1 Tiled 1.6

- The version property is now written as a string (“1.6”) instead of a number (1.5).

21.10.2 Tiled 1.5

- Unified cornercolors and edgecolors properties of Wang Set as the new colors property.
- Wang Color can now store properties.
- Added transformations property to Tiles (see Transformations).
- Removed dflip, hflip and vflip properties from Wang Tile (no longer supported).

21.10.3 Tiled 1.4

- Added objectalignment to the Tiles object.
- Added tintcolor to the Layer object.

21.10.4 Tiled 1.3

- Added an editorsettings property to top-level Map and Tiles objects, which is used to store editor specific settings that are generally not relevant when loading a map or tileset.
- Added support for Zstandard compression for tile layer data ("compression": "zstd" on tile layer objects).
- Added the compressionlevel property to the Map object, which stores the compression level to use for compressed tile layer data.

21.10.5 Tiled 1.2

- Added nextlayerid to the Map object.
- Added id to the Layer object.
- The tiles in a Tileset are now stored as an array instead of an object. Previously the tile IDs were stored as string keys of the “tiles” object, now they are stored as id property of each Tile object.
- Custom tile properties are now stored within each Tile instead of being included as tileproperties in the Tileset object.
- Custom properties are now stored in an array instead of an object where the property names were the keys. Each property is now an object that stores the name, type and value of the property. The separate propertytypes and tilepropertytypes properties have been removed.
21.10.6 Tiled 1.1

- Added a chunked data format, currently used for infinite maps.
- Templates were added. Templates can be stored as JSON files with an Object Template object.
- Tilesets can now contain Terrain Sets. They are saved in the new Wang Set object (since Tiled 1.1.5).
CHAPTER 22

Scripting

22.1 Introduction

Tiled can be extended with the use of JavaScript. Scripts can be used to implement custom map formats, custom actions and new tools. Scripts can also automate actions based on signals.

On startup, Tiled will execute any script files present in extensions. In addition it is possible to run scripts directly from the console. All scripts share a single JavaScript context.

Note: A few example scripts and links to existing Tiled extensions are provided at the Tiled Extensions repository: https://github.com/mapeditor/tiled-extensions

Warning: Most builds of Tiled use Qt 5.12 or later, which support ECMAScript 7. However, the builds for Windows XP and the snap release of Tiled currently rely on Qt 5.6 and Qt 5.9 respectively. ECMAScript 7 features will not work there and some other functionality is missing as well, like interrupting scripts on API usage errors and the creation of new Tiled-specific objects.

22.1.1 Scripted Extensions

Extensions are placed in a system-specific location. This folder can be opened from the Plugins tab in the Preferences dialog.
An extension can be placed directly in the extensions directory, or in a sub-directory. All scripts files found in these directories are executed on startup.

When any loaded script is changed or when any files are added/removed from the extensions directory, the script engine is automatically reinitialized and the scripts are reloaded. This way there is no need to restart Tiled when installing extensions. It also makes it quick to iterate on a script until it works as intended.

Apart from scripts, extensions can include images that can be used as the icon for scripted actions or tools.

### 22.1.2 Console View

In the Console view (View > Views and Toolbars > Console) you will find a text entry where you can write or paste scripts to evaluate them.

You can use the Up/Down keys to navigate through previously entered script expressions.

### 22.1.3 Connecting to Signals

The script API provides signals to which functions can be connected. Currently, the tiled module has the most useful set of signals.

Properties usually will have related signals which can be used to detect changes to that property, but most of those are currently not implemented.

To connect to a signal, call its `connect` function and pass in a function object. In the following example, newly created maps automatically get their first tile layer removed:

```javascript
function onAssetCreated(asset) {
  // Do something...
}
```

(continues on next page)
tiled.assetCreated.connect(onAssetCreated)
// ...
tiled.assetCreated.disconnect(onAssetCreated)

## 22.2 API Reference

### 22.2.1 Global Variables

__filename__ The file path of the current file being evaluated. Only available during initial evaluation of the file and not when later functions in that file get called. If you need it there, copy the value to local scope.

### 22.2.2 tiled module

The `tiled` module is the main entry point and provides properties, functions and signals which are documented below.

#### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>version</code></td>
<td>string [read-only]</td>
<td>Currently used version of Tiled.</td>
</tr>
<tr>
<td><code>platform</code></td>
<td>string [read-only]</td>
<td>Operating system. One of <code>windows</code>, <code>macos</code>, <code>linux</code> or <code>unix</code> (for any other UNIX-like system).</td>
</tr>
<tr>
<td><code>arch</code></td>
<td>string [read-only]</td>
<td>Processor architecture. One of <code>x64</code>, <code>x86</code> or <code>unknown</code>.</td>
</tr>
<tr>
<td><code>actions</code></td>
<td>[string] [read-only]</td>
<td>Available actions for <code>tiled.trigger()</code>.</td>
</tr>
<tr>
<td><code>menus</code></td>
<td>[string] [read-only]</td>
<td>Available menus for <code>tiled.extendMenu()</code>.</td>
</tr>
<tr>
<td><code>activeAsset</code></td>
<td><code>Asset</code></td>
<td>Currently selected asset, or <code>null</code> if no file is open. Can be assigned any open asset in order to change the active asset.</td>
</tr>
<tr>
<td><code>openAssets</code></td>
<td>array [read-only]</td>
<td>List of currently opened <code>assets</code>.</td>
</tr>
<tr>
<td><code>mapEditor</code></td>
<td><code>MapEditor</code></td>
<td>Access the editor used when editing maps.</td>
</tr>
<tr>
<td><code>tilesetEditor</code></td>
<td><code>TilesetEditor</code></td>
<td>Access the editor used when editing tilesets.</td>
</tr>
<tr>
<td><code>tilesetFormats</code></td>
<td>[string] [read-only]</td>
<td>List of supported tileset format names. Use <code>tilesetFormat</code> to get the corresponding format object to read and write files. (Since 1.4)</td>
</tr>
<tr>
<td><code>mapFormats</code></td>
<td>[string] [read-only]</td>
<td>List of supported map format names. Use <code>mapFormat</code> to get the corresponding format object to read and write files. (Since 1.4)</td>
</tr>
</tbody>
</table>

#### Functions

**tiled.trigger(action [string]) [void]** This function can be used to trigger any registered action. This includes most actions you would normally trigger through the menu or by using their shortcut.

Use the `tiled.actions` property to get a list of all available actions.

Actions that are checkable will toggle when triggered.

**tiled.executeCommand(name [string, inTerminal][bool]) [void]** Executes the first custom command with the given name, as if it was triggered manually. Works also with commands that are not currently enabled.

Raises a script error if the command is not found.
**tiled.open(fileName)** [string][Asset] Requests to open the asset with the given file name. Returns a reference to the opened asset, or null in case there was a problem.

**tiled.close(asset)** [Asset][bool] Closes the given asset without checking for unsaved changes (to confirm the loss of any unsaved changes, set `activeAsset` and trigger the “Close” action instead).

**tiled.reload(asset)** [Asset][Asset] Reloads the given asset from disk, without checking for unsaved changes. This invalidates the previous script reference to the asset, hence the new reference is returned for convenience. Returns null if reloading failed.

**tiled.alert(text)** [string [, title][string]][void] Shows a modal warning dialog to the user with the given text and optional title.

**tiled.confirm(text)** [string [, title][string]][bool] Shows a yes/no dialog to the user with the given text and optional title. Returns `true` or `false`.

**tiled.prompt(label)** [string [, text][string [, title][string]]][string] Shows a dialog that asks the user to enter some text, along with the given label and optional title. The optional `text` parameter provides the initial value of the text. Returns the entered text.

**tiled.log(text)** [string][void] Outputs the given text in the Console window as regular text.

**tiled.warn(text)** [string, activated][function][void] Outputs the given text in the Console window as warning message and creates an issue in the Issues window.

When the issue is activated (with double-click or Enter key) the given callback function is invoked.

**tiled.error(text)** [string, activated][function][void] Outputs the given text in the Console window as error message and creates an issue in the Issues window.

When the issue is activated (with double-click or Enter key) the given callback function is invoked.

**tiled.registerAction(id)** [string, callback][function][Action] Registers a new action with the given `id` and `callback` (which is called when the action is triggered). The returned action object can be used to set (and update) various properties of the action.

Example:

```javascript
var action = tiled.registerAction("CustomAction", function(action) {
  tiled.log(action.text + " was " + (action.checked ? "checked" : "unchecked"))
})

action.text = "My Custom Action"
action.checkable = true
action.shortcut = "Ctrl+K"
```

The shortcut will currently only work when the action is added to a menu using `tiled.extendMenu()`.

**tiled.registerMapFormat(shortName)** [string, mapFormat][object][void] Registers a new map format that can then be used to open and/or save maps in that format.

If a map format is already registered with the same `shortName`, the existing format is replaced. The short name can also be used to specify the format when using `--export-map` on the command-line, in case the file extension is ambiguous or a different one should be used.

The `mapFormat` object is expected to have the following properties:
Tiled Documentation, Release 1.6.0

| name : string | Name of the format as shown in the file dialog. |
| extension : string | The file extension used by the format. |
| read : function(fileName : string) : TileMap | A function that reads a map from the given file. Can use TextFile or BinaryFile to read the file. |
| write : function(map : TileMap, fileName : string) : string | A function that writes a map to the given file. Can use TextFile or BinaryFile to write the file. When a non-empty string is returned, it is shown as error message. |
| outputFiles : function(map : TileMap, fileName : string) : [string] | A function that returns the list of files that will be written when exporting the given map (optional). |

Example that produces a simple JSON representation of a map:

```javascript
var customMapFormat = {
  name: "Custom map format",
  extension: "custom",

  write: function(map, fileName) {
    var m = {
      width: map.width,
      height: map.height,
      layers: []
    };

    for (var i = 0; i < map.layerCount; ++i) {
      var layer = map.layerAt(i);
      if (layer.isTileLayer) {
        var rows = [];
        for (y = 0; y < layer.height; ++y) {
          var row = [];
          for (x = 0; x < layer.width; ++x)
            row.push(layer.cellAt(x, y).tileId);
          rows.push(row);
        }
        m.layers.push(rows);
      }
    }

    var file = new TextFile(fileName, TextFile.WriteOnly);
    file.write(JSON.stringify(m));
    file.commit();
  },

  tiled.registerMapFormat("custom", customMapFormat)
}
```

tiled.registerTilesetFormat(shortName, tilesetFormat) [string, tilesetFormat][object][void] Like registerMapFormat, but registers a custom tileset format instead.

The tilesetFormat object is expected to have the following properties:
### Tiled Documentation, Release 1.6.0

<table>
<thead>
<tr>
<th>name</th>
<th>string</th>
<th>Name of the format as shown in the file dialog.</th>
</tr>
</thead>
<tbody>
<tr>
<td>extension</td>
<td>string</td>
<td>The file extension used by the format.</td>
</tr>
<tr>
<td>read</td>
<td>function(fileName : string) : Tileset</td>
<td>A function that reads a tileset from the given file. Can use <code>TextFile</code> or <code>BinaryFile</code> to read the file.</td>
</tr>
<tr>
<td>write</td>
<td>function(tileset : Tileset, fileName : string) : string</td>
<td>A function that writes a tileset to the given file. Can use <code>TextFile</code> or <code>BinaryFile</code> to write the file. When a non-empty string is returned, it is shown as error message.</td>
</tr>
</tbody>
</table>

**tiled.registerTool**(shortName : [string, tool][object][object]) Registers a custom tool that will become available on the Tools tool bar of the Map Editor.

If a tool is already registered with the same `shortName` the existing tool is replaced.

The `tool` object has the following properties:

<table>
<thead>
<tr>
<th>name</th>
<th>string</th>
<th>Name of the tool as shown on the tool bar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon</td>
<td>string</td>
<td>File name of an icon. If set, the icon is shown on the tool bar and the name becomes the tool tip.</td>
</tr>
<tr>
<td>map</td>
<td>TileMap</td>
<td>Currently active tile map.</td>
</tr>
<tr>
<td>selectedTile</td>
<td>Tile</td>
<td>The last clicked tile for the active map. See also the <code>currentBrush</code> property of <code>MapEditor</code>.</td>
</tr>
<tr>
<td>preview</td>
<td>TileMap</td>
<td>Get or set the preview for tile layer edits.</td>
</tr>
<tr>
<td>tilePosition</td>
<td>point</td>
<td>Mouse cursor position in tile coordinates.</td>
</tr>
<tr>
<td>statusInfo</td>
<td>string</td>
<td>Text shown in the status bar while the tool is active.</td>
</tr>
<tr>
<td>enabled</td>
<td>bool</td>
<td>Whether this tool is enabled.</td>
</tr>
<tr>
<td>activated</td>
<td>function() : void</td>
<td>Called when the tool was activated.</td>
</tr>
<tr>
<td>deactivated</td>
<td>function() : void</td>
<td>Called when the tool was deactivated.</td>
</tr>
<tr>
<td>keyPressed</td>
<td>function(key, modifiers) : void</td>
<td>Called when a key was pressed while the tool was active.</td>
</tr>
<tr>
<td>mouseEntered</td>
<td>function() : void</td>
<td>Called when the mouse entered the map view.</td>
</tr>
<tr>
<td>mouseLeft</td>
<td>function() : void</td>
<td>Called when the mouse left the map view.</td>
</tr>
<tr>
<td>mouseMoved</td>
<td>function(x, y, modifiers) : void</td>
<td>Called when the mouse position in the map scene changed.</td>
</tr>
<tr>
<td>mousePressed</td>
<td>function(button, x, y, modifiers) : void</td>
<td>Called when a mouse button was pressed.</td>
</tr>
<tr>
<td>mouseReleased</td>
<td>function(button, x, y, modifiers) : void</td>
<td>Called when a mouse button was released.</td>
</tr>
<tr>
<td>mouseDoubleClicked</td>
<td>function(button, x, y, modifiers) : void</td>
<td>Called when a mouse button was double-clicked.</td>
</tr>
<tr>
<td>modifiersChanged</td>
<td>function(modifiers) : void</td>
<td>Called when the active modifier keys changed.</td>
</tr>
<tr>
<td>languageChanged</td>
<td>function() : void</td>
<td>Called when the language was changed.</td>
</tr>
<tr>
<td>mapChanged</td>
<td>function(oldMap : TileMap, newMap : TileMap) : void</td>
<td>Called when the active map was changed.</td>
</tr>
<tr>
<td>tilePositionChanged</td>
<td>function() : void</td>
<td>Called when the hovered tile position changed.</td>
</tr>
<tr>
<td>updateStatusInfo</td>
<td>function() : void</td>
<td>Called when the hovered tile position changed. Used to override the default updating of the status bar text.</td>
</tr>
<tr>
<td>updateEnabledState</td>
<td>function() : void</td>
<td>Called when the map or the current layer changed.</td>
</tr>
</tbody>
</table>
Here is an example tool that places a rectangle each time the mouse has moved by 32 pixels:

```javascript
var tool = tiled.registerTool("PlaceRectangles", {
    name: "Place Rectangles",
    mouseMoved: function(x, y, modifiers) {
        if (!this.pressed)
            return

        var dx = Math.abs(this.x - x)
        var dy = Math.abs(this.y - y)

        this.distance += Math.sqrt(dx*dx + dy*dy)
        this.x = x
        this.y = y

        if (this.distance > 32) {
            var objectLayer = this.map.currentLayer
            if (objectLayer && objectLayer.isObjectLayer) {
                var object = new MapObject(++this.counter)
                object.x = Math.min(this.lastX, x)
                object.y = Math.min(this.lastY, y)
                object.width = Math.abs(this.lastX - x)
                object.height = Math.abs(this.lastY - y)
                objectLayer.addObject(object)
            }
            this.distance = 0
            this.lastX = x
            this.lastY = y
        }
    },
    mousePressed: function(button, x, y, modifiers) {
        this.pressed = true
        this.x = x
        this.y = y
        this.distance = 0
        this.counter = 0
        this.lastX = x
        this.lastY = y
    },
    mouseReleased: function(button, x, y, modifiers) {
        this.pressed = false
    }
})
```

tiled.extendMenu(id, [string, items][array | object]) [void] Extends the menu with the given ID. Supports both a list of items or a single item. Available menu IDs can be obtained using the tiled.menus property.

A menu item is defined by an object with the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>action</td>
<td>ID of a registered action that the menu item will represent.</td>
</tr>
<tr>
<td>before</td>
<td>ID of the action before which this menu item should be added (optional).</td>
</tr>
<tr>
<td>separator</td>
<td>Set to true if this item is a menu separator (optional).</td>
</tr>
</tbody>
</table>
If a menu item does not include a \texttt{before} property, the value is inherited from the previous item. When this property is not set at all, the items are appended to the end of the menu.

Example that adds a custom action to the “Edit” menu, before the “Select All” action and separated by a separator:

```javascript
const customAction = { action: "CustomAction", before: "SelectAll" },
{ separator: true }
);}
```

The “CustomAction” will need to have been registered before using \texttt{tiled.registerAction()}

**tiled.tilesetFormat(shortName [string])**: Returns the tileset format object with the given name, or \texttt{undefined} if no object was found. See the \texttt{tilesetFormats} property for more info.

**tiled.tilesetFormatForFile(fileName [string])**: Returns the tileset format object that can read the given file, or \texttt{undefined} if no object was found.

**tiled.mapFormat(shortName [string])**: Returns the map format object with the given name, or \texttt{undefined} if no object was found. See the \texttt{mapFormats} property for more info.

**tiled.mapFormatForFile(fileName [string])**: Returns the map format object that can read the given file, or \texttt{undefined} if no object was found.

**tiled.filePath(path [url])**: Creates a \texttt{FilePath} object with the given URL.

**tiled.objectRef(id [int])**: Creates an \texttt{ObjectRef} object with the given ID.

**Signals**

- \texttt{tiled.assetCreated(asset [Asset])}: A new asset has been created.
- \texttt{tiled.assetOpened(asset [Asset])}: An asset has been opened.
- \texttt{tiled.assetAboutToBeSaved(asset [Asset])}: An asset is about to be saved. Can be used to make last-minute changes.
- \texttt{tiled.assetSaved(asset [Asset])}: An asset has been saved.
- \texttt{tiled.assetAboutToBeClosed(asset [Asset])}: An asset is about to be closed.
- \texttt{tiled.activeAssetChanged(asset [Asset])}: The currently active asset has changed.

**22.2.3 Action**

An action that was registered with \texttt{tiled.registerAction()}. This class is used to change the properties of the action. It can be added to a menu using \texttt{tiled.extendMenu()}. 

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>checkable</td>
<td>Whether the action can be checked.</td>
</tr>
<tr>
<td>checked</td>
<td>Whether the action is checked.</td>
</tr>
<tr>
<td>enabled</td>
<td>Whether the action is enabled.</td>
</tr>
<tr>
<td>icon</td>
<td>File name of an icon.</td>
</tr>
<tr>
<td>iconVisibleInMenu</td>
<td>Whether the action should show an icon in a menu.</td>
</tr>
<tr>
<td>id</td>
<td>The ID this action was registered with.</td>
</tr>
<tr>
<td>shortcut</td>
<td>The shortcut (can be assigned a string like “Ctrl+K”).</td>
</tr>
<tr>
<td>text</td>
<td>The text used when the action is part of a menu.</td>
</tr>
<tr>
<td>visible</td>
<td>Whether the action is visible.</td>
</tr>
</tbody>
</table>

Functions

**Action.trigger()** [void] Triggers the action.

**Action.toggle()** [void] Changes the checked state to its opposite state.

### 22.2.4 Asset

Inherits *Object*.

Represents any top-level data type that can be saved to a file. Currently either a *TileMap* or a *Tileset*.

For assets that are loaded in the editor, all modifications and modifications to their contained parts create undo commands. This includes both modifying functions that are called as well as simply assigning to a writable property.

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fileName</td>
<td>File name of the asset.</td>
</tr>
<tr>
<td>modified</td>
<td>Whether the asset was modified after it was saved or loaded.</td>
</tr>
<tr>
<td>isTileMap</td>
<td>Whether the asset is a <em>TileMap</em>.</td>
</tr>
<tr>
<td>isTileset</td>
<td>Whether the asset is a <em>Tileset</em>.</td>
</tr>
</tbody>
</table>

Functions

**Asset.macro(text [string, callback][function][value])** Creates a single undo command that wraps all changes applied to this asset by the given callback. Recommended to avoid spamming the undo stack with small steps that the user does not care about.

Example function that changes visibility of multiple layers in one step:

```javascript
tileMap.macro((visible ? "Show" : "Hide") + " Selected Layers", function() {
    tileMap.selectedLayers.forEach(function(layer) {
        layer.visible = visible
    })
})
```

The returned value is whatever the callback function returned.

**Asset.undo()** [void] Undoes the last applied change. Note that the undo system is only enabled for assets loaded in the editor!
Asset.redo() [void] Redoes the last change that was undone. Note that the undo system is only enabled for assets loaded in the editor!

### 22.2.5 FileFormat

Common functionality for file format readers and writers. (Since 1.4)

#### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>canRead</td>
<td>bool</td>
<td>Whether this format supports reading files.</td>
</tr>
<tr>
<td>canWrite</td>
<td>bool</td>
<td>Whether this format supports writing files.</td>
</tr>
</tbody>
</table>

#### Functions

**FileFormat.supportsFile(fileName: string)[bool]** Returns whether the file is readable by this format.

### 22.2.6 FileInfo

Offers various operations on file paths, such as turning absolute paths into relative ones, splitting a path into its components, and so on.

#### Functions

**FileInfo.baseName(filePath: string)[string]** Returns the file name of `filePath` up to (but not including) the first ‘.’ character.

**FileInfo.canonicalPath(filePath: string)[string]** Returns a canonicalized `filePath`, i.e. an absolute path without symbolic links or redundant “.” or “..” elements. On Windows, drive substitutions are also resolved.

It is recommended to use `canonicalPath` in only those cases where canonical paths are really necessary. In most cases, `cleanPath` should be enough.

**FileInfo.cleanPath(filePath: string)[string]** Returns `filePath` without redundant separators and with resolved occurrences of . and .. components. For instance, `/usr/local/../../../bin/` becomes `/usr/bin`.

**FileInfo.completeBaseName(filePath: string)[string]** Returns the file name of `filePath` up to (but not including) the last ‘.’ character.

**FileInfo.completeSuffix(filePath: string)[string]** Returns the file suffix of `filePath` from (but not including) the last ‘.’ character.

**FileInfo.fileName(filePath: string)[string]** Returns the last component of `filePath`, that is, everything after the last ‘/’ character.

**FileInfo.fromNativeSeparators(filePath: string)[string]** On Windows, returns `filePath` with all ‘\’ characters replaced by ‘/’. On other operating systems, it returns the input unmodified.

**FileInfo.isAbsolutePath(filePath: string)[boolean]** Returns true if `filePath` is an absolute path and false if it is a relative one.

**FileInfo.joinPaths(… paths)[string]** Concatenates the given paths using the ‘/’ character.
FileInfo.path(filePath [string]) Returns the part of filePath that is not the file name, that is, everything up to (but not including) the last ‘/’ character. If filePath is just a file name, then ‘.’ is returned. If filePath ends with a ‘/’ character, then the file name is assumed to be empty for the purpose of the above definition.

FileInfo.relativePath(dirPath [string, filePath][string]) Returns the path to filePath relative to the directory dirPath. If necessary, ‘..’ components are inserted.

FileInfo.suffix(filePath [string]) Returns the file suffix of filePath from (but not including) the first ‘.’ character.

FileInfo.toNativeSeparators(filePath [string]) On Windows, returns filePath with all ‘/’ characters replaced by ‘\’. On other operating systems, it returns the input unmodified.

### 22.2.7 GroupLayer

Inherits Layer.

#### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>layerCount</td>
<td>Number of child layers the group layer has.</td>
</tr>
</tbody>
</table>

#### Functions

- new GroupLayer([name [string]]) Constructs a new group layer.
- GroupLayer.layerAt(index [int]) Returns a reference to the child layer at the given index.
- GroupLayer.removeLayerAt(index [int]) Removes the child layer at the given index. When a reference to the layer still exists and this group layer isn’t already standalone, that reference becomes a standalone copy of the layer.
- GroupLayer.removeLayer(layer [Layer]) Removes the given layer from the group. If this group wasn’t standalone, the reference to the layer becomes a standalone copy.
- GroupLayer.insertLayerAt(index [int, layer][Layer]) Inserts the layer at the given index. The layer can’t already be part of a map.
  - When adding a TileLayer to a map, the layer’s width and height are automatically initialized to the size of the map (since Tiled 1.4.2).
- GroupLayer.addLayer(layer [Layer]) Adds the layer to the group, above all existing layers. The layer can’t already be part of a map.
  - When adding a TileLayer to a map, the layer’s width and height are automatically initialized to the size of the map (since Tiled 1.4.2).

### 22.2.8 Image

Can be used to create, load, save and modify images. Also useful when writing an importer, where the image can be set on a tileset or its tiles (see Tileset.loadFromImage and Tile.setImage).
Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>Width of the image in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>Height of the image in pixels.</td>
</tr>
<tr>
<td>depth</td>
<td>Number of bits used to store a single pixel.</td>
</tr>
<tr>
<td>size</td>
<td>Size of the image in pixels.</td>
</tr>
<tr>
<td>format</td>
<td>Format of the image.</td>
</tr>
</tbody>
</table>

Functions

new Image() Constructs an empty image.

new Image(width [int, height][int, format][Format]) Constructs an image of the given size using the given format.

new Image(data [ArrayBuffer, width][int, height][int, format][Format]) Constructs an image from the given data, interpreting it in the specified format and size.

new Image(data [ArrayBuffer, width][int, height][int, bytesPerLine][int, format][Format]) Constructs an image from the given data, interpreting it in the specified format and size. The bytesPerLine argument specifies the stride and can be useful for referencing a sub-image.

new Image(fileName [string [, format][string]]) Construct an image by loading it from the given file name. When no format is given it will be auto-detected (can be “bmp”, “png”, etc.).

Image.pixel(x [int, y][int][uint]) Returns the 32-bit color value.

Image.pixelColor(x [int, y][int][color]) Returns the color at the given position as string like “#rrggbb”.

Image.setPixel(x [int, y][int, index_or_rgb][uint]) Sets the color at the specified location to the given 32-bit color value or color table index.

Image.setPixelColor(x [int, y][int, color][color]) Sets the color at the specified location to the given color by string (supports values like “#rrggbb”).

Image.fill(index_or_rgb [uint][void]) Fills the image with the given 32-bit color value or color table index.

Image.fill(color [color][void]) Fills the image with the given color by string (supports values like “#rrggbb”).

Image.load(fileName [string [, format][string]])[bool] Loads the image from the given file name. When no format is given it will be auto-detected (can be “bmp”, “png”, etc.).

Image.loadFromData(data [ArrayBuffer, format: string][bool]) Loads the image from the given data interpreted with the given format (can be “bmp”, “png”, etc.).

Image.save(fileName [string [, format][string [, quality][int ]]][bool]) Saves the image to the given file. When no format is given it will be auto-detected based on the file extension.

Image.saveToData(format [string [, quality][int ]][ArrayBuffer]) Saves the image to an ArrayBuffer in the given format (can be “bmp”, “png”, etc.).

Image.color(index [int][uint]) Returns the 32-bit color value at the given index in the color table.

Image.colorTable() [array] Returns the color table as an array of 32-bit color values.

Image.setColor(index [int, rgb][uint][void]) Sets the color at the given index in the color table to a given 32-bit color value.

Image.setColor(index [int, color][color][void]) Sets the color at the given index in the color table to a color by string (supports values like “#rrggbb”).

Image.setColorTable(colors [array][void]) Sets the color table given by an array of either 32-bit color values or strings (supports values like “#rrggbb”).
Image.copy(x [int, y][int, width][int, height][int])[Image] Copies the given rectangle to a new image object.

Image.scaled(width [int, height][int [, aspectRatioMode][AspectRatioMode [, transformation-Mode][TransformationMode]])][Image] Returns a scaled copy of this image. Default aspectRatioMode behavior is to ignore the aspect ratio. Default mode is a fast transformation.

Image.mirrored(horizontal [bool, vertical][bool][Image] Returns a mirrored copy of this image.

<table>
<thead>
<tr>
<th>Image.Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image.Format_Invalid</td>
</tr>
<tr>
<td>Image.Format_Mono</td>
</tr>
<tr>
<td>Image.Format_MonoLSB</td>
</tr>
<tr>
<td>Image.Format_Indexed8</td>
</tr>
<tr>
<td>Image.Format_RGB32</td>
</tr>
<tr>
<td>Image.Format_ARGB32</td>
</tr>
<tr>
<td>Image.Format_ARGB32_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_RGB16</td>
</tr>
<tr>
<td>Image.Format_ARGB8565_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_RGB666</td>
</tr>
<tr>
<td>Image.Format_ARGB666_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_RGB555</td>
</tr>
<tr>
<td>Image.Format_ARGB8555_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_RGBA8888</td>
</tr>
<tr>
<td>Image.Format_RGBA8444</td>
</tr>
<tr>
<td>Image.Format_RGBA444_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_RGBX8888</td>
</tr>
<tr>
<td>Image.Format_RGBA8888_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_BGR30</td>
</tr>
<tr>
<td>Image.Format_A2BGR30_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_RGB30</td>
</tr>
<tr>
<td>Image.Format_A2RGB30_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_Alpha8</td>
</tr>
<tr>
<td>Image.Format_Grayscale8</td>
</tr>
<tr>
<td>Image.Format_RGBX64</td>
</tr>
<tr>
<td>Image.Format_RGBA64</td>
</tr>
<tr>
<td>Image.Format_RGBA64_Premultiplied</td>
</tr>
<tr>
<td>Image.Format_BGR888</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image.AspectRatioMode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image.IgnoreAspectRatio</td>
</tr>
<tr>
<td>Image.KeepAspectRatio</td>
</tr>
<tr>
<td>Image.KeepAspectRatioByExpanding</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image.TransformationMode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image.FastTransformation</td>
</tr>
<tr>
<td>Image.SmoothTransformation</td>
</tr>
</tbody>
</table>
22.2.9 ImageLayer

Inherits Layer.

Properties

<table>
<thead>
<tr>
<th>transparentColor : color</th>
<th>Color used as transparent color when rendering the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>imageSource : url</td>
<td>Reference to the image rendered by this layer.</td>
</tr>
</tbody>
</table>

Functions

new ImageLayer([name [string]]) Constructs a new image layer.

ImageLayer.loadFromImage([Image [, source: url]][void] Sets the image for this layer to the given image, optionally also setting the source of the image.

Warning: This function has no undo!

22.2.10 Layer

Inherits Object.

Properties

<table>
<thead>
<tr>
<th>id : int [read-only]</th>
<th>Unique (map-wide) ID of the layer (since Tiled 1.5).</th>
</tr>
</thead>
<tbody>
<tr>
<td>name : string</td>
<td>Name of the layer.</td>
</tr>
<tr>
<td>opacity : number</td>
<td>Opacity of the layer, from 0 (fully transparent) to 1 (fully opaque).</td>
</tr>
<tr>
<td>visible : bool</td>
<td>Whether the layer is visible (affects child layer visibility for group layers).</td>
</tr>
<tr>
<td>locked : bool</td>
<td>Whether the layer is locked (affects whether child layers are locked for group layers).</td>
</tr>
<tr>
<td>offset : point</td>
<td>Offset in pixels that is applied when this layer is rendered.</td>
</tr>
<tr>
<td>parallaxFactor : point</td>
<td>The parallax factor of the layer (since Tiled 1.5).</td>
</tr>
<tr>
<td>map : TileMap [read-only]</td>
<td>Map that this layer is part of (or null in case of a standalone layer).</td>
</tr>
<tr>
<td>parentLayer : GroupLayer [read-only]</td>
<td>The parent group layer, if any.</td>
</tr>
<tr>
<td>selected : bool</td>
<td>Whether the layer is selected.</td>
</tr>
<tr>
<td>isTileLayer : bool [read-only]</td>
<td>Whether this layer is a TileLayer.</td>
</tr>
<tr>
<td>isObjectLayer : bool [read-only]</td>
<td>Whether this layer is an ObjectGroup.</td>
</tr>
<tr>
<td>isGroupLayer : bool [read-only]</td>
<td>Whether this layer is a GroupLayer.</td>
</tr>
<tr>
<td>isImageLayer : bool [read-only]</td>
<td>Whether this layer is an ImageLayer.</td>
</tr>
</tbody>
</table>

22.2.11 MapObject

Inherits Object.
Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>int [read-only]</td>
<td>Unique (map-wide) ID of the object.</td>
</tr>
<tr>
<td>shape</td>
<td>int</td>
<td>Shape of the object.</td>
</tr>
<tr>
<td>name</td>
<td>string</td>
<td>Name of the object.</td>
</tr>
<tr>
<td>type</td>
<td>string</td>
<td>Type of the object.</td>
</tr>
<tr>
<td>x</td>
<td>number</td>
<td>X coordinate of the object in pixels.</td>
</tr>
<tr>
<td>y</td>
<td>number</td>
<td>Y coordinate of the object in pixels.</td>
</tr>
<tr>
<td>pos</td>
<td>point</td>
<td>Position of the object in pixels.</td>
</tr>
<tr>
<td>width</td>
<td>number</td>
<td>Width of the object in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>number</td>
<td>Height of the object in pixels.</td>
</tr>
<tr>
<td>size</td>
<td>size</td>
<td>Size of the object in pixels.</td>
</tr>
<tr>
<td>rotation</td>
<td>number</td>
<td>Rotation of the object in degrees clockwise.</td>
</tr>
<tr>
<td>visible</td>
<td>bool</td>
<td>Whether the object is visible.</td>
</tr>
<tr>
<td>polygon</td>
<td>Polygon</td>
<td>Polygon of the object.</td>
</tr>
<tr>
<td>text</td>
<td>string</td>
<td>The text of a text object.</td>
</tr>
<tr>
<td>font</td>
<td>Font</td>
<td>The font of a text object.</td>
</tr>
<tr>
<td>textAlignment</td>
<td>Alignment</td>
<td>The alignment of a text object.</td>
</tr>
<tr>
<td>wordWrap</td>
<td>bool</td>
<td>Whether the text of a text object wraps based on the width of the object.</td>
</tr>
<tr>
<td>textColor</td>
<td>color</td>
<td>Color of a text object.</td>
</tr>
<tr>
<td>tile</td>
<td>Tile</td>
<td>Tile of the object.</td>
</tr>
<tr>
<td>tileFlippedHorizontally</td>
<td>bool</td>
<td>Whether the tile is flipped horizontally.</td>
</tr>
<tr>
<td>tileFlippedVertically</td>
<td>bool</td>
<td>Whether the tile is flipped vertically.</td>
</tr>
<tr>
<td>selected</td>
<td>bool</td>
<td>Whether the object is selected.</td>
</tr>
<tr>
<td>layer</td>
<td>ObjectGroup [read-only]</td>
<td>Layer this object is part of (or null in case of a standalone object).</td>
</tr>
<tr>
<td>map</td>
<td>TileMap [read-only]</td>
<td>Map this object is part of (or null in case of a standalone object).</td>
</tr>
</tbody>
</table>

Functions

new MapObject([name [string]]) Constructs a new map object, which can be added to an ObjectGroup.

22.2.12 MapEditor

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>currentBrush</td>
<td>TileMap</td>
<td>Get or set the currently used tile brush.</td>
</tr>
<tr>
<td>currentMapView</td>
<td>MapView [read-only]</td>
<td>Access the current map view.</td>
</tr>
<tr>
<td>tilesetsView</td>
<td>TilesView [read-only]</td>
<td>Access the Tilesets view.</td>
</tr>
</tbody>
</table>
22.2.13 MapFormat

This is an object that can read or write map files. (Since 1.4)
Inherits FileFormat.

Functions

MapFormat.read(fileName [string]) [TileMap] Read the given file as a map. This function will throw an error if reading is not supported.

MapFormat.write(map [TileMap], fileName [string]) [string] Write the given map to a file. This function will throw an error if writing is not supported. If there is an error writing the file, it will return a description of the error; otherwise, it will return "".

22.2.14 MapView

The view displaying the map.

Properties

| scale : number | The scale of the view. |
| center : point | The center of the view. |

Functions

MapView.centerOn(x [number], y [number]) [void] Centers the view at the given location in screen coordinates. Same as assigning to the center property.

22.2.15 Object

The base of most data types in Tiled. Provides the ability to associate custom properties with the data.

Properties

| asset : Asset [read-only] | The asset this object is part of, or null. |
| readOnly : bool [read-only] | Whether the object is read-only. |

Functions

Object.property(name [string]) [variant] Returns the value of the custom property with the given name, or undefined if no such property is set on the object. Does not include inherited values (see resolvedProperty).

file properties are returned as FilePath.

object properties are returned as MapObject when possible, or ObjectRef when the object could not be found.
Object.setProperty(name \[string, value\][variant])[void] Sets the value of the custom property with the given name. Supported types are bool, number, string, FilePath, ObjectRef and MapObject.

When setting a number, the property type will be set to either int or float, depending on whether it is a whole number.

*Note: Support for setting color properties is currently missing.*

Object.properties() \[object\] Returns all custom properties set on this object. Modifications to the properties will not affect the original object. Does not include inherited values (see resolvedProperties).

Object.setProperties(properties \[object\])[void] Replaces all currently set custom properties with a new set of properties.

Object.removeProperty(name \[string\])[void] Removes the custom property with the given name.

Object.resolvedProperty(name \[string\])[variant] Returns the value of the custom property with the given name, or undefined if no such property is set. Includes values inherited from object types, templates and tiles where applicable.

Object.resolvedProperties() \[object\] Returns all custom properties set on this object. Modifications to the properties will not affect the original object. Includes values inherited from object types, templates and tiles where applicable.

### 22.2.16 ObjectGroup

Inherits Layer.

The “ObjectGroup” is a type of layer that can contain objects. It will henceforth be referred to as a layer.

**Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>objects</td>
<td>[MapObject] [read-only] Array of all objects on this layer.</td>
</tr>
<tr>
<td>objectCount</td>
<td>int [read-only] Number of objects on this layer.</td>
</tr>
<tr>
<td>color</td>
<td>color Color of shape and point objects on this layer (when not set by object type).</td>
</tr>
</tbody>
</table>

**Functions**

new ObjectGroup(name \[string\]) Constructs a new object layer, which can be added to a TileMap.

ObjectGroup.objectAt(index \[int\])[MapObject] Returns a reference to the object at the given index. When the object is removed, the reference turns into a standalone copy of the object.

ObjectGroup.removeObjectAt(index \[int\])[void] Removes the object at the given index.

ObjectGroup.removeObject(object \[MapObject\])[void] Removes the given object from this layer. The object reference turns into a standalone copy of the object.

ObjectGroup.insertObjectAt(index \[int, object\][MapObject])[void] Inserts the object at the given index. The object can’t already be part of a layer.

ObjectGroup.addObject(object \[MapObject\])[void] Adds the given object to the layer. The object can’t already be part of a layer.
22.2.17 SelectedArea

Properties

<table>
<thead>
<tr>
<th>property</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boundingRect : rect</td>
<td>Bounding rectangle of the selected area.</td>
</tr>
</tbody>
</table>

Functions

SelectedArea.get() [region] Returns the selected region.
SelectedArea.set(rect [rect])[void] Sets the selected area to the given rectangle.
SelectedArea.set(region [region])[void] Sets the selected area to the given region.
SelectedArea.add(rect [rect])[void] Adds the given rectangle to the selected area.
SelectedArea.add(region [region])[void] Adds the given region to the selected area.
SelectedArea.subtract(rect [rect])[void] Subtracts the given rectangle from the selected area.
SelectedArea.subtract(region [region])[void] Subtracts the given region from the selected area.
SelectedArea.intersect(rect [rect])[void] Sets the selected area to the intersection of the current selected area and the given rectangle.
SelectedArea.intersect(region [region])[void] Sets the selected area to the intersection of the current selected area and the given region.

22.2.18 Tile

Inherits Object.

Properties

<table>
<thead>
<tr>
<th>property</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id : int [read-only]</td>
<td>ID of this tile within its tileset.</td>
</tr>
<tr>
<td>width : int [read-only]</td>
<td>Width of the tile in pixels.</td>
</tr>
<tr>
<td>height : int [read-only]</td>
<td>Height of the tile in pixels.</td>
</tr>
<tr>
<td>size : size [read-only]</td>
<td>Size of the tile in pixels.</td>
</tr>
<tr>
<td>type : string</td>
<td>Type of the tile.</td>
</tr>
<tr>
<td>imageFileName : string</td>
<td>File name of the tile image (when the tile is part of an image collection tileset).</td>
</tr>
<tr>
<td>probability : number</td>
<td>Probability that the tile gets chosen relative to other tiles.</td>
</tr>
<tr>
<td>objectGroup : ObjectGroup</td>
<td>The ObjectGroup associated with the tile in case collision shapes were defined. Returns null if no collision shapes were defined for this tile.</td>
</tr>
<tr>
<td>frames : [frame]</td>
<td>This tile’s animation as an array of frames.</td>
</tr>
<tr>
<td>animated : bool [read-only]</td>
<td>Indicates whether this tile is animated.</td>
</tr>
<tr>
<td>tileset : Tileset [read-only]</td>
<td>The tileset of the tile.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>flag</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile.Flags</td>
<td></td>
</tr>
<tr>
<td>Tile.FlippedHorizontally</td>
<td></td>
</tr>
<tr>
<td>Tile.FlippedVertically</td>
<td></td>
</tr>
<tr>
<td>Tile.FlippedAntiDiagonally</td>
<td></td>
</tr>
<tr>
<td>Tile.RotatedHexagonal120</td>
<td></td>
</tr>
</tbody>
</table>
**Functions**

Tile.setImage(image \[Image\][void]) Sets the image of this tile.

    Warning: This function has no undo and does not affect the saved tileset!

### 22.2.19 TileCollisionEditor

**Properties**

<table>
<thead>
<tr>
<th>selectedObjects : [MapObject]</th>
<th>Selected objects.</th>
</tr>
</thead>
<tbody>
<tr>
<td>view : [MapView]</td>
<td>The map view used by the Collision Editor.</td>
</tr>
</tbody>
</table>

**Functions**

TileCollisionEditor.focusObject(object \[MapObject\][void]) Focuses the given object in the collision editor view and makes sure its visible in its objects list. Does not automatically select the object.

### 22.2.20 TileLayer

Inherits Layer.

Note that while tile layers have a size, the size is generally ignored on infinite maps. Even for fixed size maps, nothing in the scripting API stops you from changing the layer outside of its boundaries and changing the size of the layer has no effect on its contents. If you want to change the size while affecting the contents, use the resize function.

**Properties**

| width : int | Width of the layer in tiles (only relevant for non-infinite maps). |
| height : int | Height of the layer in tiles (only relevant for non-infinite maps). |
| size : size | Size of the layer in tiles (has width and height members) (only relevant for non-infinite maps). |

**Functions**

**new TileLayer([name [string]])** Constructs a new tile layer, which can be added to a TileMap.

**TileLayer.region() [region]** Returns the region of the layer that is covered with tiles.

**TileLayer.resize(size \[size, offset[[point]]][void]** Resizes the layer, erasing the part of the contents that falls outside of the layer’s new size. The offset parameter can be used to shift the contents by a certain distance in tiles before applying the resize.

**TileLayer.cellAt(x [int, y][int])[cell]** Returns the value of the cell at the given position. Can be used to query the flags and the tile ID, but does not currently allow getting a tile reference.

**TileLayer.flagsAt(x [int, y][int][int]** Returns the flags used for the tile at the given position.

**TileLayer.tileAt(x [int, y][int][Tile]** Returns the tile used at the given position, or null for empty spaces.

**TileLayer.edit() [TileLayerEdit]** Returns an object that enables making modifications to the tile layer.
22.2.21 TileLayerEdit

This object enables modifying the tiles on a tile layer. Tile layers can’t be modified directly for reasons of efficiency. The apply() function needs to be called when you’re done making changes.

An instance of this object is created by calling TileLayer.edit().

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>target</td>
<td>TileLayer [read-only] The target layer of this edit object.</td>
</tr>
<tr>
<td>mergeable</td>
<td>bool        Whether applied edits are mergeable with previous edits. Starts out as false and is automatically set to true by apply().</td>
</tr>
</tbody>
</table>

Functions

TileLayerEdit.setTile(x [int, y][int, tile][Tile [flags][int = 0]][void] Sets the tile at the given location, optionally specifying tile flags.

TileLayerEdit.apply() [void] Applies all changes made through this object. This object can be reused to make further changes.

22.2.22 TileMap

Inherits Asset.
Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width : int</td>
<td>Width of the map in tiles (only relevant for non-infinite maps).</td>
</tr>
<tr>
<td>height : int</td>
<td>Height of the map in tiles (only relevant for non-infinite maps).</td>
</tr>
<tr>
<td>size : size [read-only]</td>
<td>Size of the map in tiles (only relevant for non-infinite maps).</td>
</tr>
<tr>
<td>tileWidth : int</td>
<td>Tile width (used by tile layers).</td>
</tr>
<tr>
<td>tileHeight : int</td>
<td>Tile height (used by tile layers).</td>
</tr>
<tr>
<td>infinite : bool</td>
<td>Whether this map is infinite.</td>
</tr>
<tr>
<td>hexSideLength : int</td>
<td>Length of the side of a hexagonal tile (used by tile layers on hexagonal maps).</td>
</tr>
<tr>
<td>staggerAxis : StaggerAxis</td>
<td>For staggered and hexagonal maps, determines which axis (X or Y) is staggered.</td>
</tr>
<tr>
<td>orientation : Orientation</td>
<td>General map orientation</td>
</tr>
<tr>
<td>renderOrder : RenderOrder</td>
<td>Tile rendering order (only implemented for orthogonal maps)</td>
</tr>
<tr>
<td>staggerIndex : StaggerIndex</td>
<td>For staggered and hexagonal maps, determines whether the even or odd indexes along the staggered axis are shifted.</td>
</tr>
<tr>
<td>backgroundColor : color</td>
<td>Background color of the map.</td>
</tr>
<tr>
<td>layerDataFormat : LayerDataFormat</td>
<td>The format in which the layer data is stored, taken into account by TMX, JSON and Lua map formats.</td>
</tr>
<tr>
<td>layerCount : int [read-only]</td>
<td>Number of top-level layers the map has.</td>
</tr>
<tr>
<td>tiles : [Tileset]</td>
<td>The list of tilesets referenced by this map. To determine which tilesets are actually used, call usedTilesets().</td>
</tr>
<tr>
<td>selectedArea : SelectionArea</td>
<td>The selected area of tiles.</td>
</tr>
<tr>
<td>currentLayer : Layer</td>
<td>The current layer.</td>
</tr>
<tr>
<td>selectedLayers : [Layer]</td>
<td>Selected layers.</td>
</tr>
<tr>
<td>selectedObjects : [MapObject]</td>
<td>Selected objects.</td>
</tr>
</tbody>
</table>

### TileMap.Orientation
- TileMap.Unknown
- TileMap.Orthogonal
- TileMap.Isometric
- TileMap.Staggered
- TileMap.Hexagonal

### TileMap.LayerDataFormat
- TileMap.XML
- TileMap.Base64
- TileMap.Base64Gzip
- TileMap.Base64Zlib
- TileMap.Base64Zstandard
- TileMap.CSV

### TileMap.RenderOrder
- TileMap.RightDown
- TileMap.RightUp
- TileMap.LeftDown
- TileMap.LeftUp
Functions

new TileMap() Constructs a new map.

TileMap.autoMap([rulesFile [string]])[void] Applies Automation using the given rules file, or using the default rules file is none is given.

*This operation can only be applied to maps loaded from a file.*

TileMap.autoMap(region [region | rect [, rulesFile | string]])[void] Applies Automation in the given region using the given rules file, or using the default rules file is none is given.

*This operation can only be applied to maps loaded from a file.*

TileMap.setSize(width [int], height [int])[void] Sets the size of the map in tiles. This does not affect the contents of the map.

See also resize.

TileMap.setSize(width [int], height [int])[void] Sets the tile size of the map in pixels. This affects the rendering of all tile layers.

TileMap.layerAt(index [int])[Layer] Returns a reference to the top-level layer at the given index. When the layer gets removed from the map, the reference changes to a standalone copy of the layer.

TileMap.removeLayerAt(index [int])[void] Removes the top-level layer at the given index. When a reference to the layer still exists, that reference becomes a standalone copy of the layer.

TileMap.removeLayer(layer [Layer])[void] Removes the given layer from the map. The reference to the layer becomes a standalone copy.

TileMap.insertLayerAt(index [int], layer [Layer])[void] Inserts the layer at the given index. The layer can’t already be part of a map.

TileMap.addLayer(layer [Layer])[void] Adds the layer to the map, above all existing layers. The layer can’t already be part of a map.

TileMap.addTileset(tileset [Tileset])[bool] Adds the given tileset to the list of tilesets referenced by this map. Returns true if the tileset was added, or false if the tileset was already referenced by this map.

TileMap.replaceTileset(oldTileset [Tileset], newTileset [Tileset])[bool] Replaces all occurrences of oldTileset with newTileset. Returns true on success, or false when either the old tileset was not referenced by the map, or when the new tileset was already referenced by the map.

TileMap.removeTileset(tileset [Tileset])[bool] Removes the given tileset from the list of tilesets referenced by this map. Returns true on success, or false when the given tileset was not referenced by this map or when the tileset was still in use by a tile layer or tile object.

TileMap.usedTilesets() [[Tileset]] Returns the list of tilesets actually used by this map. This is generally a subset of the tilesets referenced by the map (the TileMap.tilesets property).
TileMap.merge(map) [TileMap [, canJoin][bool = false]][void] Merges the tile layers in the given map with this one. If only a single tile layer exists in the given map, it will be merged with the currentLayer.

If canJoin is true, the operation joins with the previous one on the undo stack when possible. Useful for reducing the amount of undo commands.

This operation can currently only be applied to maps loaded from a file.

TileMap.resize(size) [size [, offset][point [, removeObject][bool = false]]][void] Resizes the map to the given size, optionally applying an offset (in tiles).

This operation can currently only be applied to maps loaded from a file.

See also setSize.

TileMap.screenToTile(x, y) [number, number][point] Converts the given position from screen to tile coordinates.

TileMap.screenToTile(position) [point][point] Converts the given position from screen to tile coordinates.

TileMap.tileToScreen(x, y) [number, number][point] Converts the given position from tile to screen coordinates.

TileMap.screenToScreen(position) [point][point] Converts the given position from tile to screen coordinates.

TileMap.screenToPixel(x, y) [number, number][point] Converts the given position from screen to pixel coordinates.

TileMap.screenToPixel(position) [point][point] Converts the given position from screen to pixel coordinates.

TileMap.pixelToScreen(x, y) [number, number][point] Converts the given position from pixel to screen coordinates.

TileMap.pixelToScreen(position) [point][point] Converts the given position from pixel to screen coordinates.

TileMap.pixelToTile(x, y) [number, number][point] Converts the given position from pixel to tile coordinates.

TileMap.pixelToTile(position) [point][point] Converts the given position from pixel to tile coordinates.

TileMap.tileToPixel(x, y) [number, number][point] Converts the given position from tile to pixel coordinates.

TileMap.tileToPixel(position) [point][point] Converts the given position from tile to pixel coordinates.

22.2.23 Tileset

Inherits Asset.
## Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Name of the tileset.</td>
</tr>
<tr>
<td>image</td>
<td>The file name of the image used by this tileset. Empty in case of image</td>
</tr>
<tr>
<td>tiles</td>
<td>Array of all tiles in this tileset. Note that the index of a tile in this</td>
</tr>
<tr>
<td>wangSets</td>
<td>Array of all Wang sets in this tileset.</td>
</tr>
<tr>
<td>tileCount</td>
<td>The number of tiles in this tileset.</td>
</tr>
<tr>
<td>nextTileId</td>
<td>The ID of the next tile that would be added to this tileset. All existing</td>
</tr>
<tr>
<td>tileWidth</td>
<td>Tile width for tiles in this tileset in pixels.</td>
</tr>
<tr>
<td>tileHeight</td>
<td>Tile Height for tiles in this tileset in pixels.</td>
</tr>
<tr>
<td>tileSize</td>
<td>Tile size for tiles in this tileset in pixels.</td>
</tr>
<tr>
<td>imageWidth</td>
<td>Width of the tileset image in pixels.</td>
</tr>
<tr>
<td>imageHeight</td>
<td>Height of the tileset image in pixels.</td>
</tr>
<tr>
<td>imageSize</td>
<td>Size of the tileset image in pixels.</td>
</tr>
<tr>
<td>tileSpacing</td>
<td>Spacing between tiles in this tileset in pixels.</td>
</tr>
<tr>
<td>margin</td>
<td>Margin around the tileset in pixels (only used at the top and left sides of</td>
</tr>
<tr>
<td></td>
<td>the tileset image).</td>
</tr>
<tr>
<td>objectAlignment</td>
<td>The alignment to use for tile objects (when Unspecified, uses Bottom</td>
</tr>
<tr>
<td></td>
<td>alignment on isometric maps and BottomLeft alignment for all other maps).</td>
</tr>
<tr>
<td>tileOffset</td>
<td>Offset in pixels that is applied when tiles from this tileset are rendered.</td>
</tr>
<tr>
<td>orientation</td>
<td>The orientation of this tileset (used when rendering overlays and in the</td>
</tr>
<tr>
<td></td>
<td>tile collision editor).</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>Background color for this tileset in the Tilesets view.</td>
</tr>
<tr>
<td>isCollection</td>
<td>Whether this tileset is a collection of images (same as checking whether</td>
</tr>
<tr>
<td></td>
<td>image is an empty string).</td>
</tr>
<tr>
<td>selectedTiles</td>
<td>Selected tiles (in the tileset editor).</td>
</tr>
</tbody>
</table>

### Enums

- **Tileset.Alignment**
  - Tileset.Unspecified
  - Tileset.TopLeft
  - Tileset.Top
  - Tileset.TopRight
  - Tileset.Left
  - Tileset.Center
  - Tileset.Right
  - Tileset.BottomLeft
  - Tileset.Bottom
  - Tileset.BottomRight

- **Tileset.Orientation**
  - Tileset.Orthogonal
  - Tileset.Isometric
Functions

new Tileset([name [string]]) Constructs a new tileset.

Tileset.tile(id [int])[Tile] Returns a reference to the tile with the given ID. Raises an error if no such tile exists. When the tile gets removed from the tileset, the reference changes to a standalone copy of the tile.

Note that the tiles in a tileset are only guaranteed to have consecutive IDs for tileset-image based tilesets. For image collection tilesets there will be gaps when tiles have been removed from the tileset.

Tileset.setTileSize(width [int, height][int]][void] Sets the tile size for this tileset. If an image has been specified as well, the tileset will be (re)loaded. Can’t be used on image collection tilesets.

Tileset.loadFromImage(image [Image [, source: string]]][void] Creates the tiles in this tileset by cutting them out of the given image, using the current tile size, tile spacing and margin parameters. These values should be set before calling this function.

Optionally sets the source file of the image. This may be useful, but be careful since Tiled will try to reload the tileset from that source when the tileset parameters are changed.

Warning: This function has no undo!

Tileset.addTile() [Tile] Adds a new tile to this tileset and returns it. Only works for image collection tilesets.

Tileset.removeTiles(tiles [[Tile]])[void] Removes the given tiles from this tileset. Only works for image collection tilesets.

Tileset.addWangSet(name [string, type][int]) [WangSet] Add a new Wang set to this tileset with the given name and type.

Tileset.removeWangSet(wangSet [WangSet])[void] Removes the given Wang set from this tileset.

22.2.24 TilesetEditor

Properties

collisionEditor : TileCollisionEditor

Access the collision editor within the tileset editor.

22.2.25 TilesetFormat

This is an object that can read or write tileset files. (Since 1.4)

 Inherits FileFormat.

Functions

TilesetFormat.read(fileName [string])[Tileset] Read the given file as a tileset. This function will throw an error if reading is not supported.

TilesetFormat.write(tileset [Tileset, fileName][string][string][string] Write the given tileset to a file. This function will throw an error if writing is not supported. If there is an error writing the file, it will return a description of the error; otherwise, it will return "".
22.2.26 TilesetsView

Properties

<table>
<thead>
<tr>
<th>currentTileset : Tileset</th>
<th>Access or change the currently displayed tileset.</th>
</tr>
</thead>
</table>
| selectedTiles : [Tile]  | A list of the tiles that are selected in the current tileset.

22.2.27 WangSet

Inherits Object.

Properties

<table>
<thead>
<tr>
<th>name : string</th>
<th>Name of the Wang set.</th>
</tr>
</thead>
<tbody>
<tr>
<td>type : Type</td>
<td>Type of the Wang set.</td>
</tr>
<tr>
<td>imageTile : Tile</td>
<td>The tile used to represent the Wang set.</td>
</tr>
<tr>
<td>colorCount : int</td>
<td>The number of colors used by this Wang set.</td>
</tr>
<tr>
<td>tileset : Tileset [read-only]</td>
<td>The tileset to which this Wang set belongs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WangSet.Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WangSet.Edge</td>
<td>The Wang set only uses edges</td>
</tr>
<tr>
<td>WangSet.Corner</td>
<td>The Wang set only uses corners</td>
</tr>
<tr>
<td>WangSet.Mixed</td>
<td>The Wang set uses both corners and edges</td>
</tr>
</tbody>
</table>

Functions

WangSet.wangId(tile : Tile)[int[8]] Returns the current Wang ID associated with the given tile. The Wang ID is given by an array of 8 numbers, indicating the colors associated with each index in the following order: [Top, TopRight, Right, BottomRight, Bottom, BottomLeft, Left, TopLeft].

A value of 0 indicates that no color is associated with a given index.

WangSet.setWangId(tile : Tile, wangId[int[8]]][void] Sets the Wang ID associated with the given tile.

Make sure the Wang set color count is set before calling this function, because it will raise an error when the Wang ID refers to non-existing colors.

22.2.28 Basic Types

Some types are provided by the Qt Scripting Engine and others are added based on the needs of the data types above. In the following the most important ones are documented.
Alignment

<table>
<thead>
<tr>
<th>Qt.Alignment</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Qt.AlignLeft</td>
<td>0x0001</td>
</tr>
<tr>
<td>Qt.AlignRight</td>
<td>0x0002</td>
</tr>
<tr>
<td>Qt.AlignHCenter</td>
<td>0x0004</td>
</tr>
<tr>
<td>Qt.AlignJustify</td>
<td>0x0008</td>
</tr>
<tr>
<td>Qt.AlignTop</td>
<td>0x0020</td>
</tr>
<tr>
<td>Qt.AlignBottom</td>
<td>0x0040</td>
</tr>
<tr>
<td>Qt.AlignVCenter</td>
<td>0x0080</td>
</tr>
<tr>
<td>Qt.AlignCenter</td>
<td>Qt.AlignVCenter</td>
</tr>
</tbody>
</table>

cell

A cell on a *TileLayer*.

Properties

| tileId : int              | The local tile ID of the tile, or -1 if the cell is empty. |
| empty : bool              | Whether the cell is empty.                                |
| flippedHorizontally : bool| Whether the tile is flipped horizontally.                |
| flippedVertically : bool  | Whether the tile is flipped vertically.                  |
| flippedAntiDiagonally : bool| Whether the tile is flipped anti-diagonally.            |
| rotatedHexagonal120 : bool | Whether the tile is rotated by 120 degrees (for hexagonal maps, the anti-diagonal flip is interpreted as a 60-degree rotation). |

FilePath

Used as the value for custom ‘file’ properties. Can be created with `tiled.filePath`.

| url : url                  | The URL of the file.                                    |

Font

| family : string           | The font family.                                        |
| pixelSize : int           | Font size in pixels.                                    |
| bold : bool               | Whether the font is bold.                               |
| italic : bool             | Whether the font is italic.                             |
| underline : bool          | Whether the text is underlined.                         |
| strikeOut : bool          | Whether the text is striked through.                    |
| kerning : bool            | Whether to use kerning when rendering the text.        |

Frames

An array of frames, which are objects with the following properties:

| tileId : int              | The local tile ID used to represent the frame.         |
| duration : int            | Duration of the frame in milliseconds.                 |
ObjectRef

The value of a property of type ‘object’, which refers to a MapObject by its ID. Generally only used as a fallback when an object property cannot be resolved to an actual object. Can be created with tiled.objectRef.

| id : int | The ID of the referenced object. |

point

Qt.point(x, y) can be used to create a point object.

Properties

| x : number | X coordinate of the point. |
| y : number | Y coordinate of the point. |

Polygon

A polygon is not strictly a custom type. It is an array of objects that each have an x and y property, representing the points of the polygon.

To modify the polygon of a MapObject, change or set up the polygon array and then assign it to the object.

rect

Qt.rect(x, y, width, height) can be used to create a rectangle.

Properties

| x : int | X coordinate of the rectangle. |
| y : int | Y coordinate of the rectangle. |
| width : int | Width of the rectangle. |
| height : int | Height of the rectangle. |

region

Properties

| boundingRect : rect [read-only] | Bounding rectangle of the region. |

size

Qt.size(width, height) can be used to create a size object.

Properties

| width : number | Width. |
| height : number | Height. |
**TextFile**

The TextFile object is used to read and write files in text mode.

When using `TextFile.WriteOnly`, you need to call `commit()` when you’re done writing otherwise the operation will be aborted without effect.

**Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>filePath</code></td>
<td>The path of the file.</td>
</tr>
<tr>
<td><code>atEof</code></td>
<td>True if no more data can be read.</td>
</tr>
<tr>
<td><code>codec</code></td>
<td>The text codec.</td>
</tr>
</tbody>
</table>

**TextFile.OpenMode**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ReadOnly</code></td>
<td>0x0001</td>
</tr>
<tr>
<td><code>WriteOnly</code></td>
<td>0x0002</td>
</tr>
<tr>
<td><code>ReadWrite</code></td>
<td><code>ReadOnly</code></td>
</tr>
<tr>
<td><code>Append</code></td>
<td></td>
</tr>
</tbody>
</table>

**Functions**

- `new TextFile(fileName)` [string [. mode][OpenMode = ReadOnly]] Opens a text file in the given mode.
- `TextFile.readLine()` [string] Reads one line of text from the file and returns it. The returned string does not contain the newline characters.
- `TextFile.readAll()` [string] Reads all data from the file and returns it.
- `TextFile.truncate()` [void] Truncates the file, that is, gives it the size of zero, removing all content.
- `TextFile.write(text)` [string][void] Writes a string to the file.
- `TextFile.writeLine(text)` [string][void] Writes a string to the file and appends a newline character.
- `TextFile.commit()` [void] Commits all written text to disk and closes the file. Should be called when writing to files in `WriteOnly` mode. Failing to call this function will result in cancelling the operation, unless safe writing to files is disabled.
- `TextFile.close()` [void] Closes the file. It is recommended to always call this function as soon as you are finished with the file.

**BinaryFile**

The BinaryFile object is used to read and write files in binary mode.

When using `BinaryFile.WriteOnly`, you need to call `commit()` when you’re done writing otherwise the operation will be aborted without effect.

**Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>filePath</code></td>
<td>The path of the file.</td>
</tr>
<tr>
<td><code>atEof</code></td>
<td>True if no more data can be read.</td>
</tr>
<tr>
<td><code>size</code></td>
<td>The size of the file (in bytes).</td>
</tr>
<tr>
<td><code>pos</code></td>
<td>The position that data is written to or read from.</td>
</tr>
</tbody>
</table>
### BinaryFile

<table>
<thead>
<tr>
<th>BinaryFile.OpenMode</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BinaryFile.ReadOnly</td>
<td>0x0001</td>
</tr>
<tr>
<td>BinaryFile.WriteOnly</td>
<td>0x0002</td>
</tr>
<tr>
<td>BinaryFile.ReadWrite</td>
<td>BinaryFile.ReadOnly</td>
</tr>
</tbody>
</table>

**Functions**

**new BinaryFile(filePath [string [, mode][OpenMode = ReadOnly]])** Opens a binary file in the given mode.

**BinaryFile.resize(size [int]) [void]** Sets the file size (in bytes). If size is larger than the file currently is, the new bytes will be set to 0; if size is smaller, the file is truncated.

**BinaryFile.seek(pos [int]) [void]** Sets the current position to `pos`.

**BinaryFile.read(size [int]) [ArrayBuffer]** Reads at most `size` bytes of data from the file and returns it as an ArrayBuffer.

**BinaryFile.readAll() [ArrayBuffer]** Reads all data from the file and returns it as an ArrayBuffer.

**BinaryFile.write(data [ArrayBuffer]) [void]** Writes `data` into the file at the current position.

**BinaryFile.commit() [void]** Commits all written data to disk and closes the file. Should be called when writing to files in WriteOnly mode. Failing to call this function will result in cancelling the operation, unless safe writing to files is disabled.

**BinaryFile.close() [void]** Closes the file. It is recommended to always call this function as soon as you are finished with the file.

### Process

The Process class allows you to start processes, track their output, and so on.

**Properties**

- **workingDirectory : string**
  - The directory the process will be started in. This only has an effect if set before the process is started.

- **atEnd : bool [read-only]**
  - True if there is no more data to be read from the process output, otherwise false.

- **exitCode : int [read-only]**
  - The exit code of the process. This is needed for retrieving the exit code from processes started via `start()`, rather than `exec()`.

- **codec**: string
  - Sets the text codec to `codec`. The codec is used for reading and writing from and to the process, respectively. Common codecs are supported, for example: “UTF-8”, “UTF-16”, and “ISO 8859-1”.

**Functions**

**new Process()** Allocates and returns a new Process object.

**Process.close() [void]** Frees the resources associated with the process. It is recommended to always call this function as soon as you are finished with the process.

**Process.closeWriteChannel() [void]** Schedules the stdin channel of process to be closed. The channel will close once all data has been written to the process. After calling this function, any attempts to write to the process will do nothing.

**Process.exec(filePath [string, arguments][[string] [, throwOnError][bool = true]][number]** Executes the program at `filePath` with the given argument list and blocks until the process is finished. If an error occurs (for example, there is no executable file at `filePath`) and `throwOnError` is true (the default), then a JavaScript exception occurs.
will be thrown. Otherwise, -1 will be returned in case of an error. The normal return code is the exit code of the process.

**Process.getenv(name [[string][string]]** Returns the value of the variable varName in the process’ environment.

**Process.kill() [void]** Kills the process, causing it to exit immediately.

**Process.readLine() [string]** Reads and returns one line of text from the process output, without the newline character(s).

**Process.readStdErr() [string]** Reads and returns all data from the process’ standard error channel.

**Process.readStdOut() [string]** Reads and returns all data from the process’ standard output channel.

**Process.setEnv(varName [[string][varValue][string]]** Sets the value of variable varName to varValue in the process environment. This only has an effect if called before the process is started.

**Process.start(filePath [[string][arguments][string]]|bool]** Starts the program at filePath with the given list of arguments. Returns true if the process could be started and false otherwise.

  **Note:** This call returns right after starting the process and should be used only if you need to interact with the process while it is running. Most of the time, you want to use exec() instead.

**Process.terminate() [void]** Tries to terminate the process. This is not guaranteed to make the process exit immediately; if you need that, use kill().

**Process.waitForFinished(int msecs = 30000) [bool]** Blocks until the process has finished or timeout milliseconds have passed (default is 30000). Returns true if the process has finished and false if the operation has timed out. Calling this function only makes sense for processes started via start() (as opposed to exec()).

**Process.write(text [string]) [void]** Writes text into the process’ input channel.

**Process.writeLine(text [string]) [void]** Writes text, followed by a newline character, into the process’ input channel.